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INTRODUCCION

INTRODUCCION A LOS SISTEMAS DE INFORMACION GEOGRAFICA

LQUE ES UN SIG?

El término de SIG esta ampliamente difundido, sin embargo no es facil definir lo que es un SIG.
Se puede afirmar que hay casi tantas definiciones como autores que escriben sobre los SIG.

Un SIG lo podemos definir como un “Sistema de Informaciéon para trabajar con datos
georreferenciados mediante coordenadas espaciales o geograficas “(Star y Ester, 1990), es decir, un
sistema que nos proporciona informacion a partir de datos geograficos. De hecho, la geografia constituye
un elemento clave para estructurar la informacion dentro de un SIG y para realizar operaciones de
analisis.

Desde otro punto de vista se frata de una extensién del concepto de base de datos: un SIG es
“una base de datos computerizada que contiene informacion espacial” (Cebrian, 1988). En un SIG se
almacena informacion cartografica (con lo que es posible conocer la localizacién exacta de cada elemento
en el espacio y con respecto a otros elementos) e informacién alfanumérica (datos sobre las
caracteristicas o atributos de cada elemento geografico). Este hecho, el trabajar con informacion espacial,
es lo que diferencia basicamente a los SIG de otros Sistemas de Informacién.

COMPONENTES DE UN SIG:
= Personas
= Datos
=  Hardware
= Software

=  Procedimientos.

FUNCIONES DE UN SIG

Cualquier Sistema de Informacion Geografica deberia ser capaz de llevar a cabo las siguientes
operaciones fundamentales, para ser capaz de encontrar soluciones a los problemas reales.

1. Capturar datos
Almacenar datos
Consultar datos
Analizar datos

Visualizar datos

I O

Salida

ORGANIZACION DE LOS DATOS EN UN SIG

Un SIG organiza y almacena informacion sobre el mundo como un conjunto de capas tematicas que
pueden ser vinculadas geograficamente. Cada capa contiene atributos que pueden ser similares. La
complejidad de la tierra nos permite crear tantas capas como gueramos. La pregunta entonces, seria
como organizar de la mejor manera estas entidades del mundo real, en formas geomeétricas manejables y
almacenarias digitaimente.
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INTRODUCCION A ARCGIS 9.1

ArcGis Desktop 9.1 es la Ultima version de un programa desarrollado por la compariia ESRI (Enviomental
System Research Institute), con la finalidad ultima de extender el uso de los datos espaciales en formato
digital, y de la tecnologia de los Sistemas de Informacion Geografica para el tratamiento de los mismos.

En el mercado podemos encontrar tres licencias diferentes para la utilizacién licencias a las que nos
referimos son las siguientes:

. ArcView, licencia del programa ArcGis permite generar mapas se una manera sencilla y
proporciona herramientas de analisis y herramientas simples de edicién y analisis.

e ArcEditor incluye la funcionalidad total de ArcView ademas de funciones avanzadas.
. Arcinfo amplia la funcionalidad de ambos al incluir analisis un analisis ain mas avanzado que
ArEditor.

Independientemente de la licencia que utilicemos, la arquitectura del programa es la misma, por lo que los
usuarios que trabajen con cualquiera de estos clientes, pueden compartir su trabajo con otros usuarios.
En los tres productos se pueden intercambiar mapas, datos, simbologia, capas de mapas, herramientas
personalizadas e interfaces, informes, metadatos y asi sucesivamente.

En nuestro caso en concreto, para el desarrollo del médulo utilizaremos el programa ArcGis con la
licencia ArcView.

VISION EN CONJUNTO DE ARCGIS

El programa ArcGis se compone de tres méodulos: ArcMap, ArcCatalog y ArcToolbox. Utilizando estos
tres médulos juntos, se puede realizar cualquier tarea de SIG, tanto simple como avanzada, incluyendo la
generacion de mapas, la gestion de datos y el analisis.

S
& 30 Analyst Toals
& Analysis Taols
& Cartography Tools
2 Conversion Tools
&§ Coverage Tools
& Data Management Tools
& Geocoding Tools
% Geostatistical Analyst Tools
& Linear Referencing Tools
&F Spatial analyst Tools
+ % Spatial Statistics Tools

+ o+ o+ o+ + o+ o+

+

Aitia ]

ArcMap es el médulo principal de ArcGis. Este nos proporciona las herramientas para visualizar,
consultar, editar, crear y analizar datos. Ademas nos permite generar la composicién de los mapas
para posteriormente imprimirios.. También incluye funciones de generacién de graficos e informes y un
exhaustivo conjunto de herramientas de edicion para crear y editar los datos geograficos.

ArcCatalog

ArcCatalog sirve para organizar y gestionar todos los datos SIG. Incluye herramientas para buscar y
encontrar informacion geografica, registrar y visualizar metadatos, realizar una rapida visualizacion de
cualquier archivo y definir la estructura de nuestras capas de datos.
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ArcToolbox

ArcToolbox proporciona herramientas para la conversion de datos, para la gestion de sistemas de
coordenadas, para cambiar las proyecciones del mapa y para el andlisis avanzado.

ArcMap, ArcCatalog y ArcToolbox han sido disefiados para trabajar conjuntamente y asi, llevara a cabo
todas las tareas de SIG. Por ejemplo, se puede buscar y encontrar un documento en ArcCatalog, después
abrirlo en ArcMap haciendo doble click sobre €l en el catalogo y por ultimo se pueden editar y resaltar los
datos con las herramientas disponibles en el entorno de edicion de ArcMap

EL MENU “AYUDA” EN ARCGIS

¢ Desde la interfaz de ArcMap, en el menu general Help.

» Desde la interfaz de ArcCatalog, en el menu general Help.

La ayuda de ArcGis dispone de varios métodos para encontrar la ayuda necesaria para utilizar el software
productivamente.

Welcome to ArcGIS Desktop

Help
i 0 Archls Deskiop applications aetting help »
P Additional
L
@
Lo
[
e
@ |
Y I
& 11 A atalog
B 3 !
N Y |
R Y g 1
. En la pestafia Contenidos, podemos buscar informacion referente a las categorias de
contenidos.
° La pestafia Indice nos permite buscar temas que contengan palabras del indice de ayuda, como

por ejemplo capa o tabla.

. La pestafia Busqueda, nos permite realizar una busqueda en todos los documentos de ayuda
con una palabra especifica. Dicha palabra ni tiene por gué estar en el indice para poder buscarla
en el documento, aungue la busqueda sera mas rapida si se encuentra en el indice.

Ademas, en ArcCatalog, ArcMap y ArcToolbox, los nombres de los botones y de las herramientas, se
muestran al desplazar el cursor del raton sobre ellos (esto se conoce como texto emergente o tools tips).

También se puede conseguir ayuda sensible al contexto sobre cualquier herramienta utilizando la
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herramienta *;Qué es esio?" N? what's This?  Shift+F1

interfaces de ArcMap y ArcCatalog.

(localizada en el menu general Help) en las

Para aquellas aplicaciones como ArcMap que tienen una interfaz de usuario gréafica, este tipo de ayuda es
muy util para encontrar informacion sobre lo que hacen todos los botones y herramientas.
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Sistemas de Informacion Geografica

UNIDAD 1. VISUALIZACION DE DATOS

CONTENIDOS

1.

Documentos de ArcGis

Interfaz y herramientas de ArcMap

Layers (capas), Data Frame (marco de datos) y mapas .
Gestion de la Tabla de Contenidos

Opciones para la visualizacion de las capas
Simbologia en ArcMap

Visualizacién dependiente de la escala

Etiquetado

Cambiar la fuente de datos de una capa

Guardar un archivo de capa

Los documentos de ArcGis

UNIDAD 1

Un documento de ArcGis constituye un espacio de organizacion, utilizado basicamente para estructurar
toda la informacion que se utilice en un trabajo concreto. Este espacio consiste en un archivo de
direcciones con extension *.mxd (de la misma forma que un documento de Microsoft Word es guardado
en un archivo con extension *.doc).

El archivo *.mxd, es el lugar donde se registra la localizacion de esta informacién y cierto tipo de
manipulaciones de la misma como es, por ejemplo la simbologia, asi como la modificaciones que se
realicen en el entorno de trabajo (menus, barras de herramientas, programas especificos...). Sin embargo,
es importante no olvidar gue no contiene los datos utilizados, sino Unicamente la ruta al directorio donde
estan ubicados en nuestro ordenador.

Como ya hemos indicado, la visualizacion de datos en ArcGis se realiza a través de ArcMap, es por ello
por lo gque nos vamos a centrar en este médulo.

2.

Interfaz y herramientas de ArcMap

2.1. Caracteristicas de la interfaz de ArcMap

b HARRA DE MENT G
“as W

BARRADE
HERRAMIENTAS

a e o MENL
TABLADE = CONTEXTUAL -
CONTENID O3 :

BARRA DE ESTAD O

it HERILAMIENTAS
i (Horances)
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Sistemas de Informacion Geografica UNIDAD 1

s La barra de titulo muestra el nombre del mapa, el médulo de ArcGis con el que estamos trabajando
{(ArcMap o ArcCatalog) y la licencia de ArcGis de la que disponemos (ArcView, ArcEditor o Arcinfo)

° La tabla de contenidos enumera las capas de datos y las leyendas. Es desplegable y se puede
cambiar su tamafio arrastrando el separador vertical entre la tabla de contenidos y el aérea de
visualizacion.

. El area de visualizacién es donde aparecen los elementos del mapa.

° La barra de estado, ademas de informar sobre las coordenadas, muestra una descripcion de los
botones seleccionados y de los puntos del mend.

2.2, Data View (vista de datos) y Layout View (vista de presentacion)?

Data View

Se trata de la vista mas importante de ArcMap, ya que permite la introduccién de la informacion espacial
(grafica) en el proyecto. Trabajaremos en el Data View para visualizar, consultar, editar, explorar y
analizar informacion espacial.

Layout View

La finalidad de esta vista es la de generar salidas cartograficas, en las que podremos afadir otros
elementos al mapa, como son graficos, tablas, flecha de direccion Norte, leyenda, escala, titulo y otra
informacion textual (Ej. autor, fecha de los datos, fecha del mapa, tipo de proyeccién...). Cuando todo esto
este completo podremos enviar nuestro mapa a un plotter o impresora.

Data View layout View

Para movernos de una vista a otra:

e Desde la barra de MENU general > Clic en el botén View.

Wiew Insert Selection Tools Window Help
@ Data view 55% v

L
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Sistemas de Informacién Geografica UNIDAD 1

3. Layers (capas), Data Frame (marco de datos)

t6

Lrex

En ArcGis, la informacion espacial se estructura en unidades denominadas capas (LAYER). Estas
almacenan la ruta a una fuente de datos y las propiedades de visualizacion de esta fuente de datos.

La incorporacion de capas a la Tabla de Contenidos se realiza mediante la opcién del menu File > Add
data . Esta opcion conduce a una ventana a través de la cual buscaremos el directorio o unidades
del disco donde se encuentran los datos que queremos cargar.

Un Data Frame o marcos de datos es un contenedor de capas que nos permiten organizar nuestros
datos en agrupaciones logicas, como temas o areas geograficas Al crear un nuevo mapa,
automaticamente se le afiade un data frame de datos predeterminado en la parte de arriba de la tabla de
contenidos. Al abrir el programa este lo denomina como Layers, por lo que no lo debemos confundir con
el Layer referido a las capas que hemos citado anteriormente. En cualquier caso, podemos cambiar en
cualguier momento el nombre del Data Frame.

Cuando un mapa tiene mas de un data frame, sélo uno de ellos estara activo. El data frame activo es
aquel con el que se esta trabajando. Por ejemplo, cuando se afiade una nueva capa a un mapa, se afiade
al data frame activo. Siempre podemos saber cudl esta activo porque se encuentra marcado en el mapa y
sU nombre aparece resaltado en negrita en la tabla de

i i i Hlo ti DEEHE rHBEX o & A
contenidos. Obviamente, si un mapa solo tiene un data frame, ke A5 NG5 A
siempre sera el activo. g

. e
Para activar un data frame: e

e Clic con el botdn derecho del raton en el data frame y
después, hacer clic en Acfivar. El data frame activo
aparecera resaltado en negrita en la tabla de contenidos.

2
%

i

e

15 Fovertes
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Sistemas de Informacion Geografica UNIDAD 1

4. Gestion de la Tabla de Contenidos

T T ~ La tabla de contenidos enumera todos los Data Frame y las Capas, y
" muestra los simbolos utilizados para representar los elementos de cada
capa.

e Una casilla de verificacion al lado de la capa, indica si es visible
CASILADE | actualmente en el mapa.

VERIFICACION |@ .

Indicasilacapa |& Las capas que se encuentran en la parte superior de la tabla de

estaactivaomn : contenidos, se dibujan encima de las capas que se en encuentran debajo
s TaBLADE . % de ellas. De este modo, pondremos las capas de tipo puntual y lineal por

CONTENIDOS 45 : . .
encima de las poligonales, ya que de lo contrario perderemos

informacion. (Ej. Si tenemos una capa lineal que simboliza los rios y otra
de tipo poligonal que simboliza los términos municipales, tendremos que
colocar por encima la de los rios para que estos no sean ocultados por la
capa de limites municipales)

Para cambiar el orden de visualizacion de las capas:

Clic en la capa y arrastrarla de arriba a abajo por la tabla de contenidos hasta una nueva posicion.
También se pueden copiar y pegar capas dentro de un mismo data frame o en un data frame diferente.

Para eliminar las capas que no deseemos:

- £ Layers
e clic sobre la capa con el boton derecho del raton > Remove en el b s -
menu contextual. - B imies munii o

] Open Attribute Table
Joins and Relates 3

@ Zoom To Layer

5. Opciones para la visualizacion de las capas R

e En el MENU DE HERRAMIENTAS (Tools), encontramos la mayoria de herramientas para navegar
por los datos.

RATIOdE Bk O Hs

+
Zoom In (zoom de aproximacion). Aumenta la escala de visualizacidon de una zona especifica

=
Zoom Out = (zoom de alejamiento). Disminuye la escala de visualizacion de una zona especifica

P
Fixed Zoom In ** . Aumenta la escala de visualizacion de la vista
L |
Fixed Zoom Out ** . Disminuye la escala de visualizacion de |a vista

Pan {'n-r" . Permite desplazarte a través del mapa

Full Extend s . La ventana grafica de la vista toma sus coordenadas maximas y minimas entre todas
las capas en la vista

5.1. LA OPCION ZOOM TO LAYER

La opcion Zoom to Layer sirve para hacer un zoom completo de una
capa en concreto

Remaove

- lirmits w

= Clic con el boton derecho sobre la capa en la que queramos hacer el )
Open Attribute Table

Joins and Relates 4
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zoom > Zoom to Layer)

5.2, BOOKMARKS (Marcadores Espaciales)

Un Bookmark o marcador espacial hace un Zoom a una posicion geografica particular que previamente
hemos guardado.

o Para crear un Bookmark: Una vez estamos situados en la region geografica que queremos
mantener: Opcién View del menud = Bookmarks > Create

o Para visualizar un Bookmark previamente creado: Opcion View del menu > Bookmarks =
Clic sobre el Bookmark que gueramos

5.3. MAGNIFIER (Vista de lupa) y OVERVIEW (Vista General)

ArcMap proporciona dos modos adicionales para explorar los datos espaciales de nuestro mapa; a traves
de una vista general (Overview) o a través de una vista de lupa (Magnifier).

La vista de lupa (Opcion Window del men( > Magnifier) funciona como si fuese una lente de aumento; al
desplazar la ventana sobre los datos, vemos una vista ampliada de la posicién que se encuentra debajo
de la ventana. Mover la ventana alrededor del mapa no afecta a la visualizaciéon del mismo.

La vista general (Opcion Window del menu > Overview) muestra toda la zona de estudio. Un pequefio
cuadro en la ventana de generalidades, representa el area visualizada en el mapa. Podemos mover este
cuadro para hacer "pan” en el mapa y reducirio o ampliarlo, para acercar o alejar la imagen.

Ambas ventanas soélo estan disponibles en la vista de datos

6. Simbologia de las capas en ArcMap

6.1. MODIFICAR LAS PROPIEDADES DE LOS SIMBOLOS

ArcMap nos permite cambiar faciimente el color del simbolo de
una capa, el color de una capa, el color de la capa (Clic con el | (IRASEEIR, o
botén derecho del raton en el simbolo), o el simbolo mismo (Clic
sobre el simbolo).

R TR TR R
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6.2. MAPAS TEMATICOS

Se puede configurar el simbolo de las capas, dentro de la pestafia Simbolos de la ventana Propiedades
de la capa (Clic con el boton derecho sobre |a capa cuyas propiedades queremos cambiar > Propierties
> Symbology).

En el panel Show de la pestaiia Symbology. ArcMap ofrece varias opciones para crear mapas tematicos,
tanto cualitativos (opcion Categories) como cuantitativos (opcion Quantities). Cuando elegimos uno de
ellos, las opciones de las propiedades que se encuentran a la derecha del panel Show cambian de
acuerdo con el tipo de mapa tematico utilizado.

%{Jx.)xmhhgs
Charts
Multiple Attnbutes

yiezs

<Heading> MUNICIPIG ik

Mapas tematicos con valores cualitativos

o Representacion de los elementos de una capa con un Gnico simbolo

De forma predeterminada, ArcMap dibuja todos los elementos componentes de la capa con un tnico
simbolo o color.

* Enel panel Show > Features > Single Symbol.

o  Clasificacion de los elementos de las capas por categoria

Una categoria describe un conjunto de elementos con el mismo valor de atributos. Por ejemplo,
una parcela dada con un atributo que describe un uso del suelo (residencial, comercial y areas ptiblicas).
Podemos utilizar un simbolo diferente para representar cada tipo de uso del suelo. Dibujar los elementos
de esta forma, nos permite ver donde se encuentran los elementos y a qué categoria pertenecen. Esto
puede resultar Gtil, si nuestro objetivo es un tipo especifico de elementos para alguna accion o plan
determinado. Por ejemplo, un urbanista puede utilizar el mapa de usos del suelo para centrarse en areas
de reurbanizacion.

s Enel panel Show > Categories > Unigue value.

Podemos dejar que ArcMap asigne un simbolo a cada valor Unico, basandose en el esquema de colores
que nosotros decidamos, o podemos asignar nosotros mismos un simbolo especifico a un valor de
atributos especifico.
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e ——————— Features
-Fealuues : .
: \W\ - Categores
Calegunes = o
Unique values, many |

{ Quantities :
{Charts n MdEC_h to symbols in &
:Multiple Attributes g Quantities

Charts

Multiple Attributes

Mapas tematicos con valores cuantitativos

Cuando queremos que nuestro mapa comunique qué cantidad hay de algo en particular, tenemos que
dibujar los elementos utilizando una medida cuantitativa. Esta medida puede ser un recuento, un ratio
como porcentaje, o un rango como alto, medio o bajo.

Podemos representar cantidades en un mapa variando el color o el tamafio del simbolo que utilizamos
para dibujar elementos. Por ejemplo, podemos utilizar tonalidades azules de intensidad creciente para
representar el aumento de lluvia, o grandes circulos para representar ciudades con gran densidad de
poblacién. Generalmente, necesitaremos clasificar nuestros datos cuando los visualicemos. Podemos,
bien definir las clases manualmente o bien aplicar uno de los esquemas estandar de clasificacion para
hacerlo automaticamente, simplemente especificando el nimero de clases que queramos mostrar. Una
vez hayamos definido las clases, podremos afadir mas clases, eliminar clases o redefinir el rango de
estas.

Shnw

Features

=I:ateu‘:jmle:

‘Quantities
EE—
Graduated symbols
Proportional symbols
Dot density

Charts

{Multiple Attributes

Shnw

‘Features

;Caiegunes » g

Quantities
Graduated calors

R
Proportional symbols
. Dot density
iCharts
: Multiple Attributes

Features

Categories

Huantities
Graduated colors

Charts
Multiple Attributes

Los graficos circulares, graficos de barras y graficos de barras apiladas, pueden representar grandes
cantidades de datos cuantitativos de un modo llamativo. Por ejemplo, si estamos generando un mapa de
poblacién por municipios, podemos hacer un grafico circular para mostrar el porcentaje de poblacion por
grupo etnico por cada municipio.
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Show:
T ——
:Categories
‘Quantities
EChilts -
e
Bar/Column
i Stacked
‘Multiple Attributes

Generalmente dibujaremos una capa con graficos cuando nuestra capa tenga un numero de atributos
numéricos relacionados que queramos compartir. Utilizaremos graficos circulares si nuestra intencion es
mostrar qué porcentaje de la cantidad total toma cada categoria. Utilizaremos graficos de barras, para
mostrar cantidades relativas en vez de la proporcién total,

En el panel Show > Charts > Pie (gréfico de quesitos)
Bar > Column (Grafico de barras)

Stacked (Grafico en una sola barra)

Clasificacion de valores cuantitativos

Cuando generamos mapas a partir de datos cuantitativos, tenemos dos opciones: o asignamos a cada
valor su propio simbolo, o agrupamos valores dentro de una clase, utilizando un simbolo diferente para
cada clase.

Si estamos generando un mapa a partir de pocos valores (menos de 10), podemos asignar un Unico
simbolo a cada valor. Esto puede representar un reflejo mas fiel de los datos, ya gue no estamos
predeterminando qué elemento se agrupan juntos. Lo mas probable es que los valores de nuestros datos
sean demasiado numerosos como para generar un mapa individualmente a partir de ellos y entonces
podemos agruparlos en clases o clasificar los datos. Un buen ejemplo de clasificaciéon de datos, es el
mapa de temperaturas que podemos encontrar en cualquier periddico. En vez de mostrar temperaturas
individuales, estos mapas muestran bandas de temperaturas, donde cada banda representa un rango de
temperaturas dado.

El modo en que definamos los rangos de las clases y las divisiones (los valores alto y bajo que catalogan
cada clase) determinaran qué elementos estaran en cada clase y asi, como sera la apariencia del mapa.
Al cambiar las clases, podemos crear mapas de diferente apariencia. Generalmente, el objetivo es
asegurarnos de que los elementos con valores similares estén en la misma clase.

Dos factores clave para clasificar nuestros datos son, el esquema de clasificacion que utilicemos y el
numero de clases que creemos. Si conocemos bien nuestros datos, podemos definir las clases
manualmente. Ofra posibilidad es dejar que ArcMap clasifique nuestros datos, utilizando esquemas
estandar de clasificacién. Los cuatro esquemas de clasificacion mas comunes son:

° Natural Breaks (Saltos naturales). Este método identifica saltos de valor importante en las
secuencias de valores para crear clases.

. Quantile (Cuantiles). En este método de clasificacion los valores se dividen de forma que cada
clase contenga el mismo numero de elementos

. Equal Interval (Intervalos iguales). Este método de clasificacion divide el rango de valores de los
atributos en rangos de igual tamafio

® Standar Deviation (Desviacion standar). En este caso, ArcGis encuentra el valor medio, despuées
coloca espacios de separacién entre clases arriba y abajo de la media a intervalos de 1/4 , 1/2 6
una desviacion tipica.

En el panel Show > Quantities
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En el panel Classification > Classify... > Method

CLASIFICACTON DE VALORES CUANTITATIVOS

Wanmal begale Quantiie

Faual nternval Estandar deviation

7. Visualizacion dependiente de la escala

Al configurar una escala de visualizacion, evitamos la acumulacién de datos innecesarios en nuestro
mapa, restringiendo la visualizacion de elementos o de texto hasta que se llegue a una escala apropiada
donde la informacidn sea util para el usuario.

Existen dos métodos para hacer esto:

e Clic con el boton derecho del raton sobre la capa > Rango de escala visible > Configurar escala
minima y Configurar escala maxima.

Para eliminar esta propiedad, repetir, pero esta vez hacer Clic sobre Borrar rango de escala.

e Clic con el boton derecho del ratén en la capa > Propiedades >pestafia General > configurar el rango
de escala como se muestra en la diapositiva.

De esta forma podemos configurar las propiedades de una capa para que se visualice soélo si la
extension del mapa se encuentra dentro de un cierto rango de escala.

ezt capaen thncion del rango de

s capa en mneion del g de eseala
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Las etiquetas también se pueden visualizar en funcion de un rango de escala. Para establecerlo: En
Layers Properties > Labels > Scale Range.

8. Etiquetado

Al nombrar los elementos en un mapa, los usuarios pueden identificarios rapidamente e interpretar mas
faciimente el mapa. En ArcMap, podemos nombrar elementos utilizando un campo de la tabla de
atributos. (Ej. Tenemos un mapa de los municipios de la provincia de Sevilla y queremos visualizar los
nombres de cada unc de los municipios; tendremosque poner las etiquetas en funcién del campo de la
tabla de atributos asociada que contenga dicha informacion)

La posicion del texto de las etiquetas depende de la fuente del texto, el tamafio, la posicion, la escala del
mapa y el numero de elementos que necesiten ser etiquetados. Para ayudarnos con esta tarea, ArcMap
ofrece herramientas para controlar la ubicacion, el tamafio, la escala del mapa Yy muchas otras
caracteristicas del texto de las etiquetas.

Para establecer las etiquetas:

1. Seleccionamos el campo cuyo valor queremos que aparezca como etiqueta. En Layer Properties >
Labels > Label Field.

2. Seleccionamos el Simbolo del texto. En Layer Properiies > Labels > Text Symbol.

3. Seleccionamos otras opciones para el texto como son: localizacion del texto, rango de escala... En
Layer Properties > Labels > Other options.

4. Indicamos que gqueremos que se visualicen las etiquetas. Clic con el botdn derecho del ratén sobre la
capa cuyas etiquetas queremos que se visualicen > Label Features.

Sin embargo, esta forma de establecer etiquetas no nos permite moverlas con
el cursor posteriormente. Para poder mover el texto una vez puesta la etiqueta
haremos lo siguiente:

Una vez establecidas las propiedades de |as etiquetas (es decir, hemos indicado A .

=
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el campo de la tabla de atributos a partir del cual queremos las etiquetas y el tamafio y color de la letra),

-

hacemos Clic en el desplegable del boton
interfaz de ArcMap > Clic en el botdn Label

de la barra de dibujo, situada en la parte inferior de la

Si nos vamos al mapa y hacemos Clic sobre alguno de los elementos, comprobamos que aparece la
etiqueta sobre dicho elemento. Si ahora hacemos Clic sobre la etiqueta e intentamos arrastrarla sobre el
mapa para cambiar su ubicacion, comprobamos que el programa si nos lo permite.

Las etiquetas también se pueden visualizar en funcién de un rango de escala. Para establecerlo: En
Layers Properties = Labels > Scale Range.

Definy envquetns en fmcion del rango de excala

9. Guardar un archivo de capa

Las capas que creamos en ArcMap se aimacenan como parte de un documento de mapa (con extension
.mxd). Cuando terminemos la simbolizacion y el etiquetado de una capa, podemos guardarlo fuera del
mapa como un archivo de capa (con extension .lyr). También podemos reutilizar la capa en otros mapas o
mandarla por correo electronico junto con otro datos a usuarios que quieran afadirla a sus mapas.

La forma de guardar una capa fuera de un mapa es la siguiente:

1. En ArcMap, abrir el mapa que contenga la capa gue queremos guardar como archivo tipo capa
. Clic con el boton derecho del ratdn en la capa
. Clic en Save as Layer file...

. Seleccionar la carpeta en la que queremos guardar la capa

2
3
4
5. Nombrar en el archivo de capa
6. Clic en Guardar

7. En el Catalogo, abrir la carpeta en la que hayamos guardado la capa
8

. Ahora, la capa es un elemento de la carpeta. Si la capa no aparece en la lista de Contenidos, hacer Clic
en la capa que deberia de aparecer en el Catalogo desplegable, a continuacion, hacer Clic en el menu
Ver y, por ultimo, hacer Clic en Actualizar para actualizar la lista.
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10. Buscar o cambiar la fuente de datos de una capa

El documento de mapa (.mxd) no almacena los datos espaciales que se muestran en él, sinc que
almacena las referencias de las ubicaciones de las fuentes de datos. Cuando abrimos un documento,
ArcMap lee el archivo y busca todas las rutas para reconstruir las capas.

Cuando las fuentes de datos se mueven, los documentos (.mxd) pueden perder la pista de éstas. Cuando
esto ocurre, en ArcMap el nombre de la capa aparece en la tabla de contenidos con un signo de
exclamacion rojo y el area de visualizacion aparecera vacia para esa capa.

Para corregir ese problema, tenemos dos opciones:

= Clic con el boton derecho del raton sobre la capa > Properties...> Source (Fuente)>Set Data Source
(Establecer fuente de datos)/ Aparece un navegador que te permite establecer la nueva fuente de
datos.

* Acceso directo para ayudar a corregir el nombre de la ruta para una fuente de datos: Doble Clic con
el raton sobre el signo de exclamacion > Busqueda en el navegador de la nueva fuente de datos.

Una vez que esto se haya completado, la ruta hasta la fuente de datos se fijara y aparecera la capa.
Tenemos que recordar guardar el documento para que también se guarde la nueva ruta. Este
procedimiento es similar a la operacién de reparar el proyecto en ArcView,

T ——— O 1)} 6200 (Y
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UNIDAD 2. LOS DATOS GEOGRAFICOS

CONTENIDOS

+ Componentes de los datos geograficos

« Modelos de datos: Vectorial y Raster

e Los datos geograficos en ArcGis. Utilizacién de ArcCatalog

e  La referencia geografica (georreferenciacion). Los Sistemas de referencia y las proyecciones
cartograficas

e Lareferencia espacial en ArcGis

1. Componentes de los datos geograficos

Como indicamos con anterioridad, los SIG se distinguen del resto de Sistemas de Informacion por el
hecho de trabajar con “informacién geogréfica’, por lo tanto, el conocimiento de la naturaleza de los datos
geograficos supone una cuestion previa al manejo de cualquier sistema.

Con caracter general podemos decir que cualquier dato, perteneciendo a cualquier disciplina, se
descompone en los siguientes elementos:

1 Unidad de observacién o soporte: cualquier entidad de la realidad sobre la que se observa un
fenomeno.

2  Atributo tematico o variable: cualquier hecho que adopta diferentes modalidades.

Ej. En psicologia, cuando se realiza un test para medir el coeficiente intelectual de un grupo de
estudiantes, la unidad de observacion son los estudiantes y lo que se mide -el atributo tematico o la
variable- es el coeficiente intelectual.

En el caso concreto de los datos geograficos:
1 LA UNIDAD DE OBSERVACION

Es una entidad con referencia espacial, es decir, localizada en el espacio o lo que es lo mismo
georreferenciada.

Existen dos formas de geoarreferenciar o localizar un elemento en el espacio:

e Localizacion geografica. mediante sistemas de coordenadas (coordenadas esféricas o coordenadas
proyectadas), que deben ser el mismo para las diferentes capas o estratos de informacion con los
que se representa el area de estudio.

e Segun la topologia o relaciones topologicas. La localizacion de los objetos se realiza en base a
ciertas relaciones basadas en el espacio que estos objetos tienen entre si (conectividad, contigiidad,
proximidad, inclusion...).

De esta forma, podemos diferenciar entre relaciones topeldgicas (de tipo cualitativo) y relaciones
geométricas (calculadas a partir de las coordenadas de ios objetos). Cuando cambiamos la proyeccion de
un mapa, las relaciones geométricas de un mapa se modifican, como por ejemplo las distancias medidas
sobre el mapa, pero en cambio las relaciones topologicas se mantienen, como por ejemplo la contiglidad.

/lUn ejemplo ilustrative para diferenciar entre las relaciones es el de los mapas esquematicos de las
lineas de metro: las relaciones geométricas no se respetan, ya que el trazado de las lineas y la
localizacion de las estaciones no se corresponde con la realidad, pero las relaciones topolégicas (la
conectividad de los diferentes tramos de lineas) permanecen inalteradas.//
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2 LOS ATRIBUTOS TEMATICOS O VARIABLE TEMATICA

Los objetos con los que representamos la realidad poseen unas determinadas caracteristicas que
conocemos como atributos, registrando cada objeto un determinado valor para cada uno de estos
atributos. (Ej. Nombre, poblacion, capital...son atributos de una provincia).

2. Modelos de datos

El mundo real es enormemente rico y variado. Cada investigador se propone un objetivo en su estudio,
que solo puede ser alcanzado mediante una simplificacion de la reaiidad, es decir, mediante un modelo.

Dentro de los SIG’s existen dos modelos de datos fundamentales para la representacion de la realidad:
Modelo Vectorial

Modelo Raster

A continuacion, detallaremos cada uno de estos modelos atendiendo a las diferencias existentes en los
componentes de los datos que estos representan; en cada uno de los modelos de datos haremos
referencia a la unidad de observacién, es decir, como representa cada modelo las entidades, a las
relaciones topologicas y a los atributos tematicos.

2.1. Modelo Vectorial

Unidades de observacion

El Modelo de datos vectorial representa los elementos geograficos u entidades de un modo similar a los
mapas; utilizando objetos gue son almacenados en la base de datos. Estos objetos son puntos, lineas y
poligonos, de esta forma podemos distinguir entre;

e Entidades u objetos puntales (x,y) e

+ Entidades u objetos lineales (x1y+ X2,y2 Xays...)

= Entidades u objetos poligonales (x1y1 Xz,y2 Xays..., x1.¥1)

En el modelo vectorial, los atributos tematicos de las entidades son almacenados en una base de
datos asociada.

Modulo SISTEMAS DE INFORMACION GEOGRAFICA-CEA2007



UNIDAD 2

2.2. Modelo Raster

El modelo raster compartimenta el espacio en una serie de elementos discretos por medio de una reticula
rectangular dividida en celdilias. Cada celdilla, también denominada “pixel’, es un cuadrado que
representa una porcion especifica de un area.

Las celdillas de un raster se estructuran en filas y columnas. Las filas son paralelas al eje de las X, y las
columnas son paralelas al eje de las Y. De esta forma, cada celdilla puede ser localizada una posicion
unica, la de la fila y columna a la que pertenecen.

La representacion de los elementos del mundo real se realiza de la siguiente forma:

e Entidad puntual: se representa mediante una celda
e Elemento lineal: se representa mediante una secuencia de celdas alineadas

= Elemento poligonal: se representa mediante una agrupacion de celdas contiguas

En cuanto a los atributos tematicos, a cada celdilla le corresponde un Unico valor tematico relativo a la
variable a la que estd representando (altitud, usos del suelo...). Al conjunto de celdillas y sus valores
asociados constituyen un estrato o capa de informacion. De esta forma, si se quiere almacenar
informacion (sobre una misma zona) relativa a distintas variables, se han de incluir tantas capas como
variables se consideren.

ZCuando utilizar un modelo u otro?

Aungue no hay ninguna regla fija que nos indigue cuando utilizar un modelo u otro, con caracter general,
ios elementos naturales del paisaje, que normalmente no posee bordes marcados sino zonas de
transicién, se representan mas adecuadamente con el modelo raster. En cambio, los elementos gue son
resultado de la accién del hombre (divisiones administrativas, limites de propiedad, vias de
comunicacién...) suelen tener bordes nitidos, por lo que se representan mejor con el modelo vectorial.

Otro criterio a tener en cuenta es el del tipo de variacion espacial que presenten los datos. Cuando esta
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variacion es continua (altitud, precipitacion, temperatura...), es mas frecuente trabajar con el modelo
raster, ya gque la atencion se centra en la variable (aunque nada se opone a que se haga con el modelo
vectorial). Cuando la variacién es discreta (limites administrativos...) se suele trabajar con el modelo
vectorial.

3. Los datos geograficos en ArcGis. Utilizacién de ArcCatalog
3.1. Formatos de datos con los que trabaja ArcGis
Actualmente no hay un formato estandar de datos SIG, sino que existen multiples tipos de datos en los

que se almacena informacion espacial. ArcGis puede trabajar con los siguientes tipos de datos y los
representa con la siguiente simbologia:

Shapefile (vectorials =]

Coberturas (vectoriah

Geodatabase (vectoriali ‘
Archivos CAD (vectorial) ) %)
Imagenes raster en multitud de formatos (TIFF. BMP. BIL. BIP...) %ﬁﬁ

Los diferentes tipos de datos se diferencia unos de otros basicamente por dos aspectos:
= El modelo de datos del que se trata (vectorial o raster).

* La cantidad de geometrias espaciales que pueden representar, es decir si sélo representan un
solo tipo de geometria (sdlo puntos, lineas o poligonos) o pueden representar mas de un tipo.

En relacion a esta caracteristica, tenemos que definir el concepto de Feature Class. Estas son
las unidades basicas en las que ArcCatalog (moédulo de ArcGis para gestionar elementos)
almacena elementos con el mismo tipo de geometria. A continuacion aclararemos este concepto
detallando los diferentes tipos de datos.

Formato SHAPEFILE

Formato de datos tipo vectorial especifico de ESRI. Es el formato nativo de ArcView, por lo que en ArcGis
(basta con tener la licencia ArcView) podemos visualizar, mostrar y editar tanto los datos espaciales como
los atributos.

Cada Shapefile estd formado por una sola feature class, es decir puede contener Unicamente un Gnico
tipo de objeto espacial (puntual, lineal o poligonal).

Conterts . Preview = Metadata

o Type ; i
tes municipales. shp Shapefile b Shapefile lineal
nucleos de poblacion({pal).shp Shapefile
4 red hidrografica.shp Shapefile

En ArcGis se representa mediante un cuadro de color verde en que se indica el tipo de objeto que
contiene. Tiene extension *.shp
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o

Formato COBERTURA

Formato de datos tipo vectorial especifico de ESRI. Se pueden visualizar y consultar coberturas en todas
las aplicaciones ArcGis, pero solo se pueden editar con las

licencias ArcEditor o Arcinfo. - P
: ) ] arc
Las coberturas se caracterizan porque pueden contener una o mas 4| label
feature classes de diferente geometria. _"—‘iu_l nalygon
. gy L i Feature Class
Se representan con el color amarillo E’fﬂ region, m
x4 tic

Formato GEODATABASE

Formato de datos tipo vectorial especifico de ESRI. Se trata de un formato de datos especifico de todas
las aplicaciones de ArcGis.

Puede almacenar diferentes tipos de geometrias. Al conjunto de feature class, en la geodatabase se le
denomina Datasets.

Formato con extension *.mdhb

La geodatabase se representa mediante la siguiente simbologia.

5 o » GEODATABASE

+ -{ CONDICIONANTES

1 HIDROLOGIA — | Dataset
ol ved_hidrografica >
= superficies_de_agua

< LIMITES ADMINISTRATIVOS

<N TOPONIMIA

Feature Class

+ o+

Formato CAD

Formato especifico de programas de disefio asistido por ordenador (extensiones: *.dxf, *.dwf, *.dng).
Podemos visualizar y consultar los datos tal y como estan en sus formatos nativos de archivos CAD, o
podemos convertirlos a una feature class de cobertura o de geodatabase, si lo que queremos es editar los
elementos espaciales o los registros de atributos.

Simbologia en ArcGis de los archivos CAD.:

Coler blanco cuando sélo contienen una feature class y azul cuando sean mas
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‘A Annotation }j W
@] MultiPatch —
A1 point

2| Polygon

7| Polyline

Imagenes

Informacion de tipo raster. ArcGis soporta imagenes de muliitud de formatos (*.tiff, *bmp, *.sid, *.jpeg...),
las cuales pueden ser monocromos (en blanco y negro) o multiespectrales (muchas bandas o capas
representando muchos colores).

Simbologia en ArcGis

- * Tiff, * bmp, *.jpeg... IMAGENES
Raster Dataset * S1d. O] Imagen °.tiff

Raster Dataset Ortofoto. Extension ~.sid

3.2. Utilizacion de ArcCatalog

ArcCatalog sirve para organizar y
gestionar todos los datos SIG. Incluye
herramientas para buscar y encontrar
informacion  geografica, registrar y
visualizar metadatos, realizar una rapida
visualizacion de cualquier archivo y
definir la estructura de nuestras capas de datos.

Para acceder al médulo de ArcCatalog: inicio > fodos los programas> ArcGis> ArcCatalog.

3.2.1. Visualizacion de datos en ArcCatalog

ArcCatalog nos permite visualizar nuestros datos de tres formas diferentes:
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Eif o

Pestafias de visualizacién de datos

. La pestafia CONTENIDOS

La pestafia Contenidos muestra los objetos que contiene cualgquier elemento que seleccionemos en el

catdlogo desplegable (carpetas, geodatabases o conjunto de datos de elementos). Permite ver la lista de
datos de cuatro formas diferentes:

o Large Icons (lconos grandes)
o List (Listado):
¢ Details (Detalles): iconos pequefios con informacion adicional sobre el tipo de dato de cada
archivo.
o Thumbnails (Catalogo de Vistas): todos los objetos aparecen representados por imagenes
en miniatura en la ventana principal de visualizacién, a modo de diapositiva.
Pestania Conrerados
* v
Large icens i Denils Y
r o
iige Thumbnaiis
. La pestana VISTA PREVIA

Muestra la previsualizacion de los datos geograficos o tabulares del objeto seleccionado.

En la parte inferior de la pestafia, hay un menu deplegabie que permite al usuario seleccionar el tipo de
vista (geografia o tabla). La vista predeterminada es la de geografia, donde los datos se muestran con un

color y un conjunto de simbolos al azar. La vista de tabla muestra la tabla de atributos asociada a los
elementos seleccionados.
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Festana Preview

. La pestafia METADATOS

ArcCatalog nos permite visualizar los metadatos de los elementos seleccionados en el catalogo haciendo
Clic sobre |a pestafia metadatos en el area de visualizacion.

Se puede definir metadatos como "la informacién descriptiva acreditativa de los datos” ("datos sobre los
datos"). Los metadatos incluyen informacion descriptiva como la fecha, el autor, extension geogréfica,
sistema de coordenadas y dominio de los atributos. Nos garantizan credibilidad sobre los datos; en
muchas situaciones, no podemos interpretar nuestros datos sin los metadatos.

La pestafia Metadatos se divide en tres categorias;

. DESCRIPTION. (Informacion descriptiva) contiene la informacion basica sobre el conjunto de
datos: fuente, organizacion, fecha, usos y restricciones.

e SPATIAL. (informacion espacial) contiene la informacion sobre las coordenadas y la extension
geografica del conjunto de datos.

. ATRIBUTTES. (Informacion sobre atributos) contiene campos, dominios de los atributos e
informacion tabular relacionada.

3.2.2. Conectarse a carpetas

Al contrario que el explorados de Windows, ArcCatalog no presenta una lista con todos los archivos
almacenados en el disco, sino que solo presenta una lista con los archivos de datos geograficos. Al
seleccionar una conexion, podemos acceder a los datos a los que esta vinculada y a sus metadatos.

Cuando iniciamos ArcCatalog, éste contiene: conexiones a carpetas
que nos permiten acceder a los discos duros locales y otras carpetas
llamadas Conexiones a la base de datos y sistema de coordenadas.
Podemos afiadir conexiones adicionales a carpetas que tengan
acceso a carpetas especificas o a directorios en un disco local, a
carpetas compartidas en la red o a los contenidos en un disquet o CD-
ROM. También podemos eliminar conexiones a carpetas y ocultar
otras carpetas que no necesitemos.

Para conectarnos a alguna carpeta o unidad de nuestro ordenador:
Clic en el botén Connect to Fo.’dersxtuado en la esquina superior derecha de la interfaz de ArcCatalog
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3.2.3. Configurar la visualizacion de datos

Podemos controlar los elementos que aparecen en el catalogo de ArcCatalog. Para esto, basta con hacer
Clic en el menu Tools y seleccionar Options. Dentro de la ventana de opciones, en la pestafia General,
tenemos la posibilidad de definir qué tipos de datos queremos activar o desactivar. Si desactivamos un
tipo de datos no aparecera en la lista de catalogo desplegable de ArcCatalog. es decir, ese tipo de datos
se vuelve "invisible" o ilegible.

3.2.4.Generar un Thumbnail (catélogo de vistas)

Para generar un Thumbnail en ArcCatalog tenemos que tener la barra de herramientas de Geografia
activada en la interfaz de ArcCatalog. Se puede acceder a esta barra de herramientas través del menu
View > Toolbars > Geography.

Para generar el catdlogo de vistas: seleccionar la capa en el catélogo desplegable > Clic en la pestafia
Vista previa > Clic en Create Thumbnail en la barra de herramientas de geografia.

Para visualizar :Clic en la carpeta, geodatabase o conjunto de datos que contenga la capa> Clic en la
pestafia Contenidos > clic en el boton Mostrar contenidos como un catélogo de vistas (boton Thumbnail)
que se encuentra en la barra de herramientas estandar de ArcCatalog.

Crear un Thumbiad

4 Cheen
cataloss e y1stas
[ TRl

1 Sekcenna 3. Zean v Fan
it olije o o 1oy

Lt 5T e o
pestmna Prnew

Farivisnahzarlo o o pestana e i
Contenidos ot ot
thumb ol
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4. La referencia geografica (georreferenciacién). Los Sistemas de referencia y las provecciones
cartograficas

El proceso de elaboracion cartografica, con caracter general conlleva:
1. La determinacion de la localizacion geogréfica de diferentes elementos de la superficie terrestre,
2. su transformacién a las correspondientes situaciones en una superficie plana (mapa), y

3. larepresentacion grafica de estos elementos a través de simbolos o signos.

4.1. Georreferenciacion. Sistemas de coordenadas

La georreferenciacion es una forma de localizar un elemento sobre la superficie terrestre. Los Sistemas
de Coordenadas permiten establecer de forma univoca la posicién que ocupa cada objeto en la superficie
terrestre. Se basan en una serie de puntos cuya posicién absoluta es conocida, y a partir de los cuales se
establece la posicion de los demas mediante indicaciones de direccion y distancia.

La localizacion de un punto puede realizarse en bhase a dos sistemas de coordenadas:
» Coordenadas geograficas o esféricas

» Coordenadas planas o proyectadas

4.1.1.  Sistema de coordenadas geograficas o esféricas

El sistema de coordenadas geograficas es el principal sistema a escala planetaria. Se trata de un sistema
de referencia apoyado en una serie de puntos identificables sobre la superficie terrestre (polos N y S, yel
Ecuador) a partir de los cuales se construye una RED GEOGRAFICA.

Esta Red Geografica la forman:

. Paralelos: lineas de interseccion de los infinitos planos perpendiculares al eje terrestre con la

superficie de la tierra. El paralelo principal es aquel que se encuentra a maxima distancia del eje de la
tierra, el Ecuador.

El ecuador divide la tierra en el hemisferio Norte y en el Hemisferio Sur. Se toma como origen del sistema
de referencia creado, de forma que se designa la posicion de un punto haciendo referencia a su situacion
con respecto a estos dos hemisferios

° Meridianos: lineas de interseccién con la superficie terrestre, de los infinitos planos que
contienen el eje de la tierra.

El sistema toma como origen para designar la situacion de una posicion geografica un determinado
meridiano, denominado "meridiano 0%, cuyo nombre lo toma de la ciudad inglesa por la que pasa:
meridiano de GREENWICH.

Este meridiano divide el globo terraqueo en dos zonas: la situada al Oeste (W) del meridiano 0°, hasta el
antimeridiano y la situada al Este (E) del meridiano 0°, hasta el antimeridiano.

PARALELOS : T MERIDIANGS |
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Una vez tenemos establecida la red de paralelos y meridianos se puede definir la situacion geografica de
un punto sobre la tierra. Su expresion requiere la determinacion de la distancia a la que se encuentra el
Ecuador en la direccion N-S (LATITUD) y la distancia a la que se encuentra de un meridiano de referencia
en la direccion E-W (LONGITUD).

. latitud: /
¢ Latitud At 2

fongitud:

Arco de meridiano, medido en grados sexagesimales, entre un pinto y el
Ecuador.

La latitud maxima y minima oscila entre los 0° hasta los 90° — 0°-90°
Norte, 0°-90° Sur.

« Longitud

Arco de paralelo, medido en grados sexagesimales, entre un punto y el
meridiano principal o de referencia por el camino mas corto.

La longitud presenta un minimo posible de 0° hasta un maximo de 180° —
0°-°80° E, 0°-180° W.

Ejemplo de designacion de coordenadas geograficas:

Al designar las coordenadas de un punto, primero se indica la latitud y después la longitud.
Por ejemplo, la coordenada geografica de un punto P es:

P: 42°21°30”N 71°03°27"E

Il A veces, las latitudes sur y las longitudes ceste se indican mediante nimeros negativos y a veces se
dan en grados decimales. (P: 42.3583N 71.0575E) //

A pesar de que el sistema de coordenadas geograficas es universal y permite la localizacion de los puntos
de la superficie terrestre de forma de absoluta, en ocasiones resulta incomodo porque:

e  Se expresa en unidades sexagesimales

s  Se apoya en paralelos y meridianos, que son lineas curvas y que no se pueden representar de
forma perfecta en un plano (mapa).

Para resolver estos problemas se crearon los Sistemas de Coordenadas Planas o Proyectadas. Para
utilizarlos, primero hay que representar la superficie terrestre en un plano mediante PROYECCIONES
CARTOGRAFICAS.

4.1.2. Sistemas de Coordenadas proyectas. Las proyecciones cartograficas

Una proyeccion cartografica es un procedimiento que te permite representar la superficie curva de la
Tierra en una superficie plana. Ninguna representacion plana de la Tierra puede ser completamente
exacta, de modo gque se han desarrollado diferentes proyecciones, cada una de ellas apropiada para una
finalidad en particular.

Las proyecciones cartograficas difieren en el modo en que se comportan con las siguientes propiedades:
forma, area, distancias y direcciones; es por elio por lo que la adecuada seleccién de la proyeccion es
importante.

Tipos de Proyecciones

Podemos diferenciar tipos de proyecciones en funcion de la variable que conserven:
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* Proyecciones conformes: preservan las formas y son Utiles para cartas de navegacion y mapas
meteorologicos. La forma se mantiene para areas pequefias, pero un area grande (continente),
sufrira distorsiones significativas.

=  Proyecciones equivalentes: conservan el area pero no la forma. Suelen ser utilizadas en mapas
teméaticos.

* Proyecciones equidistantes: preservan las distancias, pero ninguna proyeccion puede preservar
distancias desde todos los puntos hacia todos los demas; en cambio es posible asegurar la veracidad
de la distancia desde un punto (o conjunto de puntos) a todos los demas puntos, o a lo largo de todos
los meridianos o paralelos.

e Proyecciones acimutales: preservan la direccién desde un punto a todos los demas puntos. Esta
cualidad puede combinarse con las proyecciones equivalentes, conformes y equidistantes.

» Ofras proyecciones: existen otras que minimizan la distorsion global pero no preservan ninguna de
las cuatro propiedades espaciales de area, forma, distancia y direccion. Normalmente se utilizan
porque estéticamente son atractivas y Utiles para la cartografia genera.

De esta forma, los criterios para la eleccion de una proyeccion seran los siguientes:

1. Que conserve la cualidad mas importante para el fendmeno representado (supone aceptar la
distorsion de todas las demas)

2. Que la zona de interés presenta la menor distorsion posible, es decir, que esté cerca del centro de la
proyeccion y tenga la misma orientacion.

La proyeccion UTM (Universal Transversal de Mercator)

La proyeccion UTM es una proyeccion cilindrica en la que el cilindro de proyeccion es transversal
respecto al eje de la tierra y, por lo tanto tangente a la tierra a lo largo de dos meridianos opuestos.

PROYECCION  UTM

Para minimizar deformaciones, ia tierra se proyecta en franjas de 6° cada una, denominadas HUSOS
(posiciones geograficas que ocupan todos los puntos comprendidos entre dos meridianos) e identificados
mediante un numero, del 1 al 60.

En cada Huso se genera un meridiano central equidistante 3° de cada extremo del Huso que se
correspondera con el centro de la proyeccion. Los Husos se generan a partir del meridiano de Greenwich,
0°aB°EyW,6°a122Ey W, ..

Ademas, para reducir aun mas las distorsiones, el sistema UTM sdélo es utilizado entre los 80° N y los 84°
8, ya que produce una distorsién més acusada cuanto mayor es la distancia al Ecuador.

La proyeccion UTM mantiene las formas, y el resto de propiedades (area, distancia y direccion) las
mantiene con una distorsién baja.
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Coordenadas UTM

Las coordenadas de un punto se definen tomando cada Huso como un sistema de coordenadas en el que
el origen, para cada Huso es el punto donde se cruza su meridiano central (centro de proyeccion) con la
linea del Ecuador.

Como en todo sistema cartesiano, primero se indica la X (distancia desde el origen sobre el eje harizontal)
y despues la Y (distancia desde el origen sobre el eje vertical). Las coordenadas UTM se expresan en
metros.

Para evitar valores negativos al designar las coordenadas UTM de un punto, el origen de coordenadas
toma valores arbitrarios diferentes al (0,0). En el Hemisferio Norte, la X toma un valor de 500.000 myla ¥
de O m. En el Sur, la X toma el mismo valor que en el Hemisferio Norte, 500.000 m y la Y toma el valor de
10.000.000 m.

HEMISFERIO NORTE ) RNER, 0

Designacion de coordenadas.

El sistema localiza un punto por coordenadas del tipo:
X = 426.130
Y =4.634.140,

Pero estas coordenadas en el Sistema UTM no definen un punto (sino 120 puntos, dos en cada Huso), ya
que no indican los siguientes datos:

e El Hemisferio en el que se encuentran

e ElHuso UTM de proyeccion (1-60)

Para que el punto quede representado correctamente hay que designarlo de la forma gue sigue:
X = 426.130
Y =4 634. 140

Huso 30 Hemisferio Norte

La proyeccién UTM es la proyeccion mas utilizada en Andalucia y en Espafia en general. Andalucia que
da ubicada en dos zonas diferentes, de Sevilla y Jerez hasta Huelva quedaria en el huso 29 y en el resto
de Andalucia en el huso 30; por ello, cuado la informacidn ha sido creada a escala provincial o municipal,
la informacion correspondiente a Huelva no puede casar con la del resto de Andalucia, ya que esta en
husos diferentes, pero cuando la informacion se realiza para toda Andalucia (escala regional), se utiliza el
huso 30, por lo que la informacién correspondiente a Huelva sufre mayor distorsion que el resto de
Andalucia, y los datos son menos precisos.
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4.2. El Elipsoide de referencia y el Datum

Independientemente del tipo de sistema de coordenadas que utilicemos para georreferenciar nuestros
datos (esféricas o proyectadas) es necesario definir dos parametros mas para que los puntos sean
unicos:

e Elipsoide de referencia

° Datum

Para definir estos parametros es necesario conocer con exactitud la forma de la tierra

El elipsoide

La forma habitual en la que se ha descrito el planeta tierra es el de
una elipse, es decir, una “esfera achatada por los polos”. Y
ciertamente esta forma se asemeja a la descripcién si se toma una
vision en conjunto.

Radio Ecuatonal

diferencia %.35310,

Si hacemos girar esta elipse en torno a su eje menor, podriamos
decir que la forma de la tierra es un elipsoide.

El geoide

Sin embargo, como podras imaginar la Tierra no es exactamente un elipsoide, sino que tiene una forma
tnica y es precisamente por eso, recibe el nombre de geoide. Se define geoide como la supefficie tedrica
equipotencial de la Tierra, es decir, la superficie tedrica que une todos los puntos de igual gravedad.

Esta forma creada supone la continuacién por debajo de la superficie de los continentes, de la superficie
de los océanos y mares suponiendo la ausencia de las mareas, con la superficie de los océanos en caima
y sin ninguna perturbacioén exterior, (coma perturbaciones externas se encuentran la atraccion de la luna —
mareas- y las interacciones de todo el sistema solar).

Lejos de lo que se podria imaginar esta superficie no es uniforme, sino que presenta una serie de
irregularidades, causada por la distinta composicion mineral del interior de la tierra y de sus distintas
densidades, lo que implica que para cada punto de la superficie terrestre exista una distancia distinta
desde el centro de la tierra al punto del geoide.

Sups| rficie
Terrestrz

4.3. El elipsoide de referencia

A persa de que un geoide seria la forma mas exacta de representar la forma de la Tierra, éste es un
cuerpo geometrico irregular. Por ello, pera construir mapas, se reemplaza por el cuerpo geométrico
regular mas parecido a él: El elipsoide de referencia.
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No hay un unico elipsoide que se adapte de la mejor forma posible a todo el geoide: cada continente,

zona, nacion... emplea un elipsoide de referencia distinto, el que mejor se adapte a la forma de Ia tierra
en la zona a cartografiar.

Elipsoides de empleo mas usual

Existen gran variedad de elipsoides, que se van mejorando matematicamente para que tengan una mejor
aproximacion al geoide, o que las desviaciones encontradas con el geoide sean las menores posibles,
aunque para cada zona de la tierra se suele emplear un elipsoide distinto de manera que se adapte mejor
a las desviaciones locales del geoide. Los elipsoides mas empleados son los siguientes:

o CLARKE Hayford
Elipsoide 1658 GRS80 WGSs4 WSS Int. 1924
Semic

emieje 6378293 6378.100 6378.137 6378.135 6378.388
mayor
Semieje 6356.617 6356.752 6356.752 6356.750 6356.911
menor
indice de
. 1/294.26 1/298.26 1/298.26 1/298.26 11297
achatamiento

4.4. El Datum

Se define Datum como el punto tangente al geoide y al elipsoide de referencia, donde ambos son
coincidentes.

Cada Datum esta compuesto por:
e Un elipsoide (definido por sus ejes y aplastamiento)

* Un punto llamado "punto fundamental” en el cual el elipsoide y la tierra son tangentes (definido
por sus coordenadas geograficas: latitud y longitud)

Eipsoige - Detiniciones - Jatum

Radio Dolar

Raco Ecuzoral t

Datum local y datum giobal

Datum local: aquel gue utiliza como referencia un elipsoide local, es decir, en el gue la longitud de sus
ejes no cambia y el elipsoide es “empujado” hasta que es tangente al geoide.

Datum global: aquel que esta referido a un elipsoide geocéntrico, es decir, en el que el centro de la tierra

es siempre el centro del elipsoide. La longitud de los ejes va cambiando hasta que geoide y elipsoide son
tangentes.
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La cartografia basica espafiola esta referida al Datum Local;

European Datum - 1950 (ED-50)

¢ Elipsoide Hayford (internacional 1924)

= Punto fundamental :Postdam (52°22°51.446°N 13°03'58.741°E)

4.5. Los Sistemas de Coordenadas y el Datum

El uso de diferentes Datums da ligar a diferentes coordenadas para un mismo punto. Es fundamental
conocer el Datum para gue la posicion de un punto sobre la superficie terrestre quede establecida sin
error.

Ej. Coordenadas geogréaficas de un mismo punto utilizando dos Datums diferentes:

Datum Latitud Longitud
WGS-84(GPS) 42°19'20.11"N 5930'19.45"W
ED-50 42°19°'21.48"N 5°30°'09.59"W

Ejemplo de designacion de coordenadas geograficas

P: 42°21°30”N 71°03’27”E. European Datum — 1950 (ED-50)

Ejemplo de designacion de coordenadas proyectadas

P: 426130, 4. 634. 140 UTM 30N. European Datum — 1950 (ED-50)

5.

La referencia espacial en ArcGis

5.1. Cémo visualizar y modificar la informacién de la referencia espacial

Para visualizar la informacion de la referencia espacial de un dato:

En la pestafna Spatial de los metadatos

Dogeription - L0 Aneibutes

omaris ot al coorilinate wyatoin

Detiiic

En las Propiedades del dato

o En Arc Map: unicamente se puede visualizar la referencia espacial del dato. (Layer
Properties > Source).

¢ EnArcCatalog: se puede visualizar la referencia espacial y modificar. (Layer Properties). En
funcion del tipo de dato se visualizaré y modificara la referencia geografica de forma
diferente.
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Los sistemas de referencias en ArcGis pueden ser configurados desde ArcMap y desde ArcCatalog. Si se
lleva a cabo mediante ArcMap no estamos cambiando la referencia original de la fuente de datos, sino
que esta referencia solo queda almacenada en el documento de ArcMap *.mxd, pero nos permite realizar
visualizaciones, consultas o incluso analisis con un conjunto de datos de sin sistema de referencia
conocido o de diferente proyeccion sin tener que cambiar la proyeccién de un conjunto de datos para. De
todos modos, si es necesario un cambio de proyeccion permanente, éste lo podemos llevar a cabo
mediante ArcToolbox o ArcCatalog.

El asistente para definir la referencia espacial

Mediante este asistente puedes definir la referencia espacial de
tres formas diferentes:

s Select: seleccionando un sistemas de coordenadas y
proyecciones de entre las que ofrece ArcGis.

« Import: importando la referencia espacias desde otra capa
gue ya la tiene definida.

e New: crear un nuevo sistema de coordenadas.

//En la practica indicaremos las diferentes formas de acceder a
este asistente.//
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UNIDAD 3. CONSULTA DE BASE DE DATOS

CONTENIDOS
e Herramientas para examinar datos: Identificar, Buscar, Medir
» Las Herramientas de Seleccién
o Utilidades de las herramientas de Seleccion
o Herramientas de seleccién disponibles
*  Seleccion Interactiva
= Seleccion por Atributos
= Seleccion por Localizacion
o  Creacion de una capa a partir de selecciones

o Generar resumenes estadisticos

1. Herramientas para examinar datos L\E k O # %

1.1. Boton Identificar

A través de esta herramienta podemos visualizar los atributos de cualguier elemento que seleccionemos con
el cursor del ratdn e la vista de datos. Al pulsar sobre cualquier elemento aparece una ventana grafica que nos
da cuenta de toda la informacion asociada que tiene ese objeto. No se produce la seleccién de ese elemento
sino que solo nos muestra la informacion.

1.2.Botén Buscar

Al pulsar este boton aparece la ventana Buscar. Introduciremos el textoa s
buscar en el cuadro y el programa recorrera la base de datos localizando
el texto introducido.

La ventana Buscar ofrece dos opciones de busqueda:
. Buscar en todas las capas de mapa
. Buscar en una capa especifica

Ademas, permite realizar la busqueda:

. En todos los campos (atributos) de la Tabla de Atributos
° en campos especificos
® En cada campo primario de la capa

Al completarse la busqueda, se amplia la ventana Buscar para mostrar un
cuadro de resultados en el cual se muestran las capas y los campos en los que se han encontrado el
elemento de nuestra blsqueda. Si hacemos Clic con el boton derecho del ratén en el valor, aparece un menu
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contextual donde se pueden realizar las siguientes operaciones:

. Flash Features (Resaltar elementos): el elemento, cuyos atributos contienen la busqueda introducida,
parpadeara durante unos segundos en un color verde (predeterminado).

. Zoom To Features (Ampliar elementos)

. Identify Features (ldentificar elementos): aparece el cuadro de identificacién de atributos del
elemento seleccionado.

. Set Bookmark (Crear marcador): marca el elemento encontrado como marcador, de forma que lo
podamos utilizar mas tarde simplemente haciendo Clic en el menti View > Bookmarks.

e Select Features (Seleccionar elementos): el elemento encontrado es seleccionado de forma que
estara disponible para acciones futuras.

. Unselect Features (Eliminar elementos).

&
1.3.Botén Medir =

Esta herramienta permite obtener mediciones sobre la Vista de datos.

Se hace Clic con el ratdn en diferentes puntos y va apareciendo una linea gruesa en los graficos. El resultado
de las mediciones aparece en la barra de estado localizada en la parte inferior izquierda de la ventana de
ArcMap; la primera cifra (Segmenf) se refiere a la longitud del ultimo segmento trazado y la segunda cifra
(Total) a la longitud acumulada en caso de que se trazase mas de un segmento.

Para terminar las operaciones de medicion basta con hacer Doble Clic en el punto de fin y la linea de
conexion desaparecera, pero la barra de estado continuard mostrando las Ultimas conexiones.

Para que esta utilidad funcione de forma correcta, es necesario que se establezcan las unidades de mapa.
Para ello: Se hace Clic con el boton derecho del ratén sobre el Data Frame > Properties > En la pestafia
General seleccionar las unidades del mapa.

2. Herramientas de Seleccion

2.1.Utilidades de las herramientas de Seleccion

e Utilizar el conjunte seleccionado para un futurc analisis
» Editar el conjunto seleccionado

e Crear una nueva capa partiendo del conjunto (trabajar con un subconjunto es mas rapido que con el
conjunte completo).

e  Calcular estadisticas para el conjunto
e  Crear un informe

e Convertir a otro formato grafico

Médulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA 2007

(8]
Ln



UNIDAD 3

2.2.Herramientas de seleccién disponibles

ArcMap ofrece tres herramientas basica para seleccionar elementos:
e  Seleccién Interactiva

e Seleccion por Atributos

e  Seleccion por Localizacion

Ademas, ArcMap permite controlar las capas que van a estar disponibles a la hora de realizar las selecciones.

Este control se lleva a cabo mediante el cuadro de dialogo Set Selectable Layers (Establecer capas
seleccionables.)

Para activar o desactivar las capas que van a estar implicadas &n las operaciones de seleccion: En el menu
Selection > Set Selectable Layers

[ Fstahlecer canas seleccionahles

2.2.1. Seleccion Interactiva

e Permite seleccionar elementos desde la Vista de datos
* Seflalando Con el puntero sobre el registro puedes seleccionar elementos en |a Tabla de Atributos
*  Seleccion por graficos. Se elabora el grafico con las herramientas de dibujo. Una vez afadido la opcion

Seleccion por Graficos se activara en el menu de seleccion. (Menu Selection > Select By Graphics).

T BT e —
oy & b -
iy v * tey il A [

En cualgquier de los casos hay que tener en cuenta:
*  Que la seleccion de un nuevo elemento o registro anula la seleccion anterior

e Por ello, si se desea seleccionar mas de un elemento o registro deberan utilizarse las herramientas
anteriores manteniendo pulsada MAYUSC.

»  Métodos de Seleccion Interactiva (Clic en el menl general Selection > Selection Method):

e Create a New Selefion (Crear una nueva seleccion): Opcion a utilizar cuando lo que se pretende es
realizar una nueva seleccion o anular otra previa.
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e Add fo Current Selection (Ahadir a la seleccién actual): Opcidn a utilizar cuando se pretende afadir
registros a una seleccion existente

«  Remove from Current Selection (Eliminar de la seleccion actual)

* Select from Current Selection (Seleccionar de la seleccién actual): Opcidn utilizar cuando se pretende
realizar una seleccién mas pequefia de entre un grupo de registros ya seleccionados.

Métodos de seleccion Interactiva

» Opciones de Seleccién Interactiva (mend general Selection >
Options)

E! cuadro de dialogo Options Selection te ofrece tres opciones adicionales de
seleccion dependiendo del modo en que queremos que los elementos se
seleccionen al crear un cuadro de seleccion:

»  Select features partiallly or completely within the box or graphic: aqui se
seleccionan elementos completos sin importar si estan completa o
parcialmente dentro del cuadro de graficos.

Select features completely within the box or graphic: agui los elementos
se seleccionan solo si estan completamente dentro del cuadro del grafico.

e Select features thatthe box or graphic are completely within: aqui el
cuadro de seleccion debe estar completamente dentro del elemento a
seleccionar.

2.2.2. Seleccioén por Atributos

Consiste en realizar una seleccién basandose en la informacion tematica de Ia tabla de atributos asociada a la
capa. Para ello se realiza una consulta mediante lenguaje SQL (Lenguaje de Consulta Standar), el cual de
definen los criterios de seleccion.

Se pueden construir expresiones para:

¢ Selecciona elementos directamente desde la Vista de datos. = En el Menu Selection > Select By
Attributes)

e Seleccionar registros en una tabla = En Ia Tabla de Atributos > Options > Select By Attributes)

/{{Para abrir |a tabla de atributos desde ArcMap: clic con el boton derecho del ratén sobre la capa > Open
Atributte Table//

//Nota: seleccionar registros en una tabla de atributos, también marca elementos en el mapa y viceversa//

En ambos casos aparece el cuadro de dialogo Select By Attributes.
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Para realizar la seleccidn por atributos se siguen los siguientes pasos:

.3l 1. En Layer, seleccionar la capa en la que gueremos seleccionar
TR
los elementos

2. Establecer el método de seleccién (crear una nueva seleccion,
anadir a la seleccion actual...)

3. Escribir la sentencia de seleccion mediante secuencia SQL.

La sentencia consta de tres partes:

e Un CAMPO en el que de3be cumplirse la seleccion

¢ Un OPERADOR que establece el tipo de condicion (igual a,
mayor gue...)

e Un VALOR gue representa el criterio a cumplirse (en caso
de campos de texto han de introducirse entre comillas)

Podemos guardar afirmaciones de seleccion y cargarlas con los
botones Save (Guardar) y Load (Cargar), que se encuentran en
la parte inferior del cuadro de dialogo, lo que ahorra tiempo a la
hora de trabajar con expresiones de consulta complejas.

2.2.3. seleccién por Localizacién (consulta espacial)

Consiste en realiza una seleccion de elementos de una capa a partir de las relaciones geograficas espaciales
con los elementos de otra capa. En lugar de utilizar el cursor o las formas geométricas para seleccionar
elementos, se utilizan elemento de una capa para seleccionar los elementos de otra.

Esta seleccion se lleva a cabo mediante el cuadro de didlogo Selecciéon por Localizacion.(En el Menu
Selection > Select By Location)

La seleccion se lleva a cabo siguiendo los siguientes pasos:
1. Elegir el método de seleccion (crear una nueva seleccion, afiadir a la seleccio X
2. Seleccionar la capa en la que queremos seleccionar los elementos.

3. Elegir el Tipo de seleccion espacial

4. Seleccionar la capa de referencia gracias al cual se podra realizar la seleccior

INTERSECT (intersecta con)

ARE WITHIN A DISTANCE OF (se encuentra a una distancia inferior a)

COMPLETELY CONTAIN (contiene completamente)
ARE COMPLETELY WITHIN (se encuentra completamente dentro)

HAVE THEIR CENTER IN (tiene su centro o centroide dentro)

SHARE A LINE SEGMENT WITH (comparte un segmento iineal con)

ARE IDENTICAL TO (es idéntico a) 7 :
OTROS . —
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2.3.Creacion de una capa a partir de selecciones

Cualguier seleccion efectuada sobre una capa puede ser convertida en una nueva capa. Para realizar esta
operacion tenemos dos opciones:

Opcion 1

e  Clic con el botdn derecho del ratén en la capa en la que estan los elementos seleccionados > Selection >
Create Layers from Selected Features (generar capa de elementos seleccionados)

Esta nueva capa es una capa virtual. Aunque en el indice aparece como una entrada individual no
esta guardada en el disco como un dataset independiente. Esta capa virtual tiene las propiedades de la capa
original y puedes simbolizar, hacer consultas y ejecutar analisis basados en ArcMap como si fuera otra clase
de elemento. En caso de querer guardarlo como un dataset independiente, lo tienes que exportar a una clase
de elementos tipc Shape gue es o que se pretende en la segunda opcion.

Opcion 2

e Clic con el boton derecho del ratdon en la capa en la que estan los elementos seleccionados > Data >
Export Data. Esta opcion conduce al cuadro de didlogo Export Data, en el que se indica que se quieren
exportar los elementos seleccionados se indica la ruta, se asigna un nombre a la nueva capa y se define
su ubicacion en el directoric o disco deseados. Asi mismo se ofrece la posibilidad de incorporar la capa a
la vista.

A

%Esx‘ii

Copy
x Remove

| Open Attribute Table RN
Joins and Relates 3
@ Zoom To Laver

visible Scale Range 14

Use Symbol Levels
Selection

Label Features

“% Convert Features to Graphics.

Save &s Laver File..,

B Properties...

2.4. Generar resumenes estadisticos

Despues de realizar una seleccion es posible que queramos generar un

resumen estadistico. Para ello; en el Menu Selection > Selection
Statistic

En la ventana Estadisticas de seleccién se selecciona para qué capa y
campo de la tabla de atributos queremos generar los resumenes

estadisticos. Entonces aparece en la ventana un resumen estadistico numérico y un grafico de distribuciones
de la frecuencia.
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UNIDAD 4. TRABAJAR CON TABLAS

CONTENIDOS

e Tablas
Estructura de la tabla
Tipos de campos
Modificar la tabla
Formatos tabulares de ArcGis

e Relacionar Tablas
Cardinalidad
Joins (uniones) y Relates (relaciones)

+ Graficos e Informes

1. Tablas

Una tabla contiene informacion descriptiva en un formato determinado. En el software ArcGis la informacion
de una tabla generalmente esta asociada a datos espaciales, como es una tabla de atributos de los elementos
de una feature class. Sin embargo, en ArcGis la informacion tabular puede ser independiente de los datos
espaciales, como datos estadisticos no espaciales.

Para abrir una tabla de atributos de una feature class:
. En ArcMap = Hacer Clic con el botdn derecho del raton sobre la capa > Open attribute table.

. En ArcCatalog = Marcamos |a feature class cuya tabla queremos visualizar y en la pestafia Preview,
seleccionamos al opcién Table

1.1. Estructura de la tabla

Las tablas estan compuestas por registros (filas) y campos (columnas). Cada campo contiene un tipo de
informacion descriptiva y los registros contienen los atributos de un elemento del conjunto de datos. La
interseccion de una fila y una columna representa un atributo especifico de un tnico elemento.

COLIURMINAS

Yaloressde log
atrthines

o

Algunas tablas, como una tabla de atributos de una feature class tienen un numero minimo de columnas
predefinido. Por ejemplo, una cobertura de un poligono, tiene cuatro columnas estandar: area, perimetro,
cobertura# y cobertura-id (identificador). Otras tablas son completamente definidas por el usuario. La tabla del
ejemplo, tiene cuatro columnas afadidas por el usuario: AREA, PERIMETER, CODIGO y TIPO. El software
ArcGis afiade automaticamente una columna liamada FID con propésitos de identificacion

Médulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA 2007 40



Sistemas de Informacion Geogréfica UNIDAD 5

1.2. Tipos de campos

Las tablas pueden almacenar valores de datos, numeros y texio. Podemos diferenciar diferentes tipos de
campos en funcion del tipo de formato de dato que almacenen. En este sentido, los formatos que ArcGis
incluye en sus tablas son:

Text (texto); el formato texto almacena una serie de elementos alfanuméricos
Short Integer (entero corto)

Large Integer (enterc largo)

Float o Double (decimal)

Date (fecha), el formato fecha permite almacenar fechas y horas (mm/dd/yyyy hh:mm:ss y especificando
AM o PM)

Es importante seleccionar el mejor tipo de campo para almacenar los valores.

1.3. Modificar la tabla

En ArcMap y ArcCatalog se pueden realizar muchas operaciones en las tablas como son:
Sort Ascending

e

¢ Ordenar de forma ascendente o descendente los registros en base a algin campo
Sort Descending

¢ Bloqueary desbloquear columnas, con la opcion hreeze Riaezeaonmn
e Generar estadisticas

¢ Creary eliminar campos

Ademas, en la tabla de atributos de ArcMap podemos:
e  Buscary seleccionar registros

e  Editar registros de una tabla existente

PROVIIICIA

#% Find & Replace...
E?L Select By Attributes.
Select Al

D Clear Selection

@ Switch Selection

Add Field. ..
Related Tables L3
Create Graoh. ..

Add Table to Layout

el
+ Reload Cache

Export..

Appearance...

1.4. Formatos tabulares de ArcGis

ArcGis puede trabajar con multiples formatos para el almacenamiento y gestion de la informacién tabular.
Cada tipo de archivo de datos espacial tiene un formato tabular nativo. De esta forma, las coberturas utilizan

tablas con formato INFO, los shapefile almacenan sus atributos en formato dBASE (dbf) v las geodatabases
en SGBDR (Acces u Oracle, por ejemplo).

Algunos formatos, como el de las coberturas pueden asociarse a tablas independientas sin tener el cuenta el
formato que estas tablas tienen.
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2. Relacionar Tablas

Es posible relacionar dos tablas si hay un campo similar en ellas gque contenga valores comunes. Por ejemplo,
imagina gue tenemos un archivo shape que representa la litologia de un determinado lugar y cuya tabla de
atributos define cada tipo litologia mediante un cédigo. Por otro lado, tenemos una tabla en la que se le asigna
el nombre del tipo de litclogia a cada coédigo. ArcGis te da la posibilidad de relacionar ambas tablas ya que
tienen ios codigos como valores comunes.

Ve e o

Ya que a menudo los elementos tienen muchos atributos, muchos disefios de bases de datos promueven la
organizacion de las bases de datos en multiples tablas, cada una con un tema especifico, en vez de una gran
tabla que contenga todos los campos necesarios. Este esquema evita la informacion duplicada en base a
datos ya que la informacién se almacena una sola vez. Las tablas se pueden relacionar para que cuando
necesitemos informacion que no se encuentre en la tabla actual, podamos acceder a ella desde una tabla
relacionada.

2.1. Cardinalidad

Cuando asociamos dos tablas, es necesario saber como se relacionan los registros individuales entre si. A
esta relacion entre registros es a lo que se le dencmina "cardinalidad". La cardinalidad entre registros podra
SEr: uno a uno, Uuno & muchos, muchos a unoy muchos a muchos.

Ej. Hay tres parcelas y tres propietarios
. Relacion uno a uno: cada parcela pertenece a un Unico propietario

. Relacion uno a muchos: una parcela tiene tres propietarios o las tres parcelas tienen el mismo y
unico propietario.

. Relacion muchos a muchos: todas las parcelas tienen multiples propietarios

Es muy importante conocer la cardinalidad entre registros antes de relacionar las tablas ya que, de esta forma,
evitaremos errores potenciales de registros. Por ejemplo, si tenemos una asociacion uno a muchos y
conectamos las tablas como si fueran uno a uno, omitiriamos informacién necesaria de la tabla relacionada ya
que el registro uno a uno detiene la busqueda en cuanto encuentra la primera similitud.

2.2, Joins (uniones) y Relates (relaciones)

ArcGis nos da la oportunidad de relacionar datos almacenados en tablas diferentes. Por ejemplo, podemos
tener una tabla de municipios de Andalucia, donde existen varios campos (uno de ellos indica el nombre del
municipio, otro la provincia a la que pertenece, otro la superficie del municipio), y hay una segunda tabla
donde quedan recogidos los nombres de los municipios y la poblacion de cada municipio. si quisiéramos
calcular la densidad de poblacién de cada municipio (n° habitantes / superficie del municipio en Km2) no
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podemos hacerlo ya que la informacién esta en tablas diferentes. Seria necesario relacionar ambas tablas
para realizar esta operacion.

ArcMap proporciona dos métodos para relacionar datos almacenados en tablas: JOINS (uniones) y
RELATES(relaciones). En ambos casos, es necesario que las tablas a asociar tengan un campo en comun
(en el caso del ejemplo anterior, para relacionar las tablas es necesario que exista un campo comun en el que
aparecieran los nombres de cada uno de los municipios).

JOINS

Los JOINS anexan atributos de una tabla a otra basandose en un campo en comuin de ambas tablas. Estas
uniones de tablas estan disefiadas para relaciones con cardinalidad uno a uno o muchos a uno. Para otras
cardinalidades deberemos utilizar un RELATE, ya gue se utilizamos un JOIN con cardinalidades uno a
muchos o muchos a muchos, omitiremos todos los registros tras la primera similitud encontrada.

El JOIN trabaja con shapefile, coberturas y geodatabases. Una vez que las tablas esta conectadas podemos
realizar consultas, simbolizar o analizar la nueva tabla basada en los valares combinados.

Las tablas conectadas mediante JOIN no estan permanentemente conectadas. En ArcMap, las tablas estan
virtualmente unidas, aungue podemos visualiza esta relacion, la gestion de ambas tablas se sigue realizando
por separado.

i
- MR
x = Copy
X Remove

Para realizar un JOIN en ArcMap tenemos dos opciones

e Clic con el botdn derecho del ratén sobre la capa en la que
queremos hacer el JOIN > Joins and Relates > Join.

Open Attribute Table

= Clic con el botén derecho del ratéon sobre la capa en la que 4 Zoom To Layer Rgmove Join(s) ¥
queremos hacer el JOIN > Propiedades > pestafa Joins & Relates Jisbie Scae Range > iBeate

Use Symbol Levels Remove Relate(s) ¥

ArcMap nos ofrece dos opciones a la hora de realizar un JOIN:

» Join attributres from table: se trata de la unién entre dos tablas basandose en un campo en comun.

El menu JOIN nos permite seleccionar qué campo contiene los valores a fravés de los cuales se va a
establecer la union. Al realizar la union los nombres de los campos no tienen que ser idéntico, pero los
campos deben ser del mismo tipo (texto, fecha, decimal...)

Campo de |z tabla seleccionada gue
et CORGERE los valores comunes

Tablao capa con cuva tabla quieres
relacionar

e e

Campo de fa segunda tabla que contiene
los valores comunes
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» Join data from another layer based on spatial location (Join Espacial): Consiste en la unién de tablas
basandose en la relacion espacial entre las dos tablas.

Ej. Tenemos, por un lado un archivo de datos con la informacion relativa a las estaciones meteoroldgicas de
Andalucia y otro archivo que contiene los municipios también de Andalucia. Imagina gue gueremos saber a
que municipio esta asociado cada yacimiento arqueolégico pero las tablas de atributos de ambos archive no
contienen campos en comun. Utilizando un Join espacial se puede llevar a cabo esta operacion.

Los eiementos de ia capa de entrada sobre los que se realiza el JOIN espacial son ios que reciben ios
campos que constituyen |a tabla de atributos de los elementos de la capa de superposicién. Cada registro de
la capa final, por tanto, recibe los atributos de los elementos del tema de superposicion con los que comparta
localizacion.

RELATES

Otro modo de conectar tablas es a través de un RELATE. Este al igual que el JOIN define una relacién entre
tablas basandose en un campo en comun. Sin embargo, el RELATE no anexa los campos de una tabla a otra,
sino que las dos tablas permanecen independientes en ArcMap. ArcMap no establece una conexién visual de
la tablas, pero si una conexion entre las dos tablas de forma que podemos acceder a los datos de las tablas
relacionadas cuando sea necesario.

Se puede hacer un RELATE entre tablas cuando existe una relacion entre ellas de uno a muchos, de muchos
a muchos o cuando necesitemos mantener la informacion de la tabla relacionada, independiente de la tabla de
atributos. Por ejemplo, utilizaremos el RELATE cuando tenemos unza tabla con el nombre de 10s nucleos de
poblacion, y en otra tabla aparecen los restaurantes que existen dentro de cada nicleo (puede haber varios
restaurantes dentro de cada nucleo), por lo que, tras realizar una conexion de tipo RELATE, al preguntar a un
nucleo de poblacion nos indicara el nimero y nombre de todos los restaurantes que se encuentran dentro del
anterior nucleo.

ArcMap nos ofrece dos opciones para realizar un RELATE:

* Clic con el botén derecho del ratén sobre la capa en la que queremos hacer el RELATE > Joins and
Relates >Relates

*  Clic con el boton derecho del raton sobre la capa en la que queremos hacer el JOIN > Propiedades >
pestana Joins & Relates

Campo de la tabla seleccionada que

&1 l;é: . b e e - “
I contiene los valores comunes

Tabla o capa con cuva rabla quieres
relacionar

« w4 Campo de la segunda tabla gue contiene
los valores comunes

o Nombre que le quieres daral RELATE

I
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Para ver los elementos relacionados: En la tabla de atributos de la capa relacionada > Options >Related
tables.

Los JOINS y RELATES se actualizan cada vez que abrimos el mapa. De este modo, si los datos subyacentes
en nuestras tablas cambian, este cambio se vera reflejado en la unidn o relacién.

Los JOINS y RELATES también se pueden eliminar.

. Eliminar un JOIN: Clic con el botén derecho del ratén en la capa sobre la que se ha realizado el JOIN
> Joins and Relates > Remove Join(s).

. Eliminar un RELATE: Clic con el botén derecho del ratén en la capa sobre la que se ha realizado el
RELATE > Joins and Relates > Remove Relate(s).

UNIDAD 5. EDITAR DATOS

CONTENIDOS
» Formatos de datos editables
¢« Herramientas de edicion en ArcMap

Seleccionar elementos

Funciones simples de edicion

El ment Sketch (borrador de edicion)
Task. Las Tareas de Edicion

e Menus contextuales de Edicion

Menu contextual de dibujo
Menu contextual de herramientas de dibujo

« Snapping environment

Tolerancia Snapping
Propiedades Snapping

« Editar Atributos

Editar atributos para elementos seleccionados
Editar tablas

1. Formatos de datos editables

independientemente de la licencia de ArcGis que poseamos (ArcView, ArcEditor o Arcinfo) utilizaremos las
mismas herramientas de edicién de ArcMap para trabajar con nuestros datos geograficos. Sin embargo, los
formatos de datos que nos permiten editar cada una de estas licencias son diferentes.

= ArcView, sélo nos permite editar shapefile y geodatabases.

*  ArcEditor y Arcinfo nos permite editar todos los formatos vectoriales de ESRI: Coberturas, shapefile y
geodatabases.

2. Herramientas de edicion en ArcMap
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En ArcMap, las operaciones de edicién se controlan a través de la barra de herramientas de Editor. Esta barra
de herramientas tiene varios controles importantes:

Cuadyo de disdog

Hervanmmia boriades de aribsie

de edicion

Capas de destue

Herrnnooents
Henm i
o Last desplegable e
* Loy ;
Canvudos de S e 2 < X
o s i 5
tliien * Herramenta de Herrmmno de
drviiang de el ies TeTacion

e

2.1. Menu EDITOR desplegable:

Este menu contiene los comandos para comenzar, terminar y guardar las sesiones de edicion (Start Editing,
Stop Editing, Save Edits). También proporciona acceso a varias operaciones de edicion, controles de ajuste y
opciones de edicion.

2.2. Seleccionar elementos

ArcMap dispone de varios métodos para seleccionar los elementos que necesitamos editar. Estos métodos se
dividen en tres categorias basicas:

. ~ o :
. Seleccion interactiva: mediante la herramienta Edit Tool o dibujando una forma (cuadro, linea
o area).
. Menu Selection (Select by attributes o Select by location).

Se puede controlar qué capas estan disponibles desde el menu Selection.

2.3. Funciones simples de edicion
ArcMap contiene varias funciones simples para editar elementos espaciales:

e Movery arrastrar elementos: es posible realizar esta funcion seleccionando con el cursor.

s () )
¢ Rotacion ’ . los elementos al seleccionados se pueden

e Split Tool: este control permite dividir el elemento seleccionado en dos elementos ¥ BB X
independientes. rotar alrededor de su eje de rotacion. :

e  Attribute dialog (cuadro de didlogo de atributos): esta ventana nos permite editar los valores de los
atributos de los elementos seleccionados.

s Otras (borrar, cortar copiar, pegar, hacer, deshacer).

2.4. El menu Sketch (borrador de edicién)
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La herramienta Sketch de edicion es la herramienta principal de ArcMap. No permite editar nuevos elementos
a partir de las diferentes opcicnes de la Lista de Tareas de Edicion (Task). Para utilizar el Sketch, el boton

izquierdo del raton afiade elementos y el botdén derecho nos permite acceder al ment contextual Sketch
Tools.

WTasﬁ ] |
: - Intersection too
Sketch toal ;-‘& ”ir'u?‘;wf ch tool
Midpaoint toaol B ﬁ—‘ Tangent Curve tool
Distance-Distance tool —#&2| £} <2 Trace taol

Direction-
Distance tool

Endpoint
Arc tool

Diferentes opciones de la herramienta Sketch Too!

»> Intersection tool (herramienta interseccién): Crea un vértice o punto en la interseccién implicada de los
segmentos.

» Arc Tool (herramienta arco): Nos ayuda a crear un segmento gue sea una curva parametrica (real), es
decir, en vez de estar compuesta por varios vértices, solo esta compuesta por dos.

A4

Midpoint Tool (herramienta punto medio): permite localizar un nuevo vértice o punto a partir de otros dos.
La localizacion de este nuevo vértice sera el punto medio de entre estos dos vértices.

» End Point Arc Tool : permite crear un arco a partir de un radio dado.

» Distance Tool (herramienta distancia) : Nos permite crear unn vertice o punto en la interseccion de dos
distancias predeterminadas a partir de dos puntos especificos

»  Direction-Distance Tool: permite editar un vértice o punto a partir de una distancia y direccién dadas.

» Trace Tool (herramienta trazar): permite crear segmentos digitalizando sobre un segmento ya existente.

2.5. Task list. Las Tareas de Edicion

Se trata de una lista desplegable donde se selecciona la operacion de edicion que queremos realizar. Las
tareas cambiaran de acuerdo con |a clase de elemento que estemos editando.

* Create Tasks (tareas para crear elementos)

¢« Modify Tasks (tareas para modificar elementos)

» Topology Tasks (tareas para modificar la topolegia entre elementos)

s  Other Tasks . L, e e
Edtor b A v Tesk [FERVETREIeS

4

i

| # ContinuAZIon Tarea en ejecucion
detallaremos algunas de estas tareas: rente e

Create New Features (Crear nuevos elementos)

Editor ~ b & v Task Create New Feature ~  Target I\.rnii:es”n.'num.ciﬁa.l.eé”Wmm >
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Esta herramienta sera utilizada para crear nuevas entidades en una feature class ya existente. Una vez
seleccionada esta tarea y la capa que queremos editar, utilizaremos alguna de las herramientas Sketch para
hacer el dibujo, las cuales nos ayudaran a ubicar vértices y segmentos en los lugares precisos.

Reshape Features (Reestructurar elementos)

Esta tarea se puede utilizar para digitalizar un dibujo que sera parte del elemento que estamos reformando.
Para ello, seleccionamos el elemento a modificar > dibujamos la nueva forma del elemento asegurandonos
que nuestro dibujo intersecta con el elemento existente > Finish Sketch.

Cut Polygon Features (cortar elementos poligonales)
Esta tarea nos permite dividir un poligono en dos. Se utiliza especificamente para la gestion de parcelas.

Seleccionamos el elemento que guerames dividir > dibujamos una linea que intersecte ambos lados del
poligono > Finish Sketch.

Extend/Trim Features (extender y recortar elementos)

* Extender elemento hasta el dibujo: Seleccionamos el elemento que vamos a extender > dibujamos una
linea hasta donde lo queramos extender > Clic con el boton derecho del ratén para que aparezca el menu

contextual > Selecciona la opcién Replaze Skefch > En el mismo menl contextual selecciona la opcién
Finish Sketch.

* Recortar elementos: Seleccionamos el elemento que queremos recortar > Dibujamos una linea de corte
en el lugar a partir del cual queremos recortar >Clic con el boton derecho del raton para que aparezca el
menl contextual > Selecciona la opcion Replaze Sketch > En el mismo menuU contextual selecciona la
opcion Finish Sketch.

Modify Features.

Esta tarea nos permite editar los vértices de un elemento ya existente. Para ello basta con mantener el cursor
sobre el vértice que gqueramos modificar hasta que cambie de forma, ahora, tenemos que hacer Clic sobre el
vertice y arrastrarlo a una nueva posicion.

e

Auto-complete Polygon (autocompletar poligonos)

Esta tarea permite afiadir poligonos a otros ya existentes sin tener que duplicar el borde que comparten
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Select Features using a Line (seleccionar elementos utilizando lineas)

Esta tarea permite seleccionar elementos a partir de una linea que intersecte con

dichos elementos. Esta linea se dibuja con el Sketch Tool

2.6. Target layer (capa de destino)

Este control nos permite seleccionar la capa que queremos editar.

3.

Menis contextuales de Edicién

UNIDAD 5

Un menu contextual es un menu flotante que aparece en la posicion del cursor cuando hacemos Clic con el
boton derecho del raton. Hay dos tipos de menus contextuales relacionados con la herramienta Sketch Tool:
Sketch context menu (menl contextual de dibujo) y Sketch fool confext menu (menl contextual de
herramientas de dibujo).

Menu contextual de dibujo

Trabaja directamente con el dibujo al completo. Aparece haciendo Clic con el botdn derecho del raton sobre el
dibujo una vez se ha afiadido el vértice. Este menu ofrece las siguientes opciones:

INSERT VERTEX y DELETE VERTEX (insertar y eliminar vértice); haciendo Clic
con el botén derecho del raton sobre en un dibujo, en la posicién donde queramos
insertar o eliminar el vértice. (Con Current task: Modify Task)

MOVE: permite mover un vértice especificando unas coordenadas relativas (por
ejemplo, la localizacién original del punto es {0.0) y queremos mover el vértice a
una nueva localizacion a partir de unas coordenadas de unidad de mapa
especificadas).Haciendo Clic con el botdn derecho del ratén sobre el vértice que
queramos mover > Move > especificar las coordenadas relativas a las que
queramos mover el vertice > Finish Sketch (con Current task: Modify Task)

MOVE TO: permite mover un vértice a una posicion X,Y absoluta. Haciendo Clic
con el boton derecho del raton sobre el vértice que queramos mover > Move to>

Route Measure Editing

Delete Vertex
Maove...

Move To...

Delete Sketch Ctri+TECLA DECIMAL
Finish Sketch Fz
Finish Part

Properties...

especificar las coordenadas x,y a las que queramos mover el vértice > Finish Sketch. (Con Current task:

Modify Task)

FLIP: permite modificar anotaciones.

TRIM TO LENGTH (modificar la longitud de un dibujo): permite recortar un elemento una longitud dada.
Haciendo Clic con el botéon derecho del ratdn sobre el Ultimo vértice anadido > Trim fo length > escribir la

cantidad a recortar > /nitro. (Con Current task: Modify Task)

DELETE SKETCH (eliminar dibujo).

FINISH SKETCH (finalizar el dibujo). Clic con el botén derecho del raton justo donde acabemos de

digitalizar > Finish Sketch en el menu contextual.

FINISH PART (terminar parte). Clic con el botdn derecho del ratén justo donde acabemos de digitalizar >
Finish Part en el ment contextual. (Esta opcién es Util para crear elementos multipartidas, por ejemplo,

muchas islas que pertenecen a un mismo pais).

EDIT SKETCH PROPERTIES (editar las propiedades del dibujo).
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Menu contextual de herramientas de dibujo)

Aparece mientras se esté utilizando la herramienta Sketch tool, haciendo Clic con el boton derecho del raton.
Algunas de las opciones con las que cuenta este menu son:

* SNAP TO FEATURE : permite acceder al Snapping environment. 20ap Jofadtirs

Direction, .,
e DIRECTION (direccion): permite especificar el anguio hacia ei que quieres dirigir el dibujo.
Clic con el botén derecho del ratén > Direction > especifica el angulo que quieres que Lengthics

tome el dibujo > Intro.
Absolute %, ¥...

e DEFLECTION (desviacion): permite dibujar un segmento especificando un angulo en Delta®, ¥...
relacion con el segmento anterior. Una vez dibujado un primer segmento, Clic con el Direchionfenat
boton derecho del raton > Deflection > especificar el angulo en relacion con el altimo &
segmento > Intfro.

Perpendicular

Segment Deflection...

* LENGTH (longitud): permite especificar la longitud que quieres que tenga el dibujo. Una fiepigee et
vez dibujado el primer vértice, haz Clic con el botdn derecho del raton > Length > escribe
la longitud deseada > Intro. Creara un segmento de |a longitud especificada.

Streaming

* CHANGE LENGTH (cambiar longitud):permite cambiar la longitud del Gltimo segmento
creado. Al cambiar la longitud, ArcMap mantiene la direccion de este Gltimo segmento y
mantendra su angulo.

Cerl+-d
ChriL

Fe
Ctri+D
G
Ctrp

Chrl+E
F?

F&

Delete Sketch  Chrl+TECLA DECIMAL

e ABSOLUTE X,Y: permite crear un nuevo punto o vértice estableciendo un vaior absoluto
de x ey, es decir basado en el sistema de coordenadas y unidades del mapa.

* DELTA X,Y: permite crear un nuevo punto estableciendo un valor relativo de x e y, es decir, en funcion
del Ultimo vértice creado.

* DIRECTION/LENGTH (direccién y longitud): permite especificar el dngulo y la longitud del dibujo.

* PARALLEL (paralelo): limita un nuevo segmento para que sea paralelo a otro existente. Colocando el
cursor sobre el segmento de referencia, Clic con el botdn derecho del ratén > Parallel.

¢ PERPENDICULAR (perpendicular): limita un nuevo segmento para que sea perpendicular a otro
existente. Colocando el cursor sobre el segmento, Clic con el botén derecho del raton > Perpendicular.

* SEGMENT DEFLECTION: permite dibujar un segmento especificando un angulo en relacion a otro
segmento. Colocando el cursor sobre el segmento, Clic con el botdén derecho del ratén > Segment
Deflection > especificar el angulo > Intro.

* REPLACE SKETCH (reemplazar dibujo).

e TANGENT CURVE (curva tangente): permite dibujar una curva tangente al Ultimo segmento dibujado a
partir de un parametro dado.

* STREAMING: permite acceder la modo de digitalizacion Stream, con el cual se capturan elementos
cuando no es mucha la precision requerida a la hora de hacer el dibujo. Con este modo de digitalizacion,
ArcMap va afiadiendo los vértices automaticamente a determinados intervalos de distancia que tu has
establecido previamente.

* DELETE SKETCH (eliminar dibujo)
e FINISH SKETCH (finalizar dibujo)
e  SQUARE AND FINISH

e FINISH PART (terminar parte)
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4. Snapping environment

Te permite establecer la localizacion exacta de un elemento en relacidn a otro. Por ejemplo, queremos dibujar
un segmento gue termine justo donde empieza otro y en ocasiones se hace dificil (por la escala, por la
confluencia de muchos segmentos...). El snapping environment hace que esta operacion sea mas facil ya que
mueve automaticamente el puntero hacia el vértice, angulo o punto segun lo hayas establecido.

4.1, Tolerancia Snapping

La tolerancia (snapping tolerance) es la distancia a partir de la cual el puntero va a ser anadido
automaticamente al angulo, vértice o punto.

Para establecer la tolerancia: En el mend Editor > Options > pestaria
General

Togher b ysaeunys wag | 7 Seesndtacn:

Frraoparg bt

Fhk o e Smeae e

Grsedads grsvraes rgei o KA MRS SYSoNE B Vb

4.2. Propiedades Snapping

T st Shgetbes b Shiarii

El menu Snapping Properties te permite establecer la opcion de snapping,
es decir, si quieres que el puntero se acerque automaticamente a un angulo,
vertice o punto.

Para establecer las Propiedades: En el menl Editor > Snapping.

Layer “Vertex Edge End
{Editar
{editarlineas

5. Editar Atributos
5.1. Editar atributos para elementos seleccionados

El Cuadro de didlogo de Atributos (aparece haciendo Clic en )
permite visualizar los atributos de los elementos seleccionados.

En la parte izquierda de cuadro aparece una lista con los elementos
seleccionados. La parte derecha, contiene dos columnas: los campos de la capa que estamos viendo y los
valores o atributos para el elemento seleccionado.

ArcMap permite afiadir atributos y cambiar el valor de los ya existentes. También ofrece la posibilidad de
copiar_atributos individuales o todos los atributos de un elemento. Los atributos se pueden pegar 2 un
elemento Unicamente o a todos los elementos seleccionados de la capa. Para copiar un valor de atributo a
una capa, hay gue copiarlo y hacer Clic con el botén derecho del raton sobre el nombre de la capa. a
continuacion, hacemos Clic en Pegar y entonces el valor del atributo se copiara en cada elemento
seleccionado en la capa.
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5.2. Editar tablas

ArcMap permite cambiar los valores de los atributos directamente sobre las tablas con el modo de Edicién
activado (menu Edjtor > Start Editing).

1. Crear un nuevo campo en una tabla ya existente (modo de edicion apagado)

Con la tabla de atributos abierta, Options > Add Fiel > en el cuadro de dialogo Add Field especificar el nombre
del campo y el tipo de dato que va a contener > OK.

2.Editar el nuevo campo. Dos opciones:

e Directamente, escribiendo los valores de los atributos (menu Editor
activado)

* Con la Calculadora de Campos CALCULATE.

Para abrir la calculadora de campos: Clic con el botdn derecho del raton en el
campo para el que queramos editar los valores > Calculate Value. Aparece un
menu que nos permite realizar calculos simples y expresiones logicas complejas
incluyendo otros campos de la tabla (por ejemplo, si tenemos un campo con la
poblacion y otro con la superficie de U municipio, podemos crear un campo
llamado densidad y decirle que el valor de éste sera la division de los dos
campos anteriores)
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UNIDAD 6 COORDENADAS, SISTEMAS DE REFERENCIA Y PROYECCIONES CARTOGRAFICAS
CONTENIDOS
* Elaboracion cartografica
o Laforma de la tierra
o El elipsoide de referencia
o Eldatum
* Georreferenciacién. Sistemas de coordenadas
o Sistema de coordenadas geograficas o esféricas
o Sistema de coordenadas geograficas o esféricas
* La referencia espacial en ArcGis
o  Almacenamiento de la informacion de la referencia espacial
o Visualizacién y modificacion de la informacion de la referencia espacial
o Las proyecciones en ArcMap
¢« Lainformacion espacial de los archivos con formato raster.
¢  Georrreferenciacién de archivos CAD

1. La elaboracion de cartografia

El proceso de elaboracion cartografica, con caracter general conlleva:

4. La determinacion de la localizacion geografica de diferentes elementos de la superficie terrestre,
5. su transformacion a las correspondientes situaciones en una superficie plana (mapa), y

6. larepresentacion grafica de estos elementos a través de simbolos o signos.

Para llevar a cabo este proceso de elaboracion se necesita, en primer lugar, conocer, con la mayor
exactitud posible, la forma y tamario de la tierra, la cual es el objeto de representacion.

1.1. La forma de la tierra
La esfericidad terrestre

La forma habitual en la que se ha descrito el planeta tierra es el de una “esfera achatada por los polos”. Y
ciertamente esta forma se asemeja a la descripcién si se toma una visién en conjunto.

El planeta tierra tiene un radio ecuatorial (maximo) de aproximadamente 6378 Km.,
frente a un radio polar de 6357 Km. (minimo), con una diferencia de 21 Km., lo que
supone un 0,329 % de radio ecuatorial.

ESFERICIDAD TERRESTRE

El elipsoide Redin Ecaatoriad e |
P diferencia Sljiibn%

Como acabamos de ver, podriamos representar la tierra como un elipsoide,
entendiendo éste como el cuerpo geométrico que resulta de hacer girar una elipse en torno a su eje
menor.

Mientras que la esfera se define Unicamente por su radio, el elipsoide se define matematicamente en
funcion de los siguientes parametros:

El geoide

La Tierra tiene una forma unica, diferente a la de cualquier otro cuerpo que, precisamente por eso, recibe
el nombre de geoide. Se define geoide como la superficie tedrica equipotencial de la Tierra, es decir, la
superficie teorica que une todos los puntos de igual gravedad.
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Esta forma creada supone la continuacion por debajo de la superficie de los continentes, de la superficie
de los océanos y mares suponiendo la ausencia de las mareas, con la superficie de los océanos en calma
y sin ninguna perturbacion exterior, (como perturbaciones externas se encuentran la atraccion de la luna —
mareas- y las interacciones de todo el sistema solar).

Lejos de lo que se podria imaginar esta superficie no es uniforme, sino que presenta una serie de
irregularidades, causada por la distinta composicién mineral del interior de la tierra y de sus distintas
densidades, lo que implica que para cada punto de la superficie terrestre exista una distancia distinta
desde el centro de la tierra al punto del geoide.

1.2. El elipsoide de referencia

El geoide es un cuerpo geomeétrico irregular. Por ello, pera construir mapas, se reemplaza por el cuerpo
geométrico regular mas parecido a él: El elipsoide de referencia.

No hay un Gnico elipsoide que se adapte de la mejor forma posible a todo el geoide: cada continente,
zona, nacion... emplea un elipsoide de referencia distinto, el que mejor se adapte a la forma de la tierra
en la zona a cartografiar.

El elipsoide comparado con el geoide

Al comparar el geoide con el elipsoide comprobamos que ningun elipsoide se adapta n
perfectamente al geocide en toda su superficie. Existen diferencias de alturas entre

elipsoide y geoide causadas por la desigual distribucion de la gravedad superficial,

de forma que existen zonas de la tierra por encima del geoide y por debajo de éste.

Estas diferencias gravitatorias son causadas por la composicidon terrestre y la
presencia de una gran masa de agua en los océanos, que causa una menor atraccion y hace que, por lo

general, el geoide quede por encima del elipsoide en la zona continental y por debajo en la zona
oceanica.

Elipsoides de empleo mas usual

Existen gran variedad de elipsoides, que se van mejorando matematicamente para que tengan una mejor
aproximacion al geoide, o que las desviaciones encontradas con el geoide sean las menores posibles,
aunque para cada zona de la tierra se suele emplear un elipsoide distinto de manera que se adapte mejor
a las desviaciones locales del geoide. Los elipsoides mas empleados son los siguientes:

| CLARKE Hayford
Elipsoide i 1958 GRSS80 WGS84 WGS72 Int. 1924
—

omice 6378.293 6378.100 6378.137 6378.135 6378.388

mayor

.

i 6356.617 6356.752 6356.752 6356.750 6356.911

menor

indice d |

- 1/294.26 1/298.26 1/298 26 1/298.26 1297 |
achatamiento |
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1.3. El Datum

Se define Datum como el punto tangente al geoide y al elipsoide de referencia, donde ambos son
coincidentes.

Cada Datum esta compuesto por:

* Un elipsoide (definido por sus ejes y aplastamiento)

e Un punto llamado “punto fundamental” en el cual el
elipsoide y la tierra son tangenies (definido por sus
coordenadas geograficas: latitud y longitud)

Radio Polat

Radio Ecuatorial :

Datum local y datum global B Mo

Datum local: aguel que utiliza como referencia un elipsoide
local, es decir, en el que la longitud de sus ejes no cambia y el
elipsoide es “empujado” hasta que es tangente al geoide.

Datum global: aquel que esta referido a un elipsoide geocéntrico, es decir, en el que el centro de la tierra
es siempre el centro del elipsoide. La longitud de los ejes va cambiando hasta que geoide y elipsoide son
tangentes.

La cartografia basica espafola esta referida al Datum Local:
European Datum - 1950 (ED-50)
s« Elipsoide Hayford (internacional 1924)

¢  Punto fundamental :Postdam (52°22°51.446"'N 13°03'58.741"'E)

2. Georreferenciacion. Sistemas de coordenadas

La georreferenciacion es una forma de localizar un elemento sobre la superficie terrestre. Estos datos de
localizacion se refieren a las coordenadas "x” e “y" de cada punto en el espacio, y que son univocas, es
decir, no pueden existir dos puntos con las mismas coordenadas y que se localicen en diferentes lugares.

Los sistemas de coordenadas permiten establecer de forma univoca la posicidn que ocupa cada objeto en
la superficie terrestre. Se basan en una serie de puntos cuya posicién absoluta es conocida, y a partir de
los cuales se establece |a posicion de los demas mediante indicaciones de direccion y distancia.

La localizacion de un punto puede realizarse en base a dos sistemas de coordenadas:
 Coordenadas geograficas o esféricas

 Coordenadas planas o proyectadas

2.1. Sistema de coordenadas geograficas o esféricas

El sistema de coordenadas geograficas es el principal sistema a escala planetaria. Se trata de un sistema
de referencia apoyado en una serie de puntos identificables sobre la superficie terrestre (polos Ny S, y el
Ecuador) a partir de los cuales se construye una RED GEOGRAFICA.

Esta Red Geografica la forman:

° Paralelos: lineas de inierseccion de los infinitos planos perpendiculares al eje terrestre con la
superficie de la tierra. El paralelo principal es aguel que se encuentra a maxima distancia del eje de la
tierra, el Ecuador.

tn
th
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El ecuador divide la tierra en el hemisferio Norte y en el Hemisferio Sur. Se toma como origen del sistema

de referencia creado, de forma que se designa la posicion de un punto haciendo referencia a su situacion
con respecto a estos dos hemisferios

. Meridianos: lineas de interseccion con la superficie terrestre, de los infinitos planos que
contienen el eje de la tierra.

El sistema toma como origen para designar la situacién de una posicion geografica un determinado
meridiano, denominado “meridiano 0%, cuyc nombre lo toma de la ciudad inglesa por la que pasa:
meridiano de GREENWICH.

Este meridiano divide el globo terraqueo en dos zonas: la situada ai Qeste (W) del meridiano 0°, hasta el
antimeridiano y la situada al Este (E) del meridiano 0°, hasta el antimeridiano.

ks PARALZLOS Taew MERIDIARCS

Una vez tenemos establecida la red de paralelos y meridianos se puede definir |a situacion geogréafica de
un punto sobre la tierra. Su expresion requiere la determinacion de la distancia a la que se encuentra el
Ecuador en la direccion N-S (LATITUD) y la distancia a la que se encuentra de un meridiano de referencia
en la direccion E-W (LONGITUD).
e Latitud
latitud: /.

Arco de meridiano, medido en grados sexagesimales, entre un pinto y el  iongitue: ¢
Ecuador. =

La latitud maxima y minima oscila entre los 0° hasta los 90° — 0°-90° Norte,
0°-90° Sur.

e Longitud

Arco de paralelo, medido en grados sexagesimales, entre un punto y el
meridiano principal o de referencia por el camino mas corto.

La longitud presenta un minimo posible de 0° hasta un maximo de 180° —
0°-°80° E, 0°-180° W.

Ejemplo de designacion de coordenadas geograficas:

Al designar las coordenadas de un punto, primero se indica la latitud y despues la longitud.
Por ejemplo, la coordenada geografica de un punto P es:

P: 42°21°30”N 71°03'27"E

Il A veces, las latitudes sur y las longitudes oeste se indican mediante numeros negativos y a veces se
dan en grados decimales. (P: 42.3583N 71.0575E) 1/

Coordenadas geograficas y Datum

El uso de diferentes Datums da ligar a diferentes coordenadas geograficas para un mismo punto. Es
fundamental conocer el Datum para que la posicién de un punto sobre la superficie terrestre quede
establecida sin error.

Ej. Coordenadas geograficas de un mismo punto utilizando dos Datums diferentes:

Datum Latitud Longitud

| WGS-84(GPS) 42°19'20.11"N 5°30'19.45"W i
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ED-50 42°19'21.48"N 5°30'09.59"W

Conclusiones a las coordenadas geograficas:

Es un sistema universal y permite la localizacion de los puntos de la superficie terrestre de forma de
absoluta.

En ocasiones resulta incomodo porque:
e«  Se expresa en unidades sexagesimales

< Se apoya en paralelos y meridianos, que son lineas curvas y que no se pueden representar de
forma perfecta en un plano (mapa).

Para resolver estos problemas se crearon los Sistemas de Coordenadas Planas o Proyectadas. Para
utilizarlos, primero hay que representar la superficie terrestre en un plano mediante PROYECCIONES
CARTOGRAFICAS.

2.2. Sistema de coordenadas geograficas o esféricas

La representacion cartografica del globo terrestre, ya sea considerado éste como una esfera o una
elipsoide, supone un problema, ya que no existe modo alguno de representar toda la superficie
desarrollada de deformarla o incluso de llegar a representarla fielmente.

Una proyeccion cartografica es un procedimiento que te permite representar la superficie curva de la
Tierra en una superficie plana. Ninguna representacién plana de la Tierra puede ser completamente
exacta, de modo que se han desarrollado diferentes proyecciones, cada una de elias apropiada para una
finalidad en particular.

Las proyecciones cartograficas difieren en el modo en que se comportan con las siguientes propiedades:
forma, area, distancias y direcciones; es por ello por io que la adecuada seleccion de la proyeccion es
importante.

Tipos de Proyecciones

Las proyecciones geodésicas son utilizadas cuando la superficie que estemos considerando es tan
grande gue tiene influencia la esfericidad terrestre en la representacion cartografica.

A la representacion cartografica obtenida, se e denomina MAPA.
Podemos diferenciar tipos de proyecciones en funcion de la variable gque conserven:

*  Proyecciones conformes: preservan las formas y son utiles para cartas de navegacion y mapas
meteorolégicos. La forma se mantiene para areas pequefias, pero un area grande (continente),
sufrira distorsiones significativas.

»  Proyecciones equivalentes: conservan el area pero no la forma. Suelen ser utilizadas en mapas
tematicos.

e Proyecciones equidistantes: preservan las distancias, pero ninguna proyeccién puede preservar
distancias desde todos los puntos hacia todos los demas; en cambio es posible asegurar la veracidad
de la distancia desde un punto (o conjunto de puntos) a todos los demas puntos, o a lo largo de todos
los meridianos o paralelos.

e Proyecciones acimutales: preservan la direccion desde un punto a todos los demas puntos. Esta
cualidad puede combinarse con las proyecciones equivalentes, conformes y equidistantes.

e Otras proyecciones: existen otras que minimizan la distorsion global pero no preservan ninguna de
las cuatro propiedades espaciales de area, forma, distancia y direccion. Normalmente se utilizan
porque estéticamente son atractivas y utiles para la cartografia general.
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De esta forma, los criterios para la eleccion de una proyeccion seran los siguientes:

3. Que conserve la cualidad mas importante para el fendémeno representado (supone aceptar la
distorsion de todas las demas)

4. Que la zona de interés presenta la menor distorsion posible, es decir, que esté cerca del centro de la
proyeccion y tenga la misma orientacion.

La proyeccion UTM (Universa! Transversal de Mercator)

La proyeccion UTM es una proyeccidn cilindrica en la que el cilindro de proyeccion es transversal
respecto al eje de la tierra y, por lo tanto tangente a la tierra a lo largo de dos meridianos opuestos.

PROYECCION ~ UTM

Para minimizar deformaciones, la tierra se
proyecta en franjas de 6° cada una, denominadas HUSOS (posiciones geogréaficas que ocupan todos los
puntos comprendidos entre dos meridianos) e identificados mediante un namero, del 1 al 60.

En cada Huso se genera un meridianc central equidistante 3° de cada extremo del Huso que se
correspondera con el centro de la proyeccion. Los Husos se generan a partir del meridiano de Greenwich,
0°a6°EyW,B62a122Ey W, ...

Esta situacion del cilindro de proyeccion, tangente al meridiano central del huso proyectado, hace que
unicamente en el centro de la proyeccion la distorsion al proyectar sea nula, creciendo la deformacion
lineal a medida que nos acercamos a los extremos. Para reducir la distorsion, el cilindro se hace secante
a cada una de las franjas de 6° de longitud.

Ademas, para reducir aun mas las distorsiones, el sistema UTM sélo es utilizado entre los 80° N y los 84°
S, ya que produce una distorsion mas acusada cuanto mayor es la distancia al Ecuador.

La proyeccion UTM mantiene las formas, y el resto de propiedades (area, distancia y direccion) las
mantiene con una distorsion baja.

Coordenadas UTM

Las coordenadas de un punto se definen tomando cada Huso como un sistema de coordenadas en el que
el origen, para cada Huso es el punto donde se cruza su meridiano central (centro de proyeccion) con la
linea del Ecuador.

Como en todo sistema cartesiano, primero se indica la X (distancia desde el origen sobre el eje horizontal)
y después la Y (distancia desde el origen sobre el eje vertical). Las coordenadas UTM se expresan en
metros.

Para evitar valores negativos al designar las coordenadas UTM de un punto, el origen de coordenadas
toma valores arbitrarios diferentes al (0,0). En el Hemisferio Norte, la X toma un valor de 500.000 m ylayY
de O m. En el Sur, la X toma el mismo valor que en el Hemisferio Norte, 500.000 my la Y toma el valor de
10.000.000 m.
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HEMISFERIO NORTE

Designacién de coordenadas.

El sistema localiza un punto por coordenadas del tipo:
X = 426.130
Y = 4.634.140,

Pero estas coordenadas en el Sistema UTM no definen un punto (sino 120 puntos, dos en cada Huso), ya
gue no indican los siguientes datos:

» El Hemisferio en el que se encuentran
» ElHuso UTM de proyeccion
e La localizacion del Datum (origen de coordenadas)
Para que el punto quede representado correctamente hay que designarlo de la forma que sigue:
X=426.130
Y =4.634. 140
Hemisferio: N

Datum: European 50 (ED 50)

Ejemplo.
30N (S) 688450 4112300

Datum ED-50

La proyeccion UTM es la proyeccion mas utilizada en Andalucia y en Espafia en general. Andalucia que
da ubicada en dos zonas diferentes, de Sevilla y Jerez hasta Huelva quedaria en el huso 29 y en el resto
de Andalucia en el huso 30; por ello, cuado la informacion ha sido creada a escala provincial o municipal,
la informacion correspondiente a Huelva no puede casar con la del resto de Andalucia, ya que esta en
husos diferentes, pero cuando la informacién se realiza para toda Andalucia (escala regional), se utiliza el
huso 30, por lo que la informacion correspondiente a Huelva sufre mayor distorsion que el resto de
Andalucia, y los datos son menos precisos.
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5. Lareferencia espacial en ArcGis
5.1.Almacenamiento de la informacién de la referencia espacial

Cada formato de datos almacena la informacion de la referencia geografica de forma diferente. La
mayoria de los formatos de datos lo llevan a cabo en un archivo de texto separado asociado al conjunto
de datos:

e En los shapefile y en las coberturas, esto se denomina archivo de proyeccion (con extension
*.prj). Estos ficheros se crean automaticamente con la creacion del dato.

= En los datos CAD se denomina archivo World o de cabecera.

= Enlas imagenes, el archivo que contiene la informacion sobre la referencia espacial es de.*tfw
(para las imagenes .TIF) y *blw (para las imagenes .BIL). Sin embargo, el que contiene la
informacion sobre el sistema de proyeccion tiene extension .*aux

La geodatabase es unica en cuanto a que se puede almacenar la informacién de la referencia espacial
dentro de la propia base de datos, lo que evita la necesidad de un archivo separado.

5.2.Cémo visualizar y modificar la informacién de la referencia espacial
Para visualizar la informacion de |a referencia espacial de un dato;

e Enla pestafa Spatial de los metadatos

Desoription

Murizantal oo

R

D ils

G Soardin

» Enlas Propiedades de la Feature Class: franswers

o En Arc Map: Unicamente se puede
visualizar la referencia espacial del
dato. (Layer Properties > Source).

o EnArcCatalog: se puede visualizar la referencia espacial y modificar. (Layer Properties). En

funcion del tipo de dato se visualizara y modificara la referencia geografica de forma
diferente.

El asistente para definir |la referencia espacial

Mediante este asistente puedes definir la referencia espacial de tres
formas diferentes:

* Select: seleccionando un sistemas de coordenadas y proyecciones
de entre las que ofrece ArcGis.

e Import: importando la referencia espacias desde otra capa que ya
la tiene definida.

e« New: crear un nuevo sistema de coordenadas.
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5.3.Las proyecciones en ArcMap

ArcMap puede trabajar con mas de 60 proyecciones estandar y tiene cientos de archivos de proyeccion
predefinidos para zonas y regiones especificas. Una proyeccién puede ser configurada explicitamente
por el usuario, o bien, ArcMap utilizara la configuracién predeterminada de la primera capa afadida.
Cuando las capas subsiguientes se afiaden al mapa, se proyectaran en la proyeccion del mapa
predeerminada.

Cuando ArcMap realiza una proyeccion en una capa del mapa, no estd cambiando la proyeccion original
de la fuente de datos. Por lo tanto, generalmente no es necesario cambiar la proyeccion de un conjunto
de datos para realizar visualizaciones, consultas o incluso andlisis con un conjunto de datos de diferente
proyeccion. De todos modos, si es necesario un cambio de proyeccion permanente, ArcToolbox contiene
las herramientas necesarias para llevar a cabo esta operacion.

6. La informacién espacial de los archivos con formato raster.

La forma en que se registran las imagenes en el espacio geografico es completamente diferente a como
lo hace la informacion vectorial; la informacién vectorial se almacena en un sistema de coordenadas X,Y
gue simulan el mundo real, con el origen de coordenadas en la esquina inferior izquierda; sin embargo, la
imagenes se almacenan en filas y columnas con el origen de datos en la equina superior izquierda.
Cuando se afiade una imagen a una vista, ArcGis transforma las coordenadas de la imagen en
coordenadas X,Y del mundo real (esquina inferior izquierda, igual que la informacion vectorial); de esta
manera la imagen se registra correctamente en el espacio geografico. La georreferenciacion del
archivo raster, es precisamente este proceso de convertir un archivo raster con coordenadas no reales a
coordenadas reales.

La correccion geométrica

La georreferenciacion espacial de la imagen raster se lleva a cabo a través de la correccion geométrica;
la cual consiste en una serie de funciones gque transforman las coordenadas de la imagen a coordenadas
del mapa.

La correccion geométrica por puntos de control realiza una perfecta georreferenciacion a partir de una
serie de puntos de control conocidos en el espacio real y en la imagen que permiten situar perfectamente
el resto de los pixeles.

La referencia puede ser una imagen del mismo lugar de otra fecha o un mapa.

Fases de la correccion geométrica

¢ |ocalizacion de los puntos de control.
La calidad de la correccion dependera de la correcta seleccion de los puntos de control.
* Interpolacion Espacial

Célculo de las funciones de transformacion que ponen en relacion las coordenadas de la imagen con las
del sistema cartografico de referencia (se calculan por regresion mltiple a partir de las coordenadas de
los puntos de control). Hay transformaciones de 1%, 2° y 3 grado.

¢ Interpolacion radiomeétrica

Transferencia de los valores digitales a la nueva posicion. En primer lugar, se proyectan los cuatro
vértices creando un nuevo grid y después ,mediante diferentes procedimientos se le asigna a cada pixel
un nuevo valor.

En ArcGIS, la correccién geométrica del archivo raster la podemos lleva a cabo con el modulo
GEORREFERENCING.
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7. Georrreferenciacién de archivos CAD

En muchos casos, los archivos CAD no estan georreferenciados, sino que poseen coordenadas de
pantalla o de tableta digitalizadora. ArcGis te da posibilidad transformar las coordenadas del fichero CAD
para que se visualicen en el mismo sistema de coordenadas que el resto de las capas con las que
estemos trabajando.

Como ya hemos indicado, la informacion referente a la referencia espacial, el los archivos CAD, se guarda
en el fichero denominado "world” o de cabecera, por lo que la transformacion de coordenadas se lievara a
cabo a través de éste.

El fichero en formato “world” es un fichero de texto (con extension *.wld) que contiene uno o dos pares de
coordenadas X,Y. El primer par de coordenadas es la ubicacion actual X,Y de cualquier punto de control
conocido del fichero del dibujo. El segundo par de coordenadas X.Y es la nueva ubicacion en el espacio
geografico donde se desea que se encuentre el punto de control del dibujo CAD en la vista de ArcGis.

Ej.
“Neneldibuo CAD - Y en el dibujo C'AD:- -~ wenelespacio geogiafico Y en el espacio geografice -

14.37. 360000 4125000

10.17, 4.75, 308420, 4102028

La transformacién del archivo CAD puede llevarse a cabo de dos formas:

e Transformacion mediante un punto: simplemente desplaza el dibujo CAD a una nueva ubicacion en el
espacio.

» Transformacion mediante dos puntos: utiliza una matriz de transformacion que aplica una distancia
de desplazamiento, escala y rotacion uniformes a todas las coordenadas leidas de la fuente del
dibujo.
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UNIDAD 7. SALIDAS CARTOGRAFICAS

CONTENIDOS

1.

Conceptos basicos de cartografia
Crear mapas en ArcMap
Layout View
El mapa y los objetivos del disefio
Otros elementos
El documento de mapa (*.mxd)
Procedimiento de creacion de salidas cartograficas
Configuracion de la pagina
Afiadir componentes
Herramientas de la Vista Layout
Las Plantillas de mapa
Imprimir mapas

Conceptos basicos de cartografia

Todos los analisis de SIG terminan con algunos resultados que deben ser comunicados. Podemos
ayudar a cumplir el proposito de nuestro mapa ubicando correctamente los elementos del mapa y
seleccionando simbolos y elementos cartograficos adaptados al mensaje que queramos comunicar. El
disefio del mapa depende, por tanto del objetivo del mapa.

1.1. Factores que controlan el disefio cartografico

Varios factores controlan el disefio de un mapa. Estos limitan nuestra creatividad y flexibilidad.

Objetivo del mapa.

Destinatarios. .

Realidad y necesidad de generalizar.
Escala.

Limitaciones técnicas.

Modo de uso.

1.2. Tipos de mapas

Clasificar los mapas es una tarea dificil, sin embargo, generalmente podemos dividirlos en dos categorias:
mapas generales y mapas tematicos.

Mapas generales.Los mapas generales muestran datos de localizacion o posicion. Representan

elementos que utilizan muchas disciplinas. Algunos ejemplos de estos mapas serian los atlas o los mapas
topograficos. Ningun elemento de estos mapas es mas importante que otro.

Mapas tematicos. Existen dos tipos de mapas tematicos: cualitativos y cuantitativos. Ambos muestran la

estructura de distribucion y ,generalmente, ambos representan un unico atributo o relacion.

Mapas tematicos cualitativos: representan datos como diferentes tipos de suelo y diferentes tipos de
elementos con igual importancia en una escala nominal.

Mapas tematicos cuantitativos: muestran, deliberadamente, diferencias en cuanto a caracteristicas
cuantitativas (por ejemplo, mostrar un intervalo o escala de ratio de densidades de poblacion por
Km?, o las variaciones de temperatura o humedad).
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1.3. Elementos del disefio cartografico y percepcién

El ojo humano tiene limitaciones

Los estudios de los investigadores han demostrado que el ojo humano esta limitado en su capacidad de
descifrar diferencias entre colores si se sobrepasa de 12 colores en la misma vista. Ademas, si decidimos
utilizar diferentes sombras del mismo color, necesitamos tener en cuenta que el ojo humano no puede
descifrar mas de siete u ocho sombras diferentes.

Legibilidad de elementos y texto

La legibilidad se define como el simbolo y el fondo en el que esta. Al crear una jerarquia visual
cuantitativa, puede haber variaciones en el tamafio y valor del tono. El contraste visual y la jerarquia se
pueden utilizaren el disefio de un mapa, para conseguir que el usuario se fije primero en las dreas mas
importantes y después en las que sean menos relevantes.

Balance visual

Al empezar a distribuir la simbologia en nuestro mapa, el tratamiento diferente de las caracteristicas
graficas puede variar el peso visual de los simbolos. Tenemos que conseguir un balance visual que
resalte el proposito del mapa.

2.Crear mapas en ArcMap
2.1. Layout View

Creamos nuestro mapa en la Vista Layout (en el ment View > Layout View). Nuestra composicién puede
contener uno o0 mas mapas. Cada mapa requiere afiadir un Data Frame a nuestro documento.

Cuando un mapa tiene mas de un data frame, uno de elios sera el activo y es con el que estamos
trabajando. Este data frame activo aparece resaltado en la Vista Layout.

2.2. Otros elementos

Ademas de los data frame, podemos afadir otros elementos en el mapa como son el Norte, la barra de
escala, el titulo, otra informacion textual....Estos elementos se afiaden a la pagina virtual.

2.3. El documento de mapa (*.mxd)

Al finalizar nuestro disefio, podemos guardar el documento mapa como archivo .mxd. Este archivo
almacenara la ruta a los datos que se han utilizado para crear el mapa y las propiedades de visualizacion
de cada capa.

3. Procedimiento de creacion de salidas cartograficas

3.1. Configuracién de la pagina

Al disefiar mapas, el primer paso seria la configuracion de la pagina a través la cual se estableceran las
unidades de medida grafica, el tamafio y forma de la hoja de impresién, margenes de impresion y calidad
de resolucion...

Para configurar la pagina: en el menu File > Page and Print Setup.

3.2, Afiadir componentes

Procedimiento general para afiadir componentes
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Todos los componentes se insertan en la vista de presentacién o composicién
de la misma forma:

1. Hacer Clic en el ment general Insert.

2. Seleccionar el tipo de elemento del mapa (tras configurar las propiedades
del elemento, éste se inserta de forma predeterminada en el centro del gz uy
mapa). P M

3. Arrastrar el elemento a una mejor posicion en el balance visual.

4. Hacer doble Clic en el elemento para cambiar sus caracteristicas, si se
desea.

La leyenda
Para insertar la leyenda: menu Insert > Legend
e Asistente de leyenda. Te permite:

o Afadir los elementos que quieres que aparezcan en la leyenda y
seleccionar el numero de columnas que va a tener.

o]

Establecer el titulo de la leyenda.

o Establecer las propiedades de la fuente de letra.

o [Establecer color de fondo, bordes...

e Cuadro de propiedades de la leyenda (Clic con el boton derecho del raton
sobre la leyenda > Properties).

La pestaria Legend permite:

e Cambiar el titulo de la leyenda. La casilla de verificacion Show, controla si el titulo aparecera o no. El
titulo se puede situar en la parte superior o inferior de ia leyenda.

Cambiar las propiedades del titulo (color, fuente, tamafio) mediante el boton Symbol.

En el cuadro Patch se pueden cambiar las propiedades de los simbolos.

Los espacios predeterminados entre los componentes individuales de la leyenda ya vienen
configurados pero se pueden modificar perfectamente.

La pestafia Items se utiliza para especificar qué objetos queremos que aparezcan en la leyenda. De forma
predeterminada apareceran los objetos de todas las capas del mapa.

También permite especificar como queremos que la leyenda esté conectada al mapa:
e Mostrar solo los objetos de la leyenda que tienen datos visibles en el mapa.
¢  Afadir un nuevo objeto a la leyenda cuando se afiada una nueva capa al mapa.
¢« Reordenar los objetos de la leyenda cuando se reordenen las capas.

Map Connection
" Only display layers that are checked on in the T able Of Contents
v Add a new item to the legend when a new laver is added to the map

v Reaorder the legend items when the map layers are recrdered

La pestaria Frame permite afiadir colores de fondo, modificar los bordes...

La pestafia Size and Position permite ajustar el tamarfio de la leyenda y su posicion en el mapa.
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Norte

Para insertar la flecha apuntando al Norte: /nsert > North Arrow. Aparece un
: selector que permite escoger entre una amplia variedad de “Nortes”. Después de
seleccionar uno de ellos, en el cuadro Properties puedes cambiar sus propiedades
(como orientacién, tamafio, color...)

Escala
ArcMap ofrece la posibilidad de insertar tres tipos de escalas:
e Una barra de escala grafica (en el menu Insert > Scale Bar).

Util para los mapas que van a ser reducidos en el proceso de impresion. Tanto el cuerpo del mapa como
la barra de escala cambian de tamafo simultaneamente para garantizar que la barra de escala sea
correcta. Una barra de escala permite el uso de escalas que no tengan que ser multiplos de 100 (por
ejemplo, 1:3.475.923), que es el resultado del intento automatico del software de amoldar la extension de
los datos del mapa dentro de la vista Layout.

0 4 @ 160 240 <)
I N W i

El Selector de barra de escala ofrece una amplia variedad de escalas. Después de seleccionar una
escala, se pueden cambiar sus propiedades, como el tipo, el tamafio de cada intervalo, el niumero de
intervalos, las unidades, el color de las lineas y etiquetas, o la fuente de las etiquetas.

¢ Una barra de escala fraccional (en el menu Insert > Scale Texf)..

Se utiliza normalmente para mapas que fueran a ser editados en una escala especifica de multiplos de
100 (por ejemplo, 1:250.000). Una vez se haya afiadido las escala al mapa, ya que la escala fraccionas es
simplemente texto, al cambiar el tamafo del mapa, ese texto se hara mas grande o mas pequefio.

Sistema de Referencia

ArcMap ofrece la posibilidad de afiadir un sistema de referencia a nuestro mapa mediante una reticula
grid que te permiten localizar un elemento en el espacio.

Para afiadir el sistema de referencia: en las Propiedades del Data Frame > pestafia Grid > New Grid.

e

El asistente de Grid te da la opcion de elegir entre varios sistemas de referencia:
e  Graticule: divide el mapa en meridianos y paralelos (coordenadas geograficas)

« Measured Grid: divide el mapa en cuadriculas basadas en las unidades del mapa (coordenadas dl
sistema de proyeccién)

« Referenced Grid: divide el mapa en cuadriculas.

Graticule Measure Grid Referenced Grid
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ArcMap viene con un conjunto de plantillas estandar que podemos utilizar para la creacion de mapas.
También podemos modificar los mapas y las plantillas o crear nuestras propias plantillas para cubrir
nuestras necesidades.

6. Imprimir mapas
Para imprimir mapas hay que llevar a cabo los siguientes pasos:
1.  En el menu File, hacer Clic en Print.

2. Aparece la ventana Print, en la que seleccionaremos la impresora disponible y el motor de
impresion.

3. En la ventana Propiedades de la impresora, seleccionamos el tamafo de pagina y la fuente, el
numero de copias y la apariencia de color.
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EJERCICIO 1 .VISUALIZACION DE DATOS

Paso 1: Copiar los datos desde el CD a nuestro ordenador

Paso 2: Iniciar ArcCatalog y analizar los datos geograficos de los que disponemos
Iniciar ArcCatalog .

e Haz Clic en Inicio > Programas > ArcGis > ArcCatalog.

¢ Enla Tabla de Contenidos de ArcCatalog ve a C:/practica 1

Haz Clic sobre la carpeta Datos Ejercicios SIG para ver los datos que contiene. #ArcCatalog denomina a las
capas feature class, es por ello por lo que cuando trabajemos en este mddulo ufilizaremos este nombre para
referirnos a ellas//

// En la ventana de Contenidos de la derecha, bajo el titulo Type, puedes comprobar de qué fipo son las
feature class. En la siguiente unidad detallaremos las caracteristicas de cada tipo de dafo.//

]

2

Pregunta 1: ; Cuantos datos tipo raster y tipo véctorial contiene la carpeta Datos Ejercicios SIG?

Paso 3: Iniciar ArcMap. Definir las unidades del mapa

Ahora, abre ArcMap. Organiza las ventanas de manera que puedas verlas al mismo tiempo Arc Map y Arc
Catalog.

e Haga Clic lnicio > Programas > ArcGis > ArcMap.
« Confirma la seleccion de un Mapa Nuevo: A new empty map > Aceptar

La interfaz de ArcMap aparece en pantalla con un documento mapa sin nembre y un Data Frame
Predeterminado denominadc Layers.

A continuacion, definiremos las unidades del mapa

e Observa la barra de estado en la parte inferior derecha de la interfaz de ArcMap. Las unidades del mapa
sin desconocidas (Unknown).

¢ Haz Clic con el boton derecho del ratén sobre el data frame Layers > Properties. En la pestana General,
indica que las unidades del mapa y las unidades de visualizacién son metros.
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Units
Map: Meters "'
Display:  Meters o .

¢ Observa la barra de estado y comprueba que aparecen los metros como unidades.

Paso 4. Afadir una capa de informacion raster

A continuacién, afiadiremos capas de datos espaciales al mapa. Se pueden afadir capas para muchos
formatos de datos incluyendo, coberturas Arcinfo, archivos Shape de ArcView GIS y algunos formatos raster
(Ej. imagenes y grids de Arcinfo).

Con ArcCatalog podemos explorar diferentes fuentes de datos y con ArcMap podemos mostrarlas, editarlas y
analizarlas. Se pueden arrastrar datos de ArcCatalog a ArcMap. Esto es lc que haremos a continuacion.

= En ArcCatalog, busca la carpeta practica 1. Haga Clic sobre la imagen h92022.tif y arrastrala desde
ArcCatalog hasta el area de visualizacion de ArcMap. (Quizas necesites organizar las ventanas para ver
ambas aplicaciones a la vez).

e Minimiza la aplicacion ArcCatalog y asegurate de que ArcMap esta abierto.

En el area de visualizacién de ArcMap podemos ver la imagen raster que acabamos de cargar. Para poder
visualizarla con mas detalle utilizamos las herramientas de visualizacion.

OROS-HEMRLE" |

¢ Hacemos Clic scbre la herramienta Zoom In @ y dibujamos un rectangulo alrededor del area gue
queramos inspeccionar. En este caso sobre el nlcleo de poblacion de Cazalla de la Sierra.

» Volvemos a visualizar la capa al completo. Para elio hacemos Clic con el botén derecho del raton sobre fa
capa en la tabla de contenidos > Zoom To Layer.

Paso 5: Afadir una capa de informacion vectorial poligonal

Ahora, afiadiremos al mapa una capa con formato Shape. Utilizaremos una metodologia diferente a la del
paso anterior para realizar esta operacion.

¢ Enla Barra de herramientas de ArcMap, haz Clic sobre el boton de Add Data

s En el cuadro de didlogo Add Data, navega por el directorio hasta practica 1. Haz Clic en el archivo
Shape nucleos de poblacion(pol).shp. > Afiadir.

El archivo Shape se anade en el indice como una capa y se muestra en la parte superior derecha del area de
visualizacion.

/INOTA. ArcMap anade automaticamente la imagen raster al final del indice para que no impida la
visualizacion de otras capas.//

Paso 6: Modificamos las opciones de visualizacién

Observamos que la capa nlcleos de poblacién cubre totalmente la imagen raster en aguellas zonas que
coinciden. Cambiaremos la propiedad de transparencia de la capa nicleos de poblacién(pol).shp para
visualizar los detalles de la imagen raster.
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*  Clic con el botén derecho del ratén sobre la capa nicleos de poblacién(pol).shp > Properties.
* Enel cuadro de didglogo Properties, Clic en la pestafia Display {visualizacion).

= Eneltanto por ciento de transparencia, escribe 50. Haz Clic en Aplicar.

Sin cerrar la ventana de Properties, observa que capa se visualiza con una sombra fransparente.

Ahora, anadiremos una linea de contorno roja a los nucleos de poblacion y cambiaremos la sombra a un color
azul

e En el cuadro de dialogo Properties hacemos Clic en Ia ventana Symbology.

* En Symbol, haz Clic en el botén Symbol que aparece resaltade para abrir el Selector de Simbolos.

© [raw all features using the tame symbol Hapos

Bl g
{ategones
Huantias
Charty
‘Multiple Atliibutes

Surrbend

» En el Selector de simbolos, en la opcion Fill Color (color de relleno), haz Clic en el boton Simbolo que
aparece resaltado. Elige el color azul en la paleta de colores

* En las Opciones Outline Width (ancho de contorno), haz Clic en la flecha hacia arriba para seleccionar 2.

* Enlas Opciones de Outline Color, haz Clic en el botén Simbolo que aparece resaltado.

.+ Enlapaleta de colores, seleccionar el color rojo. Observa los cambios en el area de Preview del Selector
de simbolos.

*  Haz Clic en Aceptar para cerrar el Selector de simbolos y la ventana de Propiedades.

La capa nucleos de poblacion.shp aparece con un relleno transparente de color azul y un contorno rojo.

Paso 7: Anadir una capa de informacién vectorial puntual
Ahora, afiadiremos elementos de un archive Shape de tipo puntual, usando un tercer método:

» En el indice, haz Clic con el botén derecho del raton en el Data Frame donde quieras incorporar la capa;
luego, haz Clic en el boton Add Data.

*  Utiliza el cuadro de didlogo Add Data para afiadir el archivo shape C:\Practica 1\ \cotas.shp.
Probablemente el simbolo para las cotas no sea apropiado. Sigue los siguientes pasos para cambiarlo:
¢« Enla Tabla de Contenidos, haz doble Clic sobre el simbolo de cotas.

e En el Selector de simbolos selecciona el simbolo denominado Triangle 3.

* Enlas Opciones Color selecciona un color apropiado en la paleta de colores.

Tu mapa deberia verse asi:
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Paso 8: Nombrar elementos

Un mapa esta incompleto si los elementos no tienen etiquetas con sus nombres. Ahora, pondremos a cada
cota su valor.

e En el cuadro de dialogo Properties de la capa Cotas, haz Clic en |la pestafia Labels (etiquetas).
« Marca la casilla de seleccion Label features in this Layer ('nombrar elementos de esta capa")

« En el cuadro Text String, en el Label Field ("campo de etiquetas"), haz clic o confirma que el campo
seleccionado es ID (si observas |a tabla de atributos de la capa cotas.shp, veras que es el campo que
contiene el valor de las cotas).

= Enel cuadro Text Symbol, haz Clic en el boton Symbol...

s Enlas Opciones Color, selecciona la casilla coloreada (el negro es el color predeterminado) y selecciona
un color verde brillante para el texto.

o En Tamano, escribe 10
¢« Haga Clic en el botén B parra cambiar la fuente a negrita
(Observa gue las caracteristicas del texto seleccionado se muestran en Preview.)

e Haga Clic en Aceptar para cerrar el Selector de Simbolos. En el Cuadro de Propiedades, haz Clic en
Aplicar y después en Aceptar.

Ahora, para poder visualizar las etiquetas:

» Haz Clic con el boton derecho raton sobre la capa cotas.shp y selecciona la opcion Label Features

Paso 9: Crear un archivo de capa de informacién (con extension.lyr)

Las capas indican las propiedades de datos y almacenamiento segln se visualicen datos. Puedes utilizar tus
archivos de capas para compartir tu visualizacion de datos con otros. Por ejemplo, para que tus companeros
de clase no tengan que repetir los mismos procedimientos de simbolizar datos y etiquetas, puedes enviarles
por e-mail tu archivo.lyr. Si tus compafieros tienen acceso a los mismas datos, la capa aparecera con tus
especificaciones.

En este paso vamos a crear un archivo de capa que contenga los simbolos CREADOS para la capa Cotas.
Para elio:

¢« Haz Clic con el boton derecho del ratén sobre la capa que quieras guardar, en este caso, la capa
Cotas.shp. Selecciona Save a Layer File.
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e Guarda el archivo cotas.lyr en el lugar que quieras.

Paso 10 : Anadir un nuevo Data Frame e introducir un archivo de capa de informacion

Puedes afiadir mas data frame al documento mapa. A lo mejor quieres un data frame para visualizar un mapa
general de tu area de estudio o para visualizar tus datos utilizando diferentes simbolos o clasificaciones.

En el siguiente paso vamos a afadir un nueve data frame al que le daremos un nombre 2propiado.

e Enla Vista de Datos, Haz Clic en el Meru /insert > selecciona Data Frame

Este nuevo data frame se convierte automaticamente en el data frame activo de la panialla.

e Haz Clicen el botén Add Data y arfiade el archivo Cotas.lyr que has creado en el paso anterior.
Observa que siguen activas todas las propiedades de visualizacidon que has configurado previamente.

s Eliminar la capa cotas.lyr. Para ello, haz Clic con el botén derecho del ratén sobre cotas.lyr y selecciona
Remove.

Observa que la capa cotas.lyr a desaparecido de la Tabla de Contenidos y, por lo tanto de la Vista de Datos

¢ Enla Tabla de Contenidos, haz clic con el botén derecho del ratén sobre el nuevo data frame y haz Clic
en Properties.

e En la pestafia General, cambia el nombre por "Sevilla".

e En esta misma pestafia indica que las unidades del mapa (map) vy las unidades de visualizacion del
mapa (display) son metros.

e  Aceptar

En la Tabla de Contenidos, podemos ver que el data frame que acabamos de afadir toma el nombre que le
hemos dado en las propiedades.

Paso 11: Clasificar y Simbolizar datos espaciales

« Haz Clic sobre el botén Add data y navega por el cuadro de didlogo para afiadir el archivo C:/Practica 1
\limites municipales.shp

La capa limites municipales aparece en un Unico color de forma predeterminada. A continuacion,
cambiaremos la visualizacion de la capa limites municipales para reflejar las clases basadas en la cantidad
de poblacién de los municipios.

¢« [nla Tabla de Contenidos, haz Clic con el botdn derecho del raton en la capa limites municipales y haz
Clic en Properties > Simbology.

e En el cuadro Show, haz Clic en Quantities {cantidades)

Observa que la opcién Graduate Colors esta resaltada como  [7*

iCategonies

valor predeterminado jDlusnlites

e En el cuadro Fiels (campos), haz Clic en la caja Value y
selecciona el campo POBLAS6. {lbierts

Multipie Attributes

e En la Rampa de colores, haz Clic en le escala de
amarillo a marron oscuro.

De forma predeterminada apareceran cinco clases que han
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sido calculadas con el Método de Clasificacion Natural de Jenks (Jenks' Nafural Breaks Method), lo que
podras comprobar si miras en la parte superior del botdn Classify.

« Haz Clic en Aplicar.

¢ Desplaza el cuadro de didlogo Properties a un lado de la pantalla para ver el cambio en el mapa.

Los municipios se muestran ahora divididos en cinco clases basadas en sus poblaciones. Todas las clases
aparecen en el indice de la Tabla de contenidos y estén resaltadas con un color diferente. De esta forma
puedes comprobar que ios municipios de mayor poblacién son resaltados con colores mas oscuros y los de
menor poblacion con los colores mas claros.

Puedes cambiar el esquema de clasificacion de datos cuande quieras. Ahora vamos a cambiar el nimero de
clases a cuatro, el método de clasificacion a Manual y definiremos las clases.

e En la pestafia Simbology de las propiedades de la capa aparece un cuadro denominado Clasificacion,
cambia el nimero de clases a 4.

s Haz Clic en el botdn Classify.
e En el Método de Clasificacion, selecciona la opcién Manual en el menu desplegable.

= En Break Value (valores de clasificacion), situados en la parte izquierda del cuadro de dialogo, haz clic en
el primer valor. Cambialo escribiendo el nuevo valor de 15.000 y pulsa Intro en el teclado.

¢ Cambia el segundo valor de clasificacion a 50.000 v el tercero a 200.000. Observa como se actualiza la
barra del histograma.

¢ Haz Clic en Aceptar para cerrar el cuadro de diglogo de Clasificacion y el menl Propiedades de la capa.

Seria posible que quisiéramos visualizar cada municipio de la provincia de Sevilla con un color diferente. Esto
se realiza mediante la opcién Unique Value.

e Vuelve a la pestafia Simbology de las propiedades de la capa.
« En el cuadro Show, selecciona la opcidn Categorias y haz Clic en Unique Value.
¢ En el cuadro Value Field, selecciona el campo MUNICIPIO

s« Haz Clic en el botdn Add All Values (afadir todos los valores)
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Observa gue se han afadido en la pantalla todos los valores correspondientes al capo MUNICIPIO y se les ha
asignado a cada uno de ellos un color diferente

. Haz Clic en Aceptar

En la Vista de Datos vemos que, ahora, cada municipio toma un color diferente. En la Tabla de contenidos
aparecen también todos los municipios con el color que se les ha asignado.

Paso 12.Generar un mapa de impresién utilizando Layout View (Vista de Composicion de mapas)

En los pasos anteriores hemos trabajado con el Data View (Vista de datos) de ArcMap. en este paso,
crearemos un mapa de impresién con la Vista Layout. Esta nos ayuda a organizar los elementos del mapa en
la pagina,, de tal forma, que es como si fuese un papel virtual. El mapa impreso se vera exactamente igual
que la Vista de composicion de mapa.

Ahora ve a la Vista Layout
. Haz Clic ene | menu View > Layout View.

Observa que en la vista Layout aparecen los dos mapas gue has creado, el de Cazalla de la Sierra y el de la
Provincia de Sevilla.

La Vista Layout aparece de forma predeterminada con orientacién vertical. En este ejercicio gueremos un
mapa con orientacion horizontal.

. Haz Clic en el menu File > Page and Print Setup (formato de pagina)
© En el cuadro Page (pagina), haz Clic en orientacién Landscape (horizontal)
. Haz Clic en Aceptar para cerrar la ventana de Formato de Pagina.

El mapa se reducira para ajustarse a la aplicacion de ArcMap. Observa el porcentaje de reduccion que
aparece en la barra de herramientas Layout que estd aparte. En este ejemplo es de un 37% pero el tuyo
puede ser diferente. Esta barra de herramientas parece cuando cambiamos de Data View a Layout View.

EE® DEDE @ 7% -

—_—
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Paso 13: Configurar la escala del mapa

Los mapas pueden estar a gran escala 0 a pequefia escala. Por ejemplo, un mapa con escala 1:10.000 es un
mapa de mayor escala que uno de escala 1:100.000. Los mapas se pueden visualizar a cualquier escala,
establecida para un objetivo y un publico especifico por el disefiador del mapa.

¢ Haz Clic sobre el mapa de Cazalla de |a Sierra y observa en la Tabla de Contenidos que es éeste data
frame el que aparece activo

» Elimina el data frame Sevilla, ya que en nuestra composicidn de mapa solo queremos que aparezca
Cazalla de la Sierra. Clic con el boton derecho del ratdn sobre el data frame Sevilla > Remove.

La escala actual para este mapa aparece en la barra de herramientas que esta situada en la parte central
superior de la ventana de ArcMap.

Pregunta 3: ;Cuadl es la escala ctual para el mapa de Cazalla de Ia Sierra?

Esta escala puede que no sea apropiada para tu mapa (porque sea muy pequefia 0 muy grande). A
continuacion, cambiaremos la escala del mapa.

. Escribe 15.000 en la casilla de escala y luego pulsa Intro

Si es necesario, utiliza la herramienta Pan (visualizacién panoramica) para ajustar la posicion del area del
mapa asi obtener un mejor balance visual dentro de la composicion del mapa.

Observa gue la barra de herramientas del Layout View tiene opciones de pan y zoom para su utilizacion en la
composicion de la pagina.

EEE BB0OE @ B

. Practica con los diversos botones de zoom que aparecen en esta barra de herramientas del Layout
View

Mientras, observa que:
. El porcentaje de reduccion cambia con cada intento de zoom
. La escala 1:15.000 no cambia

Esto significa que tus intentos de zoom estan ayudandote a ver el mapa a diferentes ratios de reduccion o
expansion en la pantalla, aungue el mapa final se imprima a escala 1:15.000.

Hasta aqui, soélo has movide tus Data Frame desde la Data View a la Layout View. En un gjercicio proximo,
aprenderemos a afiadir otros elementes de mapas.

Paso 14: Guardar Documento Mapa

. Haz Clic en File > Save as

e Navega por el directorio hasta la ubicacién que le quieras dar
e En nombre del archive escribe Ejerciciol

® En Guardar como tipo, acepta Documento de ArcMap (*.mxd)
. Haz Clic en Guardar.

FIN DEL EJERCICIO
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EJERCICIO 2A. EXAMINAR FORMATOS ESPACIALES

El objetivo de este ejercicio es examinar los diferentes tipos de datos con los que puedes trabajar en ArcGis.
Utilizaremos ArcCatalog para examinar, visualizar y organizar los datos.

Paso 1: Copiar los datos en el ordenador

e Copia la carpeta Practica 2 del CD (ubicada en D;\DatosCEAQ7\DatosPracticas\Practica?) y pégalos en la
unidad C: \ de tu ordenador.

Paso 2: Iniciar ArcCatalog y crear una conexion nueva a una carpeta
e Inicia ArcCatalog.: Inicio> Todos los programas> ArcGis>ArcCatalog.

Cuando ArcCatalog se abra, veras la Tabla de contenidos en la parte izquierda de la ventana. Esta contiene el
istado de las conexiones disponibles.

Observa que ArcCatalog puede que no tenga una conexidn directa a
los datos del curso. La conexion predeterminada es generalmente la
unidad C (C:\). Aungue esta conexion es suficiente para lograr los
propositos del gjercicio, puedes incorporar una conexion mas directa a
los datos geograficos utilizados en este ejercicio para mayor comodidad
a la hora de buscarlos.

Puedes simplificar el proceso de busqueda con solo afiadir una
conexion directa a la carpeta con los datos.

e Haz Clic en el botdn Connet To Folder , selecciona la carpeta C:\Practica 2 y haz Clic en Aceptar.
Observa que la ruta de la carpeta de datos del ejercicio se afiade como una conexion adicional.

Paso 2: Trabajar con la vista de contenidos

Con ArcCatalog podras visualizar tus datos de tres formas diferentes. Los tras métodos de visualizacion con
ArcCatalog son: Contenidos, Vista Previa y Metadatos. Podras ir cambiando la opcion haciendo Clic en las
pestafnas situadas en la parte superior de la pantalla.

Contents Preview  Metadata |

La Vista de contenidos muestra los objetos de la carpeta o de la conexion que has seleccionado en el indice.
Hay cuatro tipo de Vistas de contenidos: Large Icons (iconos grandes), List (lista), Details (detalles) o
Thumbnails (miniaturas). Podras ir cambiandolas haciendo Clic en los botones de la Barra de herramientas
estandar.

List ] g
Large Icons Details Thumnails
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Utilizaremos la vista predeterminada, Details, para examinar los iconos que representan cada tio de datos en
ArcCatalog.

e Utiliza el acceso directo para acceder a la carpeta de datos de la practica 2 y mira su contenidos en la
ventana Contenidos.

La carpeta Practica 2 contiene datos con varios formatos (coberturas, archivos Shapefile, CAD, raster,
geodatabase). Cada formato se representa con un icono y aparece en la columna Tipo. como puedes
cbservar hay tres clases de elementos shape que se muestran con diferentes iconos.

Contents * Preview = Mstadala

Shapes { ;

Mo Llvee
red de carreteras.shp Shapefile
nuciens de poblacion.shp Shapefile

nucleo_pal.shp Shapefile
mde_100_sw Raster Dataset
imagen_sevila.bil Raster Dataset
f98433.tF Raster Dataset
1050-2-%.5id Raster Dataset
1050-2-3.5id Raster Dataset
EEUU.mdb Parsanal Geodatabase

dBASE Table
dBASE Table
: *_hamuru Coverage
“Erairoad. dxf CAD Feature Dataset
¥ rairoad.dxf CAD Drawing

El icono del archivo Shape red de carreteras te indica que el archivo shape contiene elementos tipo punto, el
icono del archivo nlcleos de carreteras indica que contiene elementos lineales y el icono de nucleo_pal que

son de tipo punto. .

rd

Pregunta 1: ; Cuantas coberturas hay?

Pregunta 2: ; Cuantos archivos tipo Shapefile hay?

Pregunta 3: ; Cuantas fuentes de datos CAD hay? .....

Pregunta 4: ; Cuantos raster hay? ...

Puede que te resulte Gtil hacer que las extensiones de los archivos sean visibles en ArcCatailog.
« Haz Clic en el menu general Tools >Opfions.

« En la pestafia General, elimina la seleccién de la casilla Hide file extension (ocultar extensiones de
archivos) > Haz Clic en Aceptar. Observa que ahora las extensiones de los archivos aparecen en los
nombres de archivo.

B Menit oeneral

Ahora intenta ver los contenidos con otro tipo de vista: Large icons, List o Thumbnails
¢« Haz Clic en cualguiera de los cuatro botones
e« Haz Clic en el botan thumbnail.

Los thumbnails son consultas instantaneas de datos en miniatura. Por ahora, sélo la imagen Sevilia tiene un
thumbnail. En cuanto al resto de los datos, verés ios iconos predeterminados para cada tipo de dato. No
puedes cambiar el tamafio del thumbnail y la vista esté configurada automaticamente para mostrar tantos
thumbnails como sea posible dentro de la ventana Contenidos. Mas adelante crearemos un thumbnail.

Paso 3: Trabajar con la pestafa Preview y examinar un archivo Shape

La pestafia Preview mostrara los datos geogréficos que has seleccionado en la tabla de contenidos. Puedes
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ver la informacion geogréafica o la tabla de atributos de una clase de elementos. Esta informacion sera datos
reales, siempre correctos y actuales (al contrario que los thumbnails en la pestafia de Contenidos).

A continuacion, examinaremos el archivo Shape red de
carreteras.

» Busca el archivo red de carreteras en |a carpeta Practica 2y
haz Clic en él.

¢ Haz Clic en la pestafia Preview.

Apareceran la lineas del archivo Shape red de carreteras. Los archivos shape solo pueden tener un tipo de
elementos. En la vista de geografia podras utilizar opciones de la barra de herramientas como zoom y pan
para personalizar la vista. el botdén de la esquina derecha de la barra de herramientas sirve para crear e
insertar una imagen thumbnail en una capa de datos.

P T peate thumdmad
Zoomim Py .
; Idennf

A v %
Zoom st Fan Full extend

*  Practica con las herramientas zoom y pan en el archivo Shape red de carreteras

e Cambia Preview a Tabla y observa los atributos de la red de carreteras

g

¢ Cambia de nuevo a la vista de geografia

e Haz Clic en ArcMap ‘a ' cuando aparezca la pantalla de inicio, selecciona A new empty map.

= Cambia el tamafo de las aplicaciones de ArcMap y ArcCatalog para poder ver ambas aplicaciones al
mismo tiempo.

= En ArcCatalog, haz Clic en el icono del archivo Shape Red de carreteras y arrastralo hasta el area de
visualizacion de ArcMap.

Observa que el archivo Shape red de carreteras se afiade a la pantalla y a la tabla de contenidos. Se le asigna
un color de linea al azar que podras cambiar haciendo Clic con el botén derecho del ratén en el simbolo de la
linea.
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2

CLIC Y ARRASTTRAR

//Nota: si tus datos carecen de informacion espacial aparecera un mensaje de advertencia diciéndote que la
capa no puede ser proyectada. Esto es 16gico ya que necesitas saber el sistema de coordenadas inicial antes
de poder proyectar a un nuevo espacio de coordenadas.//

Paso 4: Examinar una cobertura

En este paso examinaremos la cobertura MUNI y veremos que a diferencia que los archivos Shape, las
coberturas pueden contener multiples clases de elementos.

s Enelindice de ArcCatalog, haz Clic en la cobertura MUNI de la carpeta Practica 2.

e Haz Clic en la feature class tipo poligono y visualizala en Preview.

L S

s OE Y A e

e

e Visualiza la tabla de atributos de poligonos MUNI y luege responde a la pregunta gue se te plantea.

Pregunta 5: ;Qué identificador de poligono (FID) ocupa el area mas grande? Sugerencia: Haz Clic con
el botén derecho del ratén en Ia columna que contiene el nombre del area y ordena el campo Area en

orden descendente. i

Paso 5. Examinar Metadatos

Para decidir si una fuente de datos es apropiada o no para utilizaria en tu mapa, probablemente necesites
mas informacion que sus propiedades basicas y ver sus elementos. Necesitaras informacion acerca de la
exactitud de los datos o de como se ha hecho una configuracion de medidas. Los metadatos de un elemento
incluyen este tipo de informacién al igual que las propiedades derivadas automaticamente de los datos.
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La pestarfia Metadatos contiene esta informacion en un formato facil de leer.

e Haz Clic en cobertura MUNI en |a Tabla de contenidos y selecciona la pestafia Metadatos.

munt

Arcinto Covere

Description Attributes

o Horizontal coordinate system

Los metadatos se muestran con el disefio de pagina predeterminada de ESRI. Esta pagina tiene pestafas de
clasificacion de los metadatos segun la informacion descriptiva, espacial y de atributos.

* Enla pestafia Spatial, selecciona Spatial data description (descripcién de datos espaciales).
Pregunta 6: ; Cuantos poligonos hay en la cobertura MUNI?. ool bentiosibeseseeesessseeeesemeeseesseseens

Al igual que con los archivos Shape, las coberturas se pueden examinar en ArcCatalog y visualizar en
ArcMap.

Paso 6. Examinar una Geodatabase

La Geodatabase es otro tipo de formato disponible para los usuarios de ArcGis. En este pasc, lo primero sera
buscar la geodatabase en el directorio de datos del ejercicio.

Actualmente hay varios datasets de elementos, come son,por ejemplo, HIDROLOGIA Y TOPONIMIA. Un
Dataset de elementos de la geodatabase contiene una coleccion de Feature class que comparten relaciones
espaciales.

» Haz Clic en el signo + situado al lado de cada Dataset para ampliarlos

Pregunta 7 ;Cuantos Datasets y Feature classes contiene la geodatabase Sevilla.mdb?

Una feature class es una coleccién de elementos con el mismo tipo de geometria. Los tipos de geometria
disponibles en la geodatabase son puntos, multipuntos, polilineas (arcos) y poligonos. El icono utilizado para
cada clase de elementos indica el tipo de geometria de los elementos.

//Nota: un elemento tipo multipunto es un conjunto logico de puntos. Por ejemplo, si Indonesia tiene varias
islas, en vez de asignarles puntos individualmente a cada isla, las puedes agrupar en un Unico objeto
multipunto.//

e Haz Clic con el boton derecho del ratén en |a feature class red_hidrografica > Propiedades.
Y
Seg ot
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ed_hidrografica
Personal Geodatabase Featue Class

. |

T o b e el o e st st e B e B o B £ e

s Haz Clic en la pestafia Fields (campos). Observa que se muestra un cuadro en el que aparecen los
nombres de todos los campos que forman la tabla de atributos de la feature class.

e Haz Clic en cada uno de los campos y comprueba en el cuadro que aparece en la parte inferior (Field
Properties) la informacion que muestran cada uno de elios.

Pregunta 8: ;Qué campo guarda los datos de las coordenadas espaciales de la feature class?

X

e En File name (nombre de archivo) haz Clic en el campo Shape.

Pregunta 9 ¢Cual es el tipo de geometria para la clase de elementos red_hidrografica?

e Haz Clic en Cancefar para cerrar el menu Propiedadss.

e Haz Clic con el botén dereche del ratén en el dataset de elementos TOPONIMIA y haz Clic en
Propiedades.

Pregunta 10: Observa la informacion espacial de referencia ¢Cual es el sistema de coordenadas
proyectado para este datasets de elementos?

s T T T T T T PR LT

//Nota. Todas las feature class de un Datasets comparten el mismo sistema de coordenadas y sus elementos
deberan estar dentro de un area geomeétrica comun {dominio).//

Haz Clic en Cancelar para cerrar el menu Propiedades.

Paso 7. Examinar una fuente de datos CAD (Disefio asistido por ordenador) y crear un archivo Shape a
partir de ésta.

destdido e featires

Las fuentes de datos CAD se pueden ver como una Unica unidad
o por capas. Tienen dos entradas en el catélogo: primero, el
dibujo CAD que representa todas las capas combinadas y
segundo, la entrada conjunto que se pueden ampliar para ver las
feature class tipo punto, linea, polilinea, poligono o anotaciones
en las capas.
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//Nota: las polilineas son cualquier linea de tres o mas puntos. En algunos casos, ArcGis llama polilineas a
elementos tipo linea de las feature class, como limites, carreteras, riachuelos y calles cuando interpreta el
archivo CAD sin convertir.//

Realiza los siguientes pasos para examinar las fuentes de datos CAD.

* En el indice de ArcCatalog, busca el archivo Sevilla_centro.dwg (en la carpeta practica 2) que esta
dividido en feature classes

Ahora, visualiza las Feature classes.
* Haz Clic en el signo + situado al lado de la entrada Sevilla_centro.dwg que contiene las feature class.
* Haz Clic en Polilinea y observa que en la pestafa Preview aparecen las lineas.

Las fuentes de datos CAD se pueden visualizar también en ArcMap, sin embargo no se pueden modificar ni
realizar operaciones de andlisis con ellas. Para poder trabajar con ellas seria necesario convertirlas a un
formato nativo de ESRI como son los Shapefiles.. A continuacion generaremos un archivo shape a partir de la
feature class polilineas del CAD Sevilla_centro.dwg

= Haz Clic con el botén derecho del ratén sobre la feature class polilineas del CAD Sevilla_centro.dwg >
Export > to Shapefile (single).

* En Cuiput Location indica la localizacion en la que quieres guardar el nuevo shape y en Output Feature
class name, el nombre que le quieres dar al nuevo shape > Aceptar.

e Visualiza en ArcMap el nuevo shape creado

Paso 8. Examinar los Datasets Raster

Los formatos raster aimacenan datos como celdas o pixeles de igual tamafio organizados en filas y en
columnas. Cada una de estas celdas contiene un valor Gnico y la resolucién de los datos estéa relacionada con
el tamario de la celda: una celda mas pequefia puede mostrar mas detalladamente el 4rea de estudio pero
también puede aumentar el tamafio del archivo. con ArcGis podras visualizar y convertir muchos formatos de
archivos raster incluyendo formatos de imagenes conocidos.

* Enlatabla de contenidos de ArcCatalog, haz Clic en Ia imagen C:\Practica 211050-2-3.sid, y obsérvala.
(Se trata de una ortofoto en color a escala 1:10.000 elaborada por el ICA y que representa una zona de la
Sierra de Grazalema).

La imagen se muestra en la ventana Preview.

)
¢ Haz Clic con la herramienta Zoom In = y dibuja un pequefio cuadro en cualquier lugar de la imagen.
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Observa que si amplias mucho la imagen, ésta se ve borrosa pudiendo ver claramente los pixeles que la
forman.

A continuacién, examina las propiedades de la imagen

* Haz Clic con el boton derecho del ratén en 1050-2-3.sid > Propiedades.

Pregunta 11: La imagen tiene ...0....cceeeeuni... filas ¥, ....cceciveneieenn. cOlumnas.
Pregunta:12: El tamafio de la celda es de .................(metros)
. Haz Clic en Cancelar para cerrar la ventana Propiedades.

Ahora, utiliza ArcCatalog para visualizar otra imagen.

e Visualiza el archivo sevilla.bil. Como puedes observar, se trata de una imagen satélite de la ciudad de
Sevilla.

Paso 10. Crear un Thumbnail

Los thumbnail son imagenes pequefias que facilitan la visualizacion de un determinado Dataset, mapa o capa

sin tener que dibujar. Podras utilizar el botén Create Thumbnail 88 que esta situado en la barra de
herramientas de Preview en ArcCatalog para crear un a consulta instantanea de tus datos.

* Enla carpeta Practica 2, haz Clic sobre la cobertura MUNI.
e Haz Clic en la ventana Preview.
Observa que los botones de la barra de herramientas Preview estan ahora activos.

e Haz un Zoom In en el centro de la cobertura MUNI

e Haz Clic en el boton Create Thumbnail B para crear una imagen miniatura nueva.

e Cambia a la vista de Contenidos , pincha en la carpeta Practica 2.
g
» Haz Clic en el botén Thumbnails =~ para poder visualizar la miniatura que acabas de insertar en la
cobertura MUNI.

e  Practica creando Thumbnails para los tipos de datos de la carpeta Practica 3.

¢ Cierra ArcCatalog y ArcMap.

FIN DEL EJERCICIO
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EJERCICIO 2B. SISTEMAS DE REFERENCIA

Este ejercicio nos demuestra cémo las diferentes proyecciones pueden afectar a nuestros datos, sobre todo
en cuanto a forma, area, distancia y direccién. Examinaremos las propiedades de proyeccion de algunos de
los datos y utilizaremos las herramientas de proyeccion de ArcToolbox para proyectar un archivo Shape.

Paso 1. Examinar como la proyeccién de un mapa puede afectar a la distancia

=  Abre ArcMap. Elige la opcién de comenzar con un mapa existente (An existing map) y haz Clic en OK.
Navega por el cuadro de dialogo hasta C:\ practica 2 y selecciona el documento proyecciéon.mxd.

) @7 e

Trer

Observaras que se abre el documento proyecciones.mxd pero que en la pantallas de visualizacion no puedes
ver ninglin mapa y que las capas de la tabla de contenidos tienen un signo de exclamacion al lado. Como
recordaras el documento *mxd Unicamente guardaba la ruta hacia la fuente de datos y los signos de
exclamacion te estan indicando precisamente que esta informacién se ha perdido. Para solucionar este
problema:

* Haz doble Clic sobre uno de los signos de exclamacién de alguna de las capas de la tabla de contenidos
y navega por el cuadro de didlogo hasta el lugar ddnde se encuentran los datos. (C:\Practica 2\Word).

. "

DORIF CTIK 7[

=1

k2

Observa como el programa reconoce automaticamente la fuente de datos de todas las capas ya que éstos se
encuentran todos ubicados en la misma carpeta.
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O]

A continuacién demostraremos como las proyecciones pueden distorsionar las distancias. Para ello,
mediremos la distancia entre dos ciudades africanas (Tunez y Ciudad del Cabo) usando diferentes
proyecciones.

e Haz un Zoom alrededor de Africa.

s Pon etiquetas con los nombres de las ciudades para ayudar a localizarlas (Clic con el botén derecho del
raton sobre la capa cities > Label Features).

2
«  Con la herramienta Measure & , mide la distancia entre Tunez y Ciudad del Cabo.

La distancia se muestra en el lado izquierdo de la barra de estado. Tu resultado debe ser cercano a 8.000 Km.

®

e Haz Clic con el botén derecho del ratén en el Data Frame Layers. Selecciona la pestafa Coordinate
System. En la opcion Select a coordinate system, haz Clic en Predefined.

e Haz Clic en Proyected Coordinate System > World > Behrmann (world).> Aplicar (contesta Sl en el
cuadro de dialogo de advertencias para continuar).
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* Vuele a medir la distancia entre Tunez y Ciudad del Cabo.

La nueva distancia deberia estar alrededor de 8.500 km.

Paso 2. Ver como la proyeccion del mapa puede afectar a la forma.

e Desactiva la capa cities.

e Haz Clic en el boton Full Extend a para volver a la extension completa de todas las capas.

* Selecciona como sistema de referencia, el sistema de coordenadas proyectadas Plate Carree (Clic con el
botén derecho del ratén en el Data Frame > Propeties > Coordinate System > Predefined> Projected
Coordinate Systems >World).

e Activa la capa circulos al mapa.
A continuacion, cambiaremos la proyeccién del mapa y observaremos la distorsion de los circulos.

e Cambia el sistema de coordenadas Plate Carree por el sistema de coordenadas proyectadas Miller
Cylindrical (Layer Propeties > Coordinate System > Predefined> Projected Coordinate Systems >World).

Observa que las caras a lo largo del ecuador parecen estar menos distorsionadas que las que estan al norte y
al sur. Practica con un par de proyecciones mas para ver cémo se distorsionan las formas de las caras.
Moliweide (world) y Equidistant Conic (world) muestran algunos resultados interesantes. También puedes
probar a medir distancias para ver si las formas y distancias se distorsionan en las mismas proyecciones.

Paso 3. Examinar los datos de Sevilla

= Abre ArcCatalog. En la tabla de contenidos busca la carpeta practica 2, y haz Clic en el archivo nlcleos

de poblacion(pol).shp. Este correspondiente un archivo poligonal que representa los nicieos de poblacion
de la provincia de Sevilla.

* Haz Clic en la pestafia METADATOS y observa la informacién sobre la referencia espacial del archivo.
(en la pestarfia Spafial y haciendo Clic en Detaiis).

Pregunta 1. ;Qué proyeccion utiliza el sistema de referencia que representa el archivo nlcleos de
POl A e ON S D P onrs s s e T i S0l frnmnnmranrannsss smam mens nm s s e e

Pregunta 2. ; Cuales son las unidades de medida del Mmapa?........cccoeeveieeiesesesssesssessevesnenens

Pregunta 3. ; Qué datum se utiliza para hacer referencia a estos datos?........cececevveeevveecernnns

Paso 4. Proyeccion de un archivo Shape

Aunque ArcMap es capaz de proyectar en el aire datos que se ajustan
al sistema de coordenadas seleccicnado para ver las capas en un data
frame, a veces, serd necesaric proyectar fisicamente los datos en un
nuevo sistema de coordenadas. Imagina que recibes datos de ofra
agencia que ufiliza un sistema de coordenadas diferente al de tu
organizacion. Antes de incorporar los datos a tu base de datos,
necesitaras ajustar los nuevos datos para que se ajusten a tus datos
existentes. Muchas de las técnicas de analisis espaciales de ArcGis
requieren que los datos de las diferentes capas tengan el mismo
sistema de coordenadas.

e« En ArcCatalog, selecciona el archivo municipios.shp
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PRACTICA 2

(correspondiente a un archivo shape poligonal de los limites municipales de Andalucia) .Si observas sus
metadatos veras que no tienen ningln sistema de coordenadas definido

Ahora utilizaremos el asistente de sistemas de referencia para asignarle un sistema de coordenadas

e En latabla de contenidos haz clic con el botdn derecho del raton sobre la feature class municipios.shp>
Propiedades.

¢ Clic en la pestafa Field del cuadro Shape Propierties.

¢ Clic en el campo Shape > Clic en el botdn -
Aparece un asistente para establecer el sistema de coordenadas.
s Haz Clic en Select>Proyected Cordinate System> UTM >Others > Europeam Datum 1950 Zone 30N

e  Aceptar

= Vuelve a la pestafa de metadatos para examinar el cambio en la informacién espacial (probablemente
tengas que actualizar la informacién. Para ello, en el menu general View Refresh).

o Cierra ArcCatalog.

FIN DEL EJERCICIO
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EJERCICIO 3. CONSTULTA DE BASE DE DATOS

3.A. Herramientas basicas de Consulta

Paso 1: Copiar los datos en nuestro ordenador
Paso 2: Iniciar ArcMap; ,abrir un nuevo mapa, asignar unidades y sistema de coordenadas al mapa.
* Inicia ArcMap seleccionando un nuevo mapa vacio (A New empty map)

A continuacion, definiremos las unidades del mapa y el sistema de coordenadas en el que estaran
proyectados los mapas

* Clic con el boton derecho del ratén sobre el Data Frame Layers > Properties. Aparece el cuadro de
dialogo de propiedades del Data Frame.

e En la pestafia General, indica que las unidades del mapa y las unidades de visualizacién son metros.
>Aplicar.

¢ Haz dlic en la pestaria Coordinate syste que el sistema de coordenadas del data frame es desconocido
(Unknown).

* En el cuadro Select coordinate system, haz Clic en Predefined >Projected Coordinate System > UTM >
Others GCS >Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar.

&
¢ Afade la capa limites municipales.shp (boton Add Data i ), situada en C:\ practica3

Se afiaden a la Vista de datos la capa limites municipales de la provincia de Sevilla

Paso 3: Identificar un Elemento

Utilizaremos la herramienta Identificar para averiguar el nombre de cada municipio (entre otros datos) de la
capa limites municipales.shp.

. En el menu herramientas haz Clic en Ia herramienta identificar
e Haz Clic en alguno de los municipios de Ia provincia de Sevilla
Aparece una ventana de resultados, la cual muestra el valor de todos los atributos de ese elemento

Pregunta 1: ; Cual es el nombre, area y perimetro del municipio situado mas al norte de la provincia de
Sevilla?....co et 2 4

A continuacion resaltaremos el elemento que acabamos de identificar para verlo mejor en la pantalla del
mapa.

* En el panel Izquierdo de |z ventana de Resultados, haz Clic en e nombre del municipio mientras que
observas la pantalla del mapa para ver el municipio que se resalta en la capa limites municipales.shp.

« Cierra la ventana de resultados

Paso 4: Buscar un elemento especifico

Ahora utilizaremos la herramienta Buscar para localizar elementos con un determinado atributo. Esta

herramienta nos ayuda a Iocalizar elementos en una o mas capas. Podemos utilizar cualquier texto o bien un
valor.
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e Haz Clic en Buscar

e En la ventana Buscar escribe Villanueva.

g

e En el selector de capas deja el valor tomado por defecto <Visible

layers>

¢ Haz Clic en Buscar (Find)

Cbserva que la ventana Buscar se despliega y aparece un recuadro con Ios
resultados de la busqueda

»  Con el boton derecho del ratdn, haz Clic en Villanueva de San Juany |
selecciona la opcion Flash Feature (Resaltar elemento). Observa que el
municipio citado aparece resaltado en la parte inferior derecha de la provincia de Sevilla. //Quizas
necesites mover la ventana Buscar para poder ver el elemento resaltado//

A continuacion, practicaremos con las opciones restantes del menu contextual

= Selecciona el municipio antes resaltado utilizando la opcion Select feature (seleccionar elemento).
Una vez seleccionado, el elemento aparecera resaltado.

e Establece un BookMark (marcador espacial) para la extension del elemento seleccionado en la opcion
Set BookMark que aparece en el menu contextual.

//Nota: cuando hayas establecido el bookmark, podras volver a este municipio con solo hacer Clic en el menu
View > BookMark > el nombre del municipio que quieres ver de nuevo. También podras definir, acceder y
organizar marcadores desde el menud Ver.

e« Haz un Zoom al elemento, seleccionando Zoom.
e Finalmente, anula la seleccion del elemento con la opcién Unselect.
e« Cuando acabes con las pruebas, cierra la ventana buscar.

e Haz Clic en el menu View > BookMark > Villanueva de San Juan

Paso 5: Realizar mediciones

A continuacion realizaremos las mediciones del mapa en la pantalla.

i
ot d
. Haz Clic en la herramienta Medir ==
. Coloca el signo + del cursor en el limite de cualquier municipio y haz Clic una vez, mueve el cursor

hasta el limite de otro municipio y haz doble Clic

Una vez establecida tu linea de medida, aparecera la distancia con la unidad de la capa en la barra de estado,
que esta situada en la parte inferior de la pantalla de ArcMap

Como podemos ver, en la barra de estado aparecen dos valores, el primero (Segment) correspondiente al
valor de medida del ultimo segmento y el segundo (Total) al valor total de medida de todos los segmentos.

Pregunta 2: ;Cual es la longitud aproximada (en Km) de la provincia de Sevilla si fuera atravesada por
una linea recta de Norte a Sur?.......... e SP=SR, G . W
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PRACTICA 3

3.B. Ejercicios de Selecciones (mantenemos el mismo proyecto.mxd que en el gjercicio 3.1)

La Consejeria de Obras Publicas de la Junta de Andalucia tiene previsto realizar una serie de obras de
adecentamiento de dos carreteras la A-455 y la Se-198, para lo cual desea conocer los siguiente:

#  Cudles pueden ser los nucleos de poblacién afectados por la realizacion de las obras

» Los tramos de Ios rios afectados (ya que la inversién tendra que ser mayor cuanto mas cruces de rios
haya)

Paso 6: Seleccién por Atributos de las carreteras a adecentar

= Junto con la capa limites municipales, afiade una nueva capa red de carreteras. shp localizada en C:\
practica 3.

//La capa red de carreteras.shp es un Shape lineal con informacién espacial de las carreteras de la provincia
de Sevilla, generado por el ICA. el nombre de cada una de las carreteras aparece en el campo MATRICULA.//

Lo primero que tendras que hacer es selecciona todos los tramos que pertenecen a las carreteras A-455 y Se-
198. Si fuera un sélo objeto se podria realizar mediante la herramienta Buscar, pero en este caso son dos
carreteras y, cada una de ellas, compuesta por multiples arcos, por lo que utilizaremos la Seleccién por
Afributos de ArcMap.

e Enlabarra de menu, haz Clic en Selection > Select By Attributes
Aparece el cuadro de Dialogo Select By Attributes que te permite hacer consultas para las capas de tu mapa.
* En Layers selecciona la capa sobre la que quieres realizar la seleccién, en este caso red de carreteras.
¢ Como método de seleccion comprobamos que es Create a New Selection (crear una nueva seleccion)

«  Elaboramos la sentencia SQL de seleccion de la siguiente forma:

o En Fields, haz Doble Clic en "MATRICULA" (recordemos que es el campo
de la tabla de atributos donde se encuentran los nombres de la
carreteras. Si lo quieres comprobar: desde la vista de datos, haz Clic con
el botdn derecho del raton sobre la capa red de carreteras.shp >Open
Attribute table > Observa que en el campo MATRICULA estan los
nombres de las carreteras.)

o Haz Clic en el botén = de la lista de operadores

o Haz Clic en el botén Get Unique Values para obtener la lista completa de
los valores de nombres de las carreteras: selecciona A-455

. Haz Clic en Aplicar

e Para incorporar la segunda carretera (Se-198), volvemos a repetir la
operacion, pero esta vez utilizando como métedo Add to current selection (afadir a la seleccién actual) y
la expresion "MATRICULA" = 'Se-1gg'

e Haz Clic en Aplicar.

/lLa seleccion la hemos realizado en dos fases (primero una carretera y despues ofra), pero podriamos
haberla realizado en una sola. Para elio tendriamos que haber escrito como secuencia SQL lo siguiente:
"MATRICULA" = 'A-455' OR "MATRICULA" = 'Se-198'//

Modulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA 2007
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Después de aplicar la consulta, los elementos de la capa red de carreteras se seleccionan y sus lineas
aparecen resaltadas con un color diferente (predeterminado azul). esta seleccion podré utilizar se en otras
operaciones; puedes crear una capa nueva a partir de los elementos seleccionados o puedes calcular
estadisticas

. Cierra la ventana Select By Atributes.

Paso 7: Generar una capa de seleccion

Una capa de seleccion es una capa separada que contiene solamente los elementos seleccionados. A
continuacion, crearemos una capa de seleccidn para las carreteras seleccionadas.

e« Haz Clic con el botdn derecho del ratén sobre la capa red de carreteras.shp (en la que se encuentran
las carreteras seleccionadas)

» Haz Clic en Data = Export data
e En el cuadro de dialogo Export Data nos aseguramos de que exportamos los elementos seleccionados.

« Haz Clic en botdn de carpeta, anota A455_SE198 como nombre del archivo navega hasta el lugar donde
quieras guardar el archivo.

« IMPORTANTE! Elimina la seleccion de la capa red de carreteras.shp; Haz Clic con el botdn derecho del
ratén sobre la capa red de carreteras.shp > Selection > Clear selection.

« Haz Clic sobre el cuadro de verificacion de la capa red de carreteras.shp para dejar de visualizarla, ya
que esta no te va a servir mas de utilidad

/{Nota: si consideras necesario cambia la simbologia de la carretera para que esta se visualice mejor. Dale,
por ejemplo un color rojo y aumenta el grosor de las lineas//

Paso 8: Seleccionar los niucleos de poblacién mas cercanos a las carreteras (Seleccion espacial de
cercania)

Necesitamos conocer cuales pueden ser los nucleos de poblacién afectados por estos arreglos de las
carreteras, en concreto seran todos los nucleos de poblacién gue se encuentren a menos de 1000 metros de
esas carreteras.

e Afade la capa nicleos de poblacién(pol).shp localizada en C:\practica 3

//La capa nucleos de pablacion(pol).shp es una capa de informacion poligonal generada por el ICA de los
nucleos de poblacion de Sevilla. El nombre de cada nicleo de poblacién aparece en el campo NOMBRE de la
Tabla de Atributos, y en el campo MUNICIPIO se indica el término municipal al cual pertenece cada nucleo./f

* Enla barra de menu general haz Clic en Sefection > Select By Location

Aparece el cuadro de Didlogo Select Location que te permite hacer consultas espaciales para las capas de tu
mapa. Nos aseguramos de que las configuraciones para seleccionar elementos de la capa nuciecs de
pcblacion.shp que esta a una distancia de menos de 1000m de las carreteras son las gue aparecen abajo
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o Queremos Seleccionar elementos

o De las capas : nicleos de poblacién(pol)

o Que: estén a una distancia maxima de
o los elementos de la capa: A455_SE198

o de: 1000 metros

El cuadro de didlogo debe que dar relleno de la siguiente forma:
. Haz Clic en Aplicar y cierra el cuadro Select By Location

(No borres la seleccion en la capa nucleos de poblacion.shp ya que
nos sera de utilidad en el siguiente paso)

Paso 9: Examinar los valores en las tablas

Recuerda que cada capa tiene una tabla que contiene un registro de
cada uno de los atributos de los elementos. Puedes examinar, analizar y editar esas tablas.

» Haz Clic con el botén derecho del raton en la capa nlcleos de poblacion y selecciona Open Attributte
Table.

Observa que los registros seleccionados resaltados (al seleccionar los elementos en la Vista de datos también
se seleccionan los registros correspondientes en la tabla de atributos) y que en la barra de estado de la tabla
aparece el total de registro y cuantos de ellos estan seleccionados.

Pregunta 3: ;Cual es el numero tpt_al} de registros y cuantos estidn seleccionados?

PRI TTTETT T e ra—.

e Haz Clic en el botdn selecfed que aparece en la parte inferior de la tabla

Observa que la tabla solo muestra los registros seleccionados. Estos son los nucleos de poblacién a los que la
construccion de la carretera podria afectar..

e Cierrala Tabla

Paso 10: Calcular estadisticas de los valores
La opcion Estadisticas genera un informe de alguna de la informacion estadistica comun relativa a sus datos.
= Enel mend principal e ArcMap, haz Clic en Selection >Statistics

e En el cuadro de didlogo Selection Statistics, en Layers, comprueba que estd seleccionada la capa
nucleos de poblacién(pol).shp

* En Field (campo), haz Clic en AREA

ey Distribnmion

Fiey

Las estadisticas mostraran una pantalla con el minimo, el
maximo, el promedic, la desviacién estandar, el area total,
asi con el nimero total de municipios, los cuales estan
afectados por el adecentamiento de las carreteras
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° Cierra el cuadro Statistic Selection

;\{ Limpia la seleccién de la capa nlcleos de poblacion(pol).shp; Haz Clic con el botén derecho del
< S raton sobre la capa > Selection > Clear selection.

Paso 11: Generar una capa que contenga los nucleos de poblacion seleccionados

= Hhaz Clic con el botdn derecho del raton sobre la capa nicieos de pobiacién (pol).shp (capa en ia que
se encuentran los datos seleccionados)

+ Haz Clic en Data > Export data
e En el cuadro de dialogo Export Data nos aseguramos de que exportamos los elementos seleccionados.

s Haz Clic en botdon de carpeta, anota nacleos_afectados como nombre del archivo navega hasta el lugar
donde quieras guardar el archivo.

+ Elimina la seleccion de la capa nucleos de poblacion(pol).shp.; Haz Clic con el botén derecho del raton
sobre la capa nucleos de poblacidn(pol).shp > Selection > Clear selection.

e« Haz Clic sobre el cuadro de verificacion de la capa nucleos de poblacion.shp para dejar de visualizarla,
ya que esta no te va a servir mas de utilidad

Paso 12: Seleccionar todos los rios que se cruzan con las carreteras a adecentar
En el siguiente paso seleccionaremos todos los rios que se cruzan con las carreteras a adecentar.
» Afiade la capa red hidrografica.shp localizada en C: \practica 3.

//Se trata de una capa tipo Shape lineal que contiene la informacion espacial de la red hidrica de Sevilla,
generada por el ICA. El nombre de cada rio aparece en el campo NOMBRE, aungue hay algunos afluentes en
los cuales no viene reflejado su nombre.//

* Realiza la seleccion de los rios que cruzan con las carreteras la A-455 y Se-198. Utiliza para ello, la
Seleccion por Localizacion (por interseccion).

« Crea una nueva capa que contenga unicamente los rios afectados y llamala rios_afecados.

PRUEBA. ; Cuales de los nicleos de poblacion afectados por el adecentamiento de las carreteras se
encuentran dentro del Parque Natural de la Sierra Norte de Sevilla?

Nota: La capa de informacion de los Espacios Naturales se encuentra en: C:\\practica 3\enp shp
Guardar el documento y salir de ArcMap

FIN DEL EJERCICIO.
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EJERCICIO 4A. TRABAJAR CON TABLAS

Archivos utilizados para esta practica

Cobertura MUNI: Municipios de Andalucia

Shape z_arqueo (puntual): seleccién de yacimientos arqueologicos de Andalucia.

Shape municipios.shp (poligonal): municipios de Andalucia.

Shape municipios_al (poligonal): municipios de la provincia de Almeria.

Shape poblacion_al (poligonal): cantidad de poblacién de cada municipio de la provincia de Almeria.

Tabla res_al.dbf: tabla independiente que contiene restaurantes de algunos municipios de la
provincia de Almeria.

Este ejercicio te ayudard a familiarizarte con los formatos de atributos tabulares relacionados con los datos
espaciales. Ademas, te mostraréd como mezclar tablas a través de relaciones y combinaciones examinando
varios formatos.

Paso 1. Abrir ArcCatalog y examinar tablas Info.
¢ Inicia ArcCatalog y busca la carpeta C:\ Practica 4.

Vamos a utilizar ArcCatalog para visualizar la informacion de atributos de las feature classes. recuerda que
cada elemento de una feature class esta representado por una fila en la tabla.

Primero, vamos a examinar una tabla Info. Las tablas Info son el formato predeterminado de las tablas de
atributos de las coberturas. Cada feature class de una cobertura tiene su propia y unica plantilla.

= Desde ArcCatalog, visualiza la tabla de atributos de |a capa poligonos de la cobertura MUNI. (Observa
los campos y valores de la tabla (pestafia Preview, opcion tabla)

pomene

Los campos que van desde AREA a MUnI-ID fueron creados y calculados por Arcinfo cuando se cred la tabla
al principio. Los campos situados a la derecha de MUNI-ID son campos de atributos afadidos por el usuario.

Pregunta 1: Indica el nombre de los campos generados POr @1 USUAIO........v..ceveeeveeeeeeeeeeseeeese oo eeeeeeeeeens

Paso 2. Examinar una tabla de atributos de un elemento tipo shape.
Ahora veremos una tabla de atributos tipo shape.
¢ Haz Clic en z_arqueol. shp

//Nota: si tienes activada la opcion mostrar extensiones de archivos, veras en el indice el archivo z_arqueol.
shp , si no veras soélo z_arqueol. Para activar u ocultar las extensiones de archivos, haz Clic en el menu Tools
> Options > marca la casilla Hide file extensions.//
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Aparecera la tabla de atributos de elementos correspondiente al archivo Shape z_arqueol.

| TEG

SRR T Y ARDUEG ] U ARGUEG 1 | EOMG0 | THOMBRE i X T

« Cambia el tamario de las columnas como consideres necesario. Para ello, haz Clic en la linea divisoria
entre los nombres de las columnas y arrastra la columna para hacerla mas grande o mas pequefia.

Paso 3. Examinar las propiedades de los campos.

El archive Shape z_arqueo esta asociado de forma predeterminada a una tabla de tipo dBASE que contiene
atributos para cada una de las zonas arqueologicas representadas en el archivo Shape. Puedes examinar las
definiciones de los campos de la tabla en la ventana Propiedades del archivo Shape.

¢ En elindice, haz Clic con e! botdn derecho del ratén sobre la capa z_arqueol > Propiedades.
» En la ventana Propiedades del archivo shape gue aparece, haz Clic en Fiels (campos).

Aparecera una lista de los campos existentes en |a tabla de atributos del archivo shape z_argueol junto al tipo
de dato que contiene cada campo.

Pregunta 2 ;De qué tipo es el campo NOMBRE? ;Y el campo
PERIMETRO?

Fleia biavse 1 e lone

Haz Clic sobre el campo Shape y observa como el cuadro de propiedades
cambia para mostrar las propiedades de este campo

Pregunta 3 ;De qué tipo de geometria es el campo SHAPE?

e Haz Clic en algunos de otros campos para ver sus propiedades.

« Haz Clic en Cancelar para cerrar la ventana de propiedades del archivo.

Paso 4. Examinar una relacién uno a uno y realizar un JOIN

Queremos saber la poblacion de los municipios de la provincia de Almeria. Sin embargo, la informacion que
contiene estos datos se encuentra en tabla diferentes.

La tabla de atributes del archivo municipios_al.shp contiene los municipios de la provincia de Almeria vy la
tabla de atributos del archivo poblacion_al.shp el codigo de los municipios y la peblacién de cada unc de
ellos. Para obtener toda la informacion en una misma tabla es necesario relacionar ambas tablas. Al tratarse
de una relacion uno a uno, realizaremos esta conexion mediante un JOIN.
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e Abre ArcMap y afiade los archivo municipios_al.shp y poblacion_al.shp (C:\Practica 4). Visualiza las
tablas de atributos de ambos archivos.

La tabla de atributos del archive municipios_al.shp contiene los municipios de la provincia de Almeria y la
tabla de atributos del archivo poblacion_al.shp el codigo de los municipios v la poblacién de cada uno de
ellos. Para obtener toda la informacién en una misma tabla es necesario relacionar ambas tablas. Al tratarse
de una relacion uno a uno, realizaremos esta conexion mediante un JOIN

Pregunta 4: ;Cual es el campo en el cual estard basado el JOINT......cooveveeeeeeeeeeeeeeeeeeeeeeereen,
e Haz Clic con el botén derecho del ratdén sobre municipios_al >Joins & Relates> Join.

e En el cuadro de didlogo Join Data selecciona COD_MUNI como el campo en el que se basara el JOIN:
selecciona poblacion_al como la tabla a combinar y luego COD_MUNI como el campo en el que se
basara el JOIN. Haz Clic en Aceptar.

» Abre y examina la tabla de atributos de municios_al y veras que los atributos de poblacion_al se han
anadido.

Paso 5. Modificar la apariencia de Ia tabla combinada
Para hacer que la tabla que acabas de combinar sea facil de leer, cerraremos algunos campos.

» Haz Clic con el boton derecho del ratén sobre municipios_al > Propiedades > Fiels. Haz Clic en los
siguientes campos para anular la seleccion de la casilla visible: MUNICIPIOS, COD_PROV, PROVINCIA,
COD_INE. , TIPO, Poblacién_alFID y Poblacién_alCOD_MUNIC> Aceptar.

e  Abre la tabla municipios_al para ver los cambios.

¢ Cierra la tabla municipios_al.

Paso 6. Trabajar con una relacién muchos a uno y realizar un JOIN ESPACIAL

ArcMap ofrece la posibilidad de unir tablas a partir de una relacion espacial entre elias (sin ser necesario un
campo en comun), el JOIN ESPACIAL. Imagina gque tenemos dos tipos de informacién come son, por un lado
un archivo de datos (z-arqueo.shp) que coniene los yacimientos arqueologicos de Andalucia y otro archivo
(municipi.shp) gue contiene los municipios también de Andalucia. Nuestro objetivo es saber a qué municipio
estd asociado cada yacimiento argueoldgico pero las tablas de atributos de ambos archivo no contienen
campos en comun. Realizaremos un JOIN ESPACIAL para establecer la relacion.

*  Anade los archivos municiposi.shp y z_arqueo.shp (C:\ practica 4). Observa sus tablas de atributos
e Haz Clic con el boton derecho del raton sobre z_arqueo.shp >Joins & Relates > Join.

//Nota: recuerda que los JOIN permiten relaciones uno a uno o muchos a uno, es por ello por lo que el JOIN
se lo tienes que aplicar a z_arqueo (muchos yacimientos pueden localizarse en un mismo municipio -muchos
a uno-, y un municipio puede contener varios yacimientos -uno a muchos-lo que no estaria permitido)/

e Enlaventana Join Data, selecciona la opcion Join data from another layer based on spatial location (JOIN
espacial).
* Selecciona la capa con la que quieres relacionarte, en este caso municipios.shp.
=
e Haz Clic en == | llama al archivo de salida arg_muni.shp y navega por el cuadro de didlogo hasta la
localizacién que le quieras dar.

e Abre la tabla de atributos de arg_muni y observa que los atributos de la capa municipios.shp se han
unido a la de los yacimientos arqueologicos.
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Paso 7. Examinar una relacion uno a muchos y realizar un RELATE

Al contrario que los JOINS, los RELATES simplemente establecen una relacién entre dos tablas sin que los
datos asociados se afiadan a la tabla de atributos de la capa. Los RELATE son utilizados para asociar tablas
en la que la cardinalidad es de uno a muchos. Por ejemplo, si queremos saber los restaurante gue hay en un
término municipal en concreto pero esta informacion se encuentra en tablas diferentes, habra que relacionar
las tablas mediante un RELATE para resolver dicha cuestion.

s Afade a la vista de ArcMap la capa municipios_al.shp (afiadela por segunda vez) y la tabla res_al.dbf,
la cual contiene una seleccién de restaurantes de la provincia. (C:\ practica 4}

e Abre ambas tablas a la vez y examinalas.

Pregunta 2: ;Cudl es el campo en comun en el cual estara basado el RELATE?

e Haz Clic con el botén derecho del ratén sobre municipios_al.shp >Joins & Relates >Relate.

s Selecciona COD_MUNIC como el campo de la tabla de municipios_al.shp en el cual estara basado el
RELATE.

e Selecciona res_al.dbf como la tabla con |a que quieres establecer la relacion.
e Selecciona MCOD_MUNIC como el campo de la tabla res_al.dbf en el cual estara basado la relacion.
e« Nombra a la relacion como MUNI_Res. =Aceptar.

Aparentemente no ha habido ningiin cambio ya que si observamos las tablas que han participado en el
RELATE, éstas no han sido modificadas. Para observar la relacién establecida haga lo siguiente:

e Abre la tabla de atributos de municipios_al.shp y selecciona el registro que corresponde al municipio "El
Ejido" (pinchande sobre el registro)

i/Nota: te serd méas facil seleccionar el registro si ordenas el ampo municipio de forma ascendente o
descendente.//

« Haz Clic en Options (en la parte inferior del cuadro de diglogo de la tabla) > Relate > MUN/_res. Observa
que aparece la tabla relacionada, con los registros pertenecientes a restaurantes de El Ejido,
seleccionados.

A )

a1 ron e | N

« Cierratodas las tablas.

Paso 10. salir de ArcCatalog y ArcMap
FIN DEL EJERCICIO

Médulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA 2007

(8]
)



Sistemas de Informacion Geografica EJERCICIO 5

EJERCICIO 5A. CREACION Y EDICION DE FEATURE CLASS

Estamos realizando el Estudio de Impacto Ambiental de la Modificacion puntual de las Normas Subsidiarias
del municipio de Sierra de Yeguas- provincia de Malaga-. Uno de los pasos fundamentales es la definicion y
cartografia de las unidades ambientales.

El objetivo de este ejercicic es precisamente cartografiar estas unidades, para lo cual tendremos que crear
una feature class que contenga esta informacion.

Las unidades ambientales definidas son:
* Zonas de especial proteccion
s« Zona de cultivo
¢« Nucleo de poblacién

Utilizaremaos como referencia un plano en formafo *bmp que nos ha facilitado el arquitecto del municipio

CEMENTERIO
Zona de especial proteccién

Nucleo de poblacion

M=/ ona de Cultivos

Paso 1: Copiar los datos en nuestro ordenador

Paso 2: Iniciar ArcMap ,abrir un nuevo mapa, asignar unidades y sistema de coordenadas al mapa.
* Inicia ArcMap seleccionando un nuevo mapa vacio (A New empty map)

A continuacion, definiremos las unidades del mapa y el sistema de coordenadas en el que estaran
proyectados los mapas

« Clic con el boton derecho del ratén sobre el Data Frame Layers > Properties. Aparece el cuadro de
dialogo de propiedades del Data Frame.

N D
R
ofrevnil =
& agdDate...
@ New Group Laver

Bz Copy

Reterance Scele »

Labelng »

Artivate

=5
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En la pestafia General, indica que las unidades del mapa y las unidades de visualizacion son metros.
>Aplicar.

Units
Map: iMeters
Display: %Metem v

Haz clic en la pestafia Coordinate system y observa que el sistema de coordenadas del data frame es
desconocido (Unknownj.

En el cuadro Select coordinate system, haz Clic en Predefined >Projected Coordinate System > UTM >
Others GCS >Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar.

Afade la feature class raster mod punt.bmp (C: \practica 5). Esta es la imagen raster facilitada por el
arquitecto del municipio de Sierra de Yeguas.

Haz un zoom a la zona de studio.

SR

Paso 3. Crear una feature class poligonal

Para poder generar la capa de Unidades Ambientales serd necesario crear una feature class vacia, de
geometria poligonal, en la que cada poligone representara una unidad ambiental.

Abre ArcCatalog. Navega por la tabla de contenidos hasta C:\practica 5.

Haz Clic con el boton derecho del ratén scbre la carpeta PRACTICA 4 > New > Shapefile

Cerl+C

* L WIND B paste v

+ . CA\DATOS iCTICE

+ @ C:\Dacum
+ a3 Dt Rename  F2
+ 3 Database ~u
+ O Address L
+ ! Coordinat
+ a8 GIS Serve

e Staler Ref i 2e0rch. ..

X Delete iS\Es |

w Refresh

3 Folder

“ personal Geodatabase

+ Q,n Search Reg Properties.. & Layer.

* A ToolbOXEs T

+ {% Tracking Connections € Group Layer
4 shapefile..

LJ
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Aparece el cuadro de creacion de Shapefile
* Indica UNIDADES AMBIENTALES como nombre de la nueva feature class y Polygon como geometria.
» Enelcuadro de sistema de coordenadas, haz Clic en el botén Edit. > Select

¢ Navega por el cuadro de contenidos hasta Predefined >Projected Coordinate System > UTM > Others
GCS >Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar

¢ Finalizar

Paso 2 Editar elementos en la feature class
= Ve a AccMap y junto a la imagen raster mod punt.bmp afade la nueva feature class creada,,

+ :
UNIDADES AMBIENTALES.shp (Add Data ). Observa que aunque el la tabla de contenidos

aparece la nueva capa afiadida, en el area de visualizacion de ArcMap no tiene lugar ningun
cambio ya que el shape UNIDADES AMBIENTALES aun se encuentra vacio.

Ahora comenzaremos a editar el shape que acabamos de crear.

-
e Abre la barra de herramientas de Edicion. Para ello haz Clic en el botén *=*
e  Para comenzar la sesion de Edicion haz clic en Editor > Start Editing

Editor x

e e

DT R A

122
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e En la lista de tareas (Task) indica que quieres crear un elemento nuevo (Create New Feature) y en la
capa de destino (Targef), indica que se trata de UNIDADES AMBIENTALES.shp

cator v~ b A1k [Geateomreatue UNIDADES AVEIENTALES -

Capa de destino

Lista de Tareas

e Con la herramienta Sketch Tool * y empieza a dibujar el poligono que representarg la Unidad
Ambiental Zona de Proteccién Ambiental. Haz un Clic para cada uno de los vértices del poligono. Para
terminar el poligonc haz un doble Clic con el ratén.

3 )
//Para eliminar un poligono, selecciénalo con la herramienta + boton SUPRIMIR//

ey
iy

Esta linea es la que delimita
la unidad ambiental zona de
cultivo de la unidad ambiental
nticlec de poblacion

» Repite la operacion para cada una de las unidades ambientales.

{1 ATENCION!AI dibujar las unidades ambientales zonas de cultivo y niicleo de poblacion sélo tienes que

tener cuidado con los limites visibles en el marco que delimitara tu mapa, ya que los otros limites no seran
visibles//

Cree s kb iU
L

T
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* Una vez dibujados las tres unidades ambientales salva los cambios de la edicion (Editor >Save Edits).

Paso 3. Editar atributos de la tabla

Cuando se genera un nuevo shape, automaticamente se genera la base de datos asociada, y por cada unc de
los elementos espaciales que se crean se genera un registro en esa base de

== l
datos. FID Shape' | Kk
0 | Polygon
* Abre la tabla de atributos asociada a la capa Unidades Ambientales.shp 1 Polygon
= Clic con el botén derecho del raton sobre la capa UNIDADES 2 Polygon

AMBIENTALES = Open Atributte Table.

Observa que la tabla de atributos contiene tres registros correspondientes a los tres elementos que has
editado, y trs campos: el campo FID (ArcGis lo afiade automaticamente a todas las tablas con propgsite de
identificacion), el campo Shape (hace referencia al tipo de objeto espacial) y el campo ID. Nuestro objetivo
sera almacenar los nombres de los monumentos dibujados, para lo cual necesitaremos crear un nuevo campo
al que llamaremos NOMBRE y, posteriormente, rellenar los registros.

* Finaliza la sesién de edicion: Editor > Stop Editing y con la tabla de atributos de la capa monumentos
abierta, afiade el nuevo campo: Options > Add Field. En |as propiedades del campo indica que el nombre

del nuevo campo es NOMBRE, que el tipo de dato es Texto y que la longitud de caracteres de texto es
30> OK..

e Cierra |z tabla de atributos.
A continuacién, rellenaremos los registros del campo NOMBRE que acabamos de crear

* Vuelve z activar la sesion de Edicién (Editor > Start Editing).Con la sesion de edicion activada y la

[ 3
herramienta Edit Too! . selecciona uno de las unidades ambientales que has editado > abre el

cuadro de atributos del elemento pulsando en

e Haz doble Clic en el valor del campo NOMBRE y escribe el nombre del monumento del que se trate.

(U]
n



Sistemas de Informacion Geografica EJERCICIO 5

——
e

» Realiza esta misma operacidn con todas las unidades ambientales editadas.

e Guarda los cambios de edicion y cierra la sesion de edicién. (Editor » Save Editing > Editor > Stop
Editing).

e« Abre la tabla de atributos de la capa unidades ambientales y observar que los registros aparecen
editados//

HOMBRE

(i Zona de ecpecial profecolon

0 Mucleo de pablacion

0 Zons de ouliivos

Prueba. Para finalizar tu mapa haz que cada unidad ambiental quede representada con un color
diferente. Para ello clasifica por categorias dicha capa utilizando como NOMBRE como campo en base
al cual se realiza la clasificacion.

En las cuadro de propiedades de la capa> Simbology.

S

IERTASE Rl

FIN DEL EJERCICIO
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UNIDAD 5. EDITAR DATOS

" CONTENIDOS
e Formatos de datos =ditables
¢ Herramientas de edicidn en ArcMap

Seleccionar elementos

Funciones simples de edicién

El mend Sketch {borrador de edicion)
Task. Las Tareas de Edicién

* Menls contextuales de Edicién

Ment contextual de dibujo
Menu contextual de herramientas de dibujo

o  Editar Atributos

Editar atributos para elementos seleccionados
Editar tablas

1. Formatos de datos editables

En ArcGis, cuando utilizamos la palabra “editar” estamos haciendo referencia al fecho de modificar datos
ya existentes o crear otros nuevos. La edicién se Hevara a cabo desde el méduio ArcMap.

Independientemente de [a licencia de ArcGis que poseamos {ArcView, ArcEditor o Arcinfe) utilizaremos
las mismas herramientas de edicién de ArcMap para ftrabajar con nuestros datos geogréficos. Sin
embargo, los formatos de datos que nos permiten editar cada una de estas licencias son diferentes.

e ArcView, sélo nos permite editar shapefile y geodatabases.

¢ ArcEditor y Arcinfo nos permite editar todos los formatos vectoriales de ESRI: Coberturas, shapefile y
geodatabases.

s Los Archivos CAD no son editables por ninguna de las licencias ArcGis. Como hemos comentado en
ccasiones anteriores, serfa necesario convertirlas a otro formato para poder modificarlas.

2. Herramientas de edicién en ArcMap

En ArcMap, las operacicnes de edicién se controlan a través de la barra de herramientas de Editor. Para

acceder a esta barra de herramientas: Clic en el botén
interfaz de ArcMap.

situado en la barra de herramientas de la

Esta barra de herramientas tiene varios controles importantes:
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Cusdro de diddozy

Herraa L&Eli‘!hﬁl‘i“sﬁﬂ B oprilnton
e edicion g g
SosApkiRD 0T TRk TR k
Hevpaladaa
Felitar S
Listo demplegeble de
rens 1
Copauion de £ =

Herromentasle Herpanimta e
divisia de eRnoTis satasiam

2.1. Meni EDITOR desplegable:

Este menti contiene los comandos para comenzar, terminar vy guardar las sesiones de edicidn (Start
Editing, Stop Editing, Save Edits). También proporciona acceso a varias operaciones de edicion, controles
de ajuste y opciones de edicion.

Para acceder a él, Clic en &l botdn en la barra de ment de Edicion.

Para comenzar una sagién de edicidn: Clic en Editor > Start Editing

(previamente tiene que haber cargada alguna capa con formato editable por ArcGis)

2.2. Seleccionar elementos

ArcMap dispone de varios métodos para seleccionar los elementos que necesitamos editar. Estos
métodos se dividen en tres categorias bésicas:

. Seleccidn interactiva: mediante la herramienta Edit Tool
linea o area).

o dibujando una forma (cuadro,

) Menu Sefection {Select by attributes o Select by location).

2.3. Funciones simples de edicidn
ArcMap contiene varias funcicnes simples para editar elementos espaciales

» Mover y arrastrar elementos: es posible realizar esta funcion seleccionando con el cursor.

» Rotacidon - los elementos al seleccionados se pusden

s Split Tool: este control permite dividir el elemento seleccionado en dos elementos
independientes. rotar alrededor de su eje de rotacidn.

o Attribute dialog (cuadro de didlogo de atributos): esta ventana nos permite editar los valores de los
atributos de los elementos seleccionados.

Create MNew Feature

Mébdulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA07 2
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1 arEn

| PERIMETER 119925,281

i municpios 113,

£ erovmicia SEVILA
“FMmICPIo CONSTANTINA
2 COD_INE 410133

A coo_ent 26

2.4, El menii Sketch (borrador de edicidn)

La herramienta Sketch de edicidn ‘es la herramienta

principal de ArcMap. No permite editar nuevos elementos

a partir de [as diferentes opciones de la Lista de Tareas )
o o z Midpnint tool

de Edicion (Task). Para utilizar el Sketch, el botén _ )

izquierdo del ratén afiade elementos y el botén derecho  Distance-Distance tacl

nos permite acceder al mentl contextual Sketch Tools.

Intersection tool
Sketch toal Are tool
Tangent Curve tool

Trace tool

Endpuaint Diraction—
Zre tool Distance tool

Diferentes opciones de la herramienta Sketch Toof

» Intersection tool (herramienta interseccién). Crea un vértice o punto en la interseccion implicada de
los segmentos.

»  Arc Tool (herramienta arco): Nos ayuda a crear un segmento que sea una curva paramétrica (real),
es decir, en vez de estar compuesta por varios vértices, sélo esta compuesta por dos.

»  Midpoint Tool {herramienta punto medio): permite localizar un nusvo vértice o punto a pattir de otros
dos. La localizacién de este nuevo vértice serd el punto medio de entre estos dos vértices.

End Point Arc Tool : permite crear un arco a partir de un radio dado.

Distance Tool (herramienta distancia) : Nos permite crear un vértice o punto en la interseecién de dos
distancias predeterminadas a partir de dos puntos especificos

Direction-Distance Tool: permite editar un vértice o punto a partir de una distancia y direccién dadas.

» Trace Tool (herramienta frazar): permite crear segmentos digitalizando sobre un segmento va
existente.

reate New Feature
Modfy Tasks
- Reshape Feature
Cut Polygon Features
- Mirror Features
- Extend) Trim Features
i - Modify Feature
- Calibrate Route Festure
L Modfy Portion of & Line
=i Topology Tasks
-Modify Edge
{ - Reshape Edge
£ Auto-Complete Palygon
= Other Tasks
i Znone>
i+ Select Features Using a
-~ Select Features Using an
*. Crecte 2-Point Line Feat

2.5. Tasklist. Las Tareas de Edicidn

Se trata de una lista desplegable donde se selecciona la operacién de edicion
que queremos realizar. Las tareas cambiarén de acuerdo con la clase de ¥
elemento que estemos editando.

e  Create Tasks (tareas para crear elementcs)

=«  Modify Tasks (tareas para modificar elementos)

+ Topology Tasks (tareas para medificar la topologfa entre elementos)

e  Other Tasks

f

Tarea en ejecncidn
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A continuacidn detallaremos algunas de estas tareas:

Create New Features {Crear nuevos elementos)

Create Hew Feature

Esta herramienta sera utilizada para crear nuevas entidades en una feature class ya existente. Una vez
seleccionada esta tarea y la capa que queremos editar, utilizaremos alguna de las herramientas Sketch
para hacer &l dibujo, las cuales nos ayudaran a ubicar vértices y segmentos en los lugares preciscs.

Reshape Features (Reestructurar elementos)

Esta tarea se puede utilizar para digitalizar un dibujo que serd parte del elemento que estamos
reformando. Para eilo, seleccionamos el elemento a modificar > dibujamos la nueva forma del elemento
asegurandonos que nuestro dibujo intersecta con el elemento existente > Finish Skefch.

Cut Polygon Features (cortar elementos poligonaies)
Esta tarea nos permite dividir un poligono en dos. Se uiiliza especificamente para la gestion de parcelas.

Seleccionamos el elemento que queramos dividir > dibujamos una linea que intersect ambos lados del
poligeno > Finish Sketch.

Extend/Trim Features (extender y recortar elementos)

* Extender elemento hasta el dibujo: Seleccionamos el elemento que vamos a exiender > dibujamos
una linea hasta donde lo queramos extender > Clic con ei boton derecho del ratdn para que aparezca
el ment contextual > Selecciona la opcién Replaze Skeich1 > En el mismo mend contextual
selecciona la opcidn Finish Sketch.

e Recortar elementos: Seleccionamos el elemento que queremos recortar > Dibujamos una linea de
corte en el fugar a partir del cual queremos recortar >Clic con €l botdn derecho del ratén para que
aparezca el men( contextual > Selecciona la opcién Replaze Sketch > En el mismo ment contextual
selecciona la opcidn Finish Sketch.

Modify Features.

Esta tarea nos permite editar los vértices de un elemento ya existente. Para ello basta con mantener el
cursor sobre el vértice que queramos modificar hasta que cambie de forma, ahora, tenemos que hacer
Clic sobre el vértice y arrastrarlo a una nueva posicidn.

e
Y
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Auto-complete Polygon (autocompletar poligonos)

Esta tarea permite afiadir poligonos a ofros ya existentes sin tener que duplicar el borde que comparten.
Select Features using a Line (seleccionar elementos utilizando iineas)

Esta tarea permite seleccionar elementos a paitir de una linea que intersecte con

dichos elementos. Esta linea se dibuja con el Sketch Too

2.6. Target layer {capa de destino)

Este control nos permite seleccionar la capa que queremos editar.

3. Menus contextuales de Edicidn

Un ment contextual es un mend flotante que aparece en la posicién del cursor cuando hacemos Clic con
el botén derecho del raton. Hay dos tipos de mends contextuales relacionados con la herramienta Sketch
Tool Sketch context menu (meni contextual de dibujo) y Skefch fool context menu (meni contextual de
herramientas de dibujo).

Menil contextual de dibujo

Trabaja directamente con el dibujo al completo. Aparece haciendo Clic con el botén derecho del ratén
sobre el dibujo una vez se ha afiadido el vértice. Este meni ofrece las siguientes opciones:

e INSERT VERTEX y DELETE VERTEX {insertar y eliminar vértice); haciendo Clic
con el botdn derecho del ratén sobre en un dibujo, en la posicion donde queramos
insertar o eliminar el vértice. (Con Current task: Medify Task)

e MOVE: permite mover un vértice especificando unas coordenadas relativas {por
ejemplo, la localizacién original del punto es (0,0) y queremos mover el vértice a
una nueva localizacién a pattir de unas coordenadas de unidad de mapa
especificadas).Haciendo Clic con el botén derecho del ratdén sobre el vértice que
queramos mover > Move > especificar las coordenadas relativas a las due
queramos mover el vértice > Finish Sketch (con Current task: Modify Task)

¢ MOVE TO: permite mover un vértice a una posicién XY absoluta. Haciendo Clic
con el boton derecho del raton sobre el vértice que queramos mover > Move {o>
especificar las coordenadas x,y a las que queramos mover el vértice > Finish Sketch. (Con Current
task: Modify Task)

¢ FLIP: permite modificar anotaciones.

e TRIM TO LENGTH (medificar la longitud de un dibuio): permite recortar un elemento una longitud
dada. Haciendo Clic con el botén derecho del ratén sobre el Gltimo vértice afiadido > Trim fo jlength >
escribir la cantidad a recortar > infro. (Con Current task: Modify Task)

e DELETE SKETCH (eliminar dibujo).

e FINISH SKETCH (finalizar el dibujo). Clic con el botén derecho del ratén justo donde
acabemos de digitalizar > Finish Skefch en el meni contextual.

¢ FINISH PART (terminar parte). Clic con el botén derecho del ratén justo donde
acabemos de digitalizar > Finish Part en el menG contextual. (Esta opcién es Uil para
crear elementos multipartides, por ejemplo, muchas islas que pertenecen a un mismo
pais).

s EDIT SKETCH PROPERTIES (editar las propi
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Menu contextual de herramientas de dibujo)

Aparece mientras se esté utilizando la herramienta Sketch tool, haciende Clic con el botén derecho del
ratén. Algunas de las opciones con las gue cuenta este ment son:

e SNAP TO FEATURE : permite acceder al Snapping envirchment.

¢ DIRECTION (direccion): permite especificar el 2ngulo hacia el que guieres dirigir el dibujo. Clic con el
botén derecho del ratén > Direction > especifica el angulo que quieres que tome el dibujo > /nfro.

s DEFLECTION (desviacién). permite dibujar un segmento especificando un dngulo en relacion con el
segmento anterior. Una vez dibujado un primer segmento, Clic con el botén derecho del ratén >
Deflection > especificar el angulo en relacién con el Gitimo segmento > [nfro.

e LENGTH (longitud): permite especificar la longitud gue quieres que tenga el dibujo. Una vez dibujado
el primer vértice, haz Clic con el botdn derecho del ratdén > Length > escribe la longiiud deseada >
Intro. Creara un segmento de la longitud especificada.

e CHANGE LENGTH (cambiar longitud);permite cambiar la longitud del dltimo segmento creado. Al
cambiar la longitud, ArcMap mantiene la direccién de este Gltimo segmento y mantendréa su angulo.

e ARSOLUTE XY: permite crear un nuevo punto o vértice estableciendo un valor aheoluto dex ey, es
decir basado en el sistema de coordenadas y unidades del mapa.

s DELTA X)Y: permite crear un nuevo punto estableciende un valor relativo de x e y, es decir, en
funcion del Gltimo vértice creado.

o DIRECTION/LENGTH {direccion y longitud): permite especificar el &ngulo y la longitud del dibujo.

e PARALLEL (paralelo): limita un nuevo segmento para que sea paralelo a otro existente. Colocando el
cursor sobre el segmento de referencia, Clic con el botén derecho del ratén > Parallel.

» PERPENDICULAR (perpendicular). limita un nuevo segmento para que sea perpendicular a otro
existente. Colocando el cursor sobre el segmento, Clic con el botén derecho del ratén >
Perpendicuiar.

¢ SEGMENT DEFLECTION: permite dibujar un segmento especificando un angulo en relacién a ofro
segmento. Colocando el cursor sobre el segmento, Clic con el botén derecho del ratén > Segment
Deflaction > especificar el angulo > Iniro.

o REPLACE SKETCH (reemplazar dibujo).

s  TANGENT CURVE (curva tangente): permite dibujar una curva tangente al Gltimo segmento dibujado
a partir de un pardmetro dado.

s STREAMING: permite acceder la modo de digitalizacién Stream, con el cual se capturan elementos
cuando no es mucha la precisién requerida a la hora de hacer el dibujo. Con este modo de
digitalizacién, ArcMap va afadiendo los vértices automaticamente a determinados intervalos de
distancia gue t0 has establecido previamente.

e DELETE SKETCH (eliminar dibujo}
e FINISH SKETCH (finalizar dibujo)
e SQUARE AND FINISH

»  FINISH PART (terminar parte)
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4. Editar Atributos

4.1. Editar atributos para elementos seleccionados

i 2

El Cuadro de dialogo de Atributos {aparece haciendo Clic en }

FUPLCIPOS 163,
permite visualizar los atributos de los elementos seleccionados. tg‘:%g%f £

I |"?_WEC_EF[D CASTIELANCO BT

CON_NE 43027

Fernaca LA RINCOMADA
Heomass Az, .

En la parte izquierda de cuadro aparece una lista con los elementos
seleccionados. La parte derecha, contiene dos columnas: ios campos de la capa gue estamos viendo y
los valores o atributos para ¢l elemento seleccionado. Haciendo Clic sobre cuaiquiera de los valores,
éstos pueden ser modificados.

ArcMap permite afiadir atributes y cambiar el valer de los ya existentes. También ofrece la posibilidad de
copiar_atributos individuales o todos los atributos de un elemento. Los atributos se pueden pegar a un
elemento Unicamente o a todos los elementos seleccionados de la capa. Para copiar un valor de atributo
a una capa, hay que cepiarlo y hacer Clic con el botdn derecho del ratén sobre el nombre de la capa. a
continuacién, hacemos Clic en Pegar y entonces el valor del atribuio se copiard en cada elemento
seleccionado en la capa.

4.2. Editar tablas

ArcMap permite cambiar los valores de los atributos directamente sobre las tablas con el modo de Edicién
activado (ment Edifor > Start £diting).

lADE) CRNOL

1. Crear un nuevo campo en una tabla ya existente {(modo de edicién apagado)

Con la tabla de atributos abierta y el modo de Edicién desactivado (Editor > Stop editing) = Options >
Add Fiel > en el cuadro de didlogo Add Field especificar el nombre del campo y el tipo de dato que va a
contener > OK.
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ARES,
12 COD_INE
ot COD_MUNIC

2 Editar el nuevo campo. Dos opciones: :
; - . o iy
« Directamente, escribiendo los valores de los atributos (mend Editor o

7 i PROVINGA
activado) _s:»e;:_ )

¢ Con la Calculadora de Campos CALCULATE.

Para abrir la calculadora de campos: Clic con el botén derecho del ratén en el
campo para el que queramos editar los valores > Calculate Value. Aparece un
mend que nos permite realizar célculos simples y expresiones l6gicas complejas
incluyendo otros campos de la tabla {por ejemplo, si tenemos un campo con la
pobiacion y ofro con la superficie de u municipio, podemos crear un campo
llamado densidad y decirle gque el valor de éste serd la divisién de los dos campos anteriores)

/INOTA: Para utilizar la calculadora de campos es necesario tener el médulo ArcCatalog cerrado, porque
de lo contrario el programa crea conflictos y no es “posible llevar a cabom las operaciones//

4.3. Crear un shape vacio para editarlo con postericridad

Cuando nuestro objetivo es crear un dato nueva, totalmente diferente a cuzlquiera que podamos tener en
nuestra coleccion de datos, sera necesario crear una nueva feature class vacia, de la geometria
adecuada (puntual, lineal o poligonal) para representar los elementos gueramos crear.

La creacién de nuevas feature classes vacias, se llevard a cabo desde ArcCatalog. En nuestro caso,
aprenderemos a crear, concretamente Shapefiles.

e Clic con el botén derecho del ratén en la Tabla de contenidos, sobre la carpeta dénde queramos
guardar el nuevo Shape vacio > New >Shapefile.

hezaz2.uf
d fmétes_munidpales.shp
nucleos de pablacion{ool).shp

DATOS_ALCEDODS
DATOS_PRACTICAS
=

CriDocuments ans

g 0y

j Database Conred.:
Address Locators

Aparsce un cuadro de creacidn de nuevos shapes en el que tendremos que indicar.
1.Nombre de la nueva feature class
2.Eltipo de geometria

3.El sistema de coordenadas con el que sera referenciados los datos.

Una vez creada la nueva feature class vacia, la cargaremos en ArcMap y podremos comenzar a editarla.

Modulo SISTEMAS DE INFORMACION GEQGRAFICA — CEA07 8



EJERCICIO 5

EJERCICIO 5A. CREACION Y EDICION DE FEATURE CLASS

En el municipio de Sierra de Yeguas —Malaga- se esta llevando a cabo una modificacién de las Normas
subsidiarias, la cual, consiste en la modificacion puntual de uso del suelo en esa zona en concreto (en la
actualidad el uso de la parcela es de cultivo y se pretende pasar a urbanizable).

Se pretende hacer una promocién de viviendas, pero |la parcela es contigua al cementerio y a una via pecuaria
porlo que hay que dejar un margen de proteccién entre estos elementos y la zona en la que se va a construir.

Se nos ha encargado cartografia de la zona en la que quede representada la zona a urbanizar, el cementerio
y la via pecuaria, la zona de proteccién junto a la via pecuaria y la zona de equipamientos que quedara junto
al cementerio.

Utilizaremos como imagen base a partir de la cual crearemos las nuevas feature class, la ortofoto digital de
Andalucia.

e A . CEMENTERIO
=8 1. | Zonade especial proter

Zona a urbanizar

Zona de equipamientos ==

Zona de Cultivos
Zona de proteccién

Paso 1: Copiar los datos en nuestro ordenador

Paso 2: Iniciar ArcMap ,abrir un nuevo mapa, asighar unidades y sistema de coordenadas al mapa.
e Inicia ArcMap seleccionando un nuevo mapa vacio (A New empty map)

A continuacién, definiremos las unidades del mapa y el sistema de coordenadas en el que estaran
proyectados los mapas

« Clic con el botén derecho del raton sobre el Data Frame Layers > Properties. Aparece el cuadro de
diglogo de propiedades del Data Frame.
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e En la pestafia General, indica que las unidades del mapa y las unidades de visualizacién son metros.

>Aplicar.
Unm. s
Map; }Melers :j
- Display: iMelers _:j

e Haz clic en la pestafia Coordinate system y observa que el sistema de coordenadas del data frame es
desconocido (Unknown).

* En el cuadro Select coordinate system, haz Clic en Predefined =Projected Coordinate System > UTM >
Others GCS >Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar.

e Afade las feature class raster 1022-4-1.sid y 1022-4-2.sid (C: \practica 5).

¢ Hazunzoom ala zona de studio.

Paso 3. Crear una feature class poligonal

En este paso crearemos una nueva feature vacia a la que llamaremos “PROTECCIONES” la cual contendra la
informacién relativa a la zona de proteccion, la zona de equipamientos y la zona donde ird ubicada la
urbanizacion.

Abre ArcCatalog. Navega por la tabla de contenidos hasta C:\practica 5.

e« Haz Clic con el botén derecho del ratdn sobre la carpeta PRACTICA 5 > New > Shapefile

¥ B i
%[ Pytho B2 copy  cuke I
: éﬁn"g"; @ pste  culy

+ 13 b <

E2 [:6 C:\Docum X plete

+ (DA Rename  F2
# {3 Databass - A l i
& W Address L Refredl

+ {2 Coordnat

71 Eolder

B shapeie,

|

+ (gH] GIS Serve
% Scalar Ref Bh Search 53"’”"“"@"”‘“”“;
2@ searchRe oo T Layer... ]
+ (55 Todbozes (& Propertes... <> ]
# (£ Tracking Connections OﬁroupluyerWVY i

Maoddulo Sistemas de Informacion Geografica -CEAO07 2



EJERCICIO 5

Aparece el cuadro de creacion de Shapefile
¢ Indica PROTECCIONES como nombre de la nueva feature class y Polygon como geometria.
¢ En el cuadro de sistema de coordenadas, haz Clic en el botén Edit. > Select

* Navega por el cuadro de contenidos hasta Predefined >Projected Coordinate System > UTM > Others
GCS >Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar

¢  Finalizar

Coordinate System |

A Name ‘PROTECCIONES
‘ g Namse  Unknown
Al Featue Type:

‘ - Spatial Reference

§ Descriplion:
i :Unknnwn Coordinate System

Selecl a pradafinad coordinats systemn

Select

Import & coordinate system and XY, 2 and M
Impca) - domains fiom an esisting geodalasel (e.g..
—-—-E feahus dataced, feaburs clsss, razted).

i
1 3 : :
||| Show Detals Edit i New.. -f Cresls a new coordinata system.

{ Edi the propesties of \he cunenlly selected
s : : 2 cooidinale sysem.
# | i Coordinates will contain M values. Used o store roule data
§ | 7 Coordinates will contain Z values. Used to slore 3D data. ...._‘..Hw....j 2t thm comcinale yaeT o ks
R L o s e e ST L N e | Save the coordinate syttam bo a s
cova| =
' sceptes | [Corcelr | i |

Paso 4. Editar elementos en la feature class

¢ Ve a ArcMap y junto a la imagen raster 1022-4-1.sid y 1022-4-2.sid afiade la nueva feature class
+
creada,, PROTECCIONES.shp (Add Data V) Observa que aunque €l la tabla de contenidos aparece
la nueva capa afiadida, en el area de visualizacion de ArcMap no tiene lugar ningin cambio ya que el
shape UNIDADES AMBIENTALES aln se encuentra vacio.

Ahora comenzaremos a editar el shape que acabamos de crear.

e Abre la barra de herramientas de Edicién. Para ello haz Clic en el botdn

o Para comenzarla sesion de Edicion haz clic en Editor > Start Editing

o En la lista de tareas (Task) indica que quieres crear un elemento nuevo (Create New Feature) y en la
capa de destino (Targef), indica que se trata de UNIDADES AMBIENTALES.shp

edtor v | b 2 < Task Hreate New Feature _wi | Target: RROTECCIONES s R

v

Lista de Tareas

Capa de destino
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2. Seleccionar el tipo de elemento del mapa (tras configurar las propiedades del elemento,
éste se inserta de forma predeterminada en el centro del mapa).

3. Arrastrar el elemento a una mejor posicion en el balance visual.

4. Hacer doble Clic en el elemento para cambiar sus caracteristicas, si se desea.

La leyenda
Para insertar la leyenda: menu Insert > Legend

o Asistente de leyenda. Te permite:

Legend | items | Frame | Size and Posit
o Afiadir los elementos que quieres que aparezcan en '@"’”” e e
la leyenda y seleccionar el nimero de columnas que i
|
va a tener.
t ner ¥ Show Position: W Symbal .. f
o Establecer el titulo de la leyenda. Peich | Specigbetweer: ,
\Widte 30 pt lilﬂeandilems gi i
& i ems
o Establecer las propiedades de la fuente de letra. Mage [IBp cabme it
e [ 2] g g BT ©
o Establecer color de fondo, bordes... sas T30 % v
¢ Cuadro de propiedades de la leyenda (Clic con el boton | [ Ml
derecho del ratén sobre la leyenda > Properties).
Aceptar Cancelar

La pestafia Legend permite:

e Cambiar el titulo de la leyenda. La casilla de verificacion Show, controla si el titulo
aparecera o no. El titulo se puede situar en la parte superior o inferior de la leyenda.

e Cambiar las propiedades del titulo (color, fuente, tamafio) mediante el botén Symbol.
o En elcuadro Patch se pueden cambiar las propiedades de los simbolos.

¢ lLos espacios predeterminados entre los componentes individuales de la leyenda ya vienen
configurados pero se pueden modificar perfectamente.

La pestafia ltems se utiliza para especificar qué objetos queremos que aparezcan en la
leyenda. De forma predeterminada apareceran los objetos de todas las capas del mapa.

También permite especificar como queremos que la leyenda esté conectada al mapa:
o Mostrar solo los objetos de la leyenda que tienen datos visibles en el mapa.
¢ Afadir un nuevo objeto a la leyenda cuando se afiada una nueva capa al mapa.

+ Reordenar los objetos de la leyenda cuando se reordenen las capas.

La pestafia Frame permite afiadir colores de fondo, modificar los bordes...

La pestafa Size and Position permite ajustar el tamaiio de la leyenda y su posicion en el mapa.

Norte

Para insertar la flecha apuntando al Norte: Insert > North Arrow. Aparece un selector que
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permite escoger entre una amplia variedad de “Nortes*. Después de seleccionar uno de ellos,
en el cuadro Properties puedes cambiar sus propiedades (como orientacién, tamaro, color...)

Escala
ArcMap ofrece la posibilidad de insertar tres tipos de escalas:
* Una barra de escala gréfica (en el men Insert > Scale Bar).

Util para los mapas que van a ser reducidos en el proceso de impresion. Tanto el cuerpo del
mapa como:la barra de escala cambian de tamafo simultdneamente para garantizar que la
barra de escala sea correcta. Una barra de escala permite el uso de escalas que no tengan que
ser multiplos de 100 (por ejemplo, 1:3.475.923), que es el resultado del intento automatico del
software de amoldar la extension de los datos del mapa dentro de la vista Layout.

0 40 @ 180 240 20
B N NN T s

El Selector de barra de escala ofrece una amplia variedad de escalas. Después de seleccionar
una escala, se pueden cambiar sus propiedades, como el tipo, el tamafio de cada intervalo, el
numero de intervalos, las unidades, el color de las lineas y etiquetas, o la fuente de las
etiquetas.

e Una barra de escala fraccional (en el mend Insert > Scale Texi)..

Se utiliza normalmente para mapas que fueran a ser editados en una escala especifica de
multiplos de 100 (por ejemplo, 1:250.000). Una vez se haya afiadido las escala al mapa, ya que
la escala fraccionas es simplemente texto, al cambiar el tamarfio del mapa, ese texto se hara
mas grande 0 mas pequefio.

Textos
Desde el menl /nsert puedes incorporar el titulo del mapa y otro texto.
¢ Qué informacion textual debe aparecer en un mapa?

Titulo; Autor o autores; Informacion sobre la proyeccién; Fecha del mapa y fecha de los datos;
Fuentes de datos que se han utilizado; Agradecimientos (si son necesarios)

Toda esta informacion textual no tiene por qué aparecer en el mismo nivel de importancia, por
ejemplo, el titulo del mapa deberia aparecer en un tamafio mayor.

4. Herramientas de la Vista Layout

No hay que confundir los botones Zoom In y Zoom Out de la Vista Layout con los de la Vista de
Datos. Los botones de la Vista Layout son para poder visualizar la vista previa de nuestro
mapa, es decir, son para ver como apareceran los elementos del mapa en diferentes
ampliaciones o reducciones,

Si acercamos o alejamos el zoom en diferentes porcentajes utilizando la barra de herramientas
del Layout; la escala real de la visualizacién permanecera igual.
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+ Realiza esta misma operacion con los dos elementos restantes, zona de proteccién y zona de
equipamientos.

» Guarda los cambios de edicién y cierra la sesion de edicién. (Editor > Save Editing > Editor > Stop
Editing).

e Abre la tabla de atributos de la capa PROTECCIONES y observar que los registros aparecen editados//

| FID | Shape' | 10 | HOMBRE |
i 2|Palygon 0 Zona a urbanizar |
53_“. 1 Polygon 0 Zonade equipamientos

ig__ 0 |Polygon 0 ?fdﬁém&é'ar&gccién B

— [

il

Pruebai. Para finalizar tu mapa haz que cada poligono de la feature class PROTECCIONES quede
representado con un color diferente. Para ello clasifica por categorias dicha capa utilizando como
NOMBRE como campo en base al cual se realiza [a clasificacién.

En las cuadro de propiedades de la capa> Simbology.

Prueba2. Para completar tu mapa es necesario gue queda representado el cementerio y Ia via pecuaria.
Para ello tendras que crear dos nuevas feature class vacias, una de tipo poligonal que representara el
cementerio y otra de tipo lineas que representara la via pecuaria.

Bl Edt Wew Jsert Selecion Jook Window Heb
DEWS - 2@ o -0 i ganw @es 5000 s ahny] & 8]

T E Lo
R R vepearia

2 B comentern

=
=l PR OYECCINES
NEMBRE

FIN DEL EJERCICIO
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UNIDAD 5. SALIDAS CARTOGRAFICAS

CONTENIDOS

e Conceptos basicos de cartografia

e Crear mapas en ArcMap
Layout View
El mapa y los objetivos del disefio
Otros elementos
El documento de mapa (*.mxd)

¢ Procedimiento de creacion de salidas cartograficas
Configuracion de la pagina
Afiadir componentes

* Herramientas de la Vista Layout

 Las Plantillas de mapa

e Imprimir mapas

1. Conceptos basicos de cartografia

Todos los andlisis de SIG terminan con algunos resultados que deben ser comunicados.
Podemos ayudar a cumplir el proposito de nuestro mapa ubicando correctamente los
elementos del mapa y seleccionando simbolos y elementos cartograficos adaptados al mensaje
gue queramos comunicar. El disefio del mapa depende, por tanto del objetivo del mapa.

1.1. Factores que controlan el disefio cartografico

Varios factores controlan el disefio de un mapa. Estos limitan nuestra creatividad y flexibilidad.
e Objetivo del mapa.

e Destinatarios. .

e Realidad y necesidad de generalizar.

e Escala.

o Limitaciones técnicas.

+ Modo de uso.

1.2. Tipos de mapas

Clasificar los mapas es una tarea dificil, sin embargo, generalmente podemos dividirlos en dos
categorias: mapas generales y mapas tematicos.

Mapas generales. Los mapas generales muestran datos de localizacion o posicion.
Representan elementos que utilizan muchas disciplinas. Algunos ejemplos de estos mapas
serian los atlas o los mapas topograficos. Ningtin elemento de estos mapas es mas importante
que otro.

Mapas tematicos. Existen dos tipos de mapas tematicos: cualitativos y cuantitativos. Ambos
muestran la estructura de distribucién y ,generalmente, ambos representan un anico atributo o
relacion.

e Mapas tematicos cualitativos: representan datos como diferentes tipos de suelo y diferentes

Médulo SISTEMAS DE INFORMACION GEOGRAFICA — CEA07 1
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tipos de elementos con igual importancia en una escala nominal.

*» Mapas tematicos cuantitativos: muestran, deliberadamente, diferencias en cuanto a
caracteristicas cuantitativas (por ejemplo, mostrar un intervalo o escala de ratio de
densidades de poblacién por Km?, o las variaciones de temperatura o humedad).

2. Crear mapas en ArcMap
2.1. Layout View

La creacion del mapa se lleva a cabo desde la Vista Layout Para acceder a esta vista:

e Enelmenu generalView > Layout View

Nuestra composicion puede contener uno o mas mapas. Cada mapa requiere afiadir un Data
Frame a nuestro documento.

Cuando un mapa tiene mas de un data frame, uno de ellos sera el activo y es con el que
estamos trabajando. Este data frame activo aparece resaltado en la Vista Layout.

DATA VIEW

= SinAilulp: Arcitap - Arc¥iow
5 o ot Sekecion Tock Windaw Help
DSB8 - @B o

Vista con dos Data Frame, sélo el
data frame Andalucia se encuentra
activo

A

&

@exuem| |

| = B imikes_manicpaiest

; coMARCA i
B ALCALA D GLIADAIRA |
B CANTILANR 1

|
-mmnemﬁmi
B CASTILLO DELAS GLR |
W CAZALLA

i

B LA RINCONADA.
T LEBRDA

[ L0RA DEL RID
R MaROENA

Data frame activo

‘:' :Fm':,lit.js'ln hrcMap 5 ArcYiow, "
Bl Bt Wen [rsert gelenion Todks window Hep

Seus imax .o Tdesse mmenuDa
A ] =

1B [A R BT B I8 [fe i3 2 |13 181 e |17y e] 1 ae)2

‘=7 emal

Edtor v ® i

| 2 H imites_mnidpalesd

COMARCA x
I ALCALS DE GUADAIRA | o »
B CANTILLANA, %
B CARMONA
B CASTILLO DE LAS GUR.
B CASTRLO DE LAS GUR
B CAZALA

LAYOYT VIEW  Ee

En el layout View, podemos visualizar Bicescarfen
todos los data frame @
independientemente de que estén o no =z
activos i - 8 wanes

=
=
o
o
=
o
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Data frame activo
— O

2.3. El documento de mapa (*.mxd)

Al finalizar nuestro disefio, podemos guardar el documento mapa como archivo .mxd. Este
archivo almacenara la ruta a los datos que se han utilizado para crear el mapa y las

propiedades de visualizacion de cada capa.

Para guardar el documento *mxd => en el menu general File > Save

3. Procedimiento de creacién de salidas cartograficas
3.1. Configuracion de la pagina

Al disefiar mapas, el primer paso seria la configuracion de la pagina a
través la cual se estableceran las unidades de medida gréfica, el
tamafio y forma de la hoja de impresion, margenes de impresion y
calidad de resolucion...

Para configurar la péagina: en el mena general File > Page and Print
Setfup.

Tamafio del filio
de impresién

~ Prirter Senp

P =
Stabus:
Type:
Where:
Camments:
EEmE e

I = e ;
R T

Orientacion (vertical u
horizontal)

3.2. Anadir componentes

Procedimiento general para afiadir componentes

Todos los componentes se insertan en la vista de presentacion o composicion de la misma

forma:

1. Hacer Clic en el mena general Insert.
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EJERCICIO 5

¢ Con la herramienta Sketch Tool '™y empieza a dibujar los poligonos que representaran cada uno de
los elementos a representar.

/{Para eliminar un poligono, selecciénalo con la herramienta + botén SUPRIMIR/

¢ Una vez dibujados los tres poligonos que representaran la zona de proteccién, la zona de equipamientos
yla zona a urbanizar, salva los cambios de la edicién (Edjfor >Save Edits).

Paso 3. Editar atributos de Ja tabla

Cuando se genera un nuevo shape, automaticamente se genera la base de datos asociada, y por cada uno de
los elementos espaciales que se crean se genera un registro en esa base de [E======

datos. : D | Shape | |
4 0 {Polygon 0

« Abrela tabla de atributos asociada a la capa PROTECCIONES.shp = [fi | ~ 1 Polygon 0
Clic con el botén derecho del ratén sobre la capa PROTECCIONES > 2 ‘Polygon DL
Open Atributte Table. | :

Observa que la tabla de atributos contiene tres registros correspondientes a los tres elementos que has
editado, v trs campos: el campo FID {(ArcGis lo afiade automaticamente a todas las tablas con propdsito de
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identificacion), el campo Shape (hace referencia al ipo de objeto espacial) y el campo ID. Nuestro objetivo
sera almacenar los nombres de los monumentos dibujados, para lo cual necesitaremos crear un nuevo campo
al que llamaremos NOMBRE vy, posteriormente, rellenar los registros.

e Finaliza la sesion de edicién: Editor > Stop Editihg vy con la tabla de atributos de la capa
PROTECCIONES abierta, afiade el nuevo campo: Options > Add Field. En las propiedades del campo
indica que el nombre del nuevo campo es NOMBRE, que el tipo de dato es Texto y que la longitud de
caracteres de texto es 30 > OK..

B Replace...
2 Select By Attributes...
[ = Nome:  [NOMBAE
i1 2 select il
. E] clear selscton Type: ]Tanl :!
= Field Propesti e
Related Tables » | Length i3
] Create Graph...
Add Table to Layout
Citsges
| Record: 14 4} T rinf Shom[ Al Selected | Records (Doutof 35eectad) Cance! ]

¢ Cierralatabla de atributos.
A continuacién, rellenaremos los registros del campo NOMBRE que acabamos de crear

o Vuelve a activar la sesion de Edicion (Editor > Start Editing).Con la sesién de edicién activada y la

e
herramienta Edit Tool ., selecciona uno de las unidades ambientales que has editado > abre el

B

cuadro de atributos del elemento pulsando en =

e Haz doble Clic en el valor del campo NOMBRE y escribe el nombre del monumento del que se trate.
it ..
(] @

PROTECCIONES
*0
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5. Las Plantillas de mapas

Las plantillas de mapas son Utiles cuando tenemos que crear varios mapas y todos ellos deben
tener el mismo aspecto (por ejemplo, la misma fuente, el mismo color de fondo...). En estos
casos, el uso de plantillas puede mejorar nuestra productividad y ayudar a estandarizar los
mapas que produce nuestra organizacién.

Las plantillas son documentos de ArcMap con extension *.mxt
Para crear una plantilla:
Al guardar el documento, simplemente se hace como documento *mxt de plantilla.

Para hacer un mapa a partir de una plantilla: Al abrir ArcMap seleccionamos la plantilla a la
que le vamos a afiadir las capas (seleccionamos A Template).

ArcMap viene con un conjunto de plantillas estandar que podemos utilizar para la creacién de
mapas. También podemos modificar los mapas y las plantillas o crear nuestras propias
plantillas para cubrir nuestras necesidades.

6.Imprimir mapas
Para imprimir mapas hay que llevar a cabo los siguientes pasos:
1. En el mena File, hacer Clic en Print.

2. Aparece la venfana Print, en la que seleccionaremos la impresora disponible y el motor
de impresion.

» En la ventana Propiedades de la impresora, seleccionamos el tamafio de péagina y la
fuente, el nimero de copias y la apariencia de color.
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En este ejercicio crearemos una salida cartografica a partir de un mapa existente. Dicha salida
consistira en un mapa en que quedara representada una ruta arqueoldgica en el municipio de

Ecija, el cual ird acompafiado de diferentes elementos cartograficos e informativos (texto, tabla,
graficos...)

Faso 1.Iniciar ArcMap, abrir un mapa existente ,asignar unidades y sistema de coordenadas al mapa

¢ Abre ArcMap, selecciona comenzar con un mapa existente y en el cuadro de dialogo busca el
mapa Ecija.mxd. (C:\Practica 6)

» Sifuese necesario, indicar la ruta hacia la fuente de datos. Todos los datos se encuentran C:\
Practica 6.

/ITendras que buscar la fuente de datos, si no se ven los datos en la pantalla de visualizacién y en
la tabla de contenidos éstos aparecen con un simbolo de exclamacién rojo/

La interfaz de ArcMap muestra el documento de mapa Ecija.mxd que contiene informacién sobre la ruta y
simbologia de los siguientes datos:

* alojami.shp. Archivo shape puntual que contiene la informacion referente a los alojamientos del
municipio de Ecija.

» yaci.shp. Archivo shape puntual que contiene la informacién referente yacimientos arqueoldgicos del
municipio de Ecija.

o Ruta del Suroeste.shp. Archivo shape lineal que representa la ruta a la que hace referencia el
mapa.

¢ vias de comunicacién.shp. Archivo shape lineal que contiene la informacién referente a las vias de
comunicacion del municipio de Ecija.

s nucleos ecija.shp. Archivo shape peligonal que contiene la informacién referente a los nlcleos de
poblacion del municipio de Ecija.

» municipios ruta.shp. Archivo shape poligonal que representa los municipios de Ecija y alrededores.

A continuacién, asignaremos unidades y un sistema de coordenadas al data frame Ecija

e Clic con el boton derecho del raton sobre el Data Frame Ecija = Properties. Aparece el cuadro de dialogo
de propiedades del Data Frame.

e En la pestafia General, indica que las unidades del mapa y las unidades de visualizacién son metros.
>Aplicar.

e Haz clic en la pestafia Coordenate system y observa que el sistema de coordenadas del data frame es
desconocido (Unknown).

e En el cuadro Select coordinate system, haz Clic en Predefined >Projected Coordinate System > UTM >
Others GCS =Europeam datum 1950 UTM Zone 30N > Aplicar y Aceptar.

A continuacién, modificaremos la simbologia de algunos de estos datos.
Comenzaremos clasificando la capa vias de comunicacidn.shp en funcién del tipo de via.
» Clic con el botén derecho del ratén sobre la capa vias de comunicacion.shp > Properties.

e Clic en la pestafia Simbology
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e En el panel Show, Clic en Categories > Unique Value

* Indica que quieres realizar la clasificacion en funcion del campo REDES_ID (Value field = REDES_ID)

/ISi observas la tabla de atributos de la capa vias de comunicacion.shp, verds que el campo que contiene la
informacion acerca de los diferentes tipos de vias de comunicacién es REDES_ID/

»  Clic en afiadir todos los valores (Add all values)

» Asigna los siguientes valores a las categoria

Symbol Label Simbologia

1 Color Rojo, Width 2,00 Carreteras asfaltadas Color Rojo, Width 2,00

2 Color Naranja, Width 1,5 Carreteras sin asfaltar Color Naranja, Width 1,5
3 Color Naranja, Width 1,00 Caminos Color Naranja, Width 1,00

» Desactiva la casila de verificacién <all other values> para que no aparezca en la tabla de contenidos de
la interfaz de ArcMap

Debe quedar asi:

Genetal | Source | Selection | Display ~ Symbology } Fields | Definition Query | Labels | Joins & Relates |

Showe e e = =
Features Draw categories using unique values of one field. Impoit....
Categories mValeFeld———— - s ColotRamps e e
- Unique values {REDES_ID ~| o 1 =
Unique values. many 1 ool |
MaEc-h \oasmibcle 2 Symbol i Value | Label { Count i
Quantities
Charts [F—— <all other values> <all other values>
Multiple Attributes <Heading> REDES_ID
| | Caneteras asfaltadas ?
2 Carneteras sin asfaltar ?
e Caminos ?
- Add Al Values i Add Yalues... ; Remove i Remove All § Advanced -i

[ Aceptar i Cancelarl Aplicar i

e Haz Clic primero en Aplicar para visualizar los cambios y luego en Aceptar.

Ahora trabajaremos con la capa yaci.shp. Queremos gue en nuestro mapa, los yacimientos que estén
localizados a menos de 2km de la ruta, aparezcan simbolizados de forma diferente de aquellos que estan mas
lejos. Para ello:

e Selecciona por localizacién aquelles yacimientos de la capa yaci.shp que estén a una distancia de 2km
de la ruta (Ruta del Suroeste.shp)

(En el menu Selection > Select by location.)
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Lets you select features flom one or more layers based on whete they are located
in relation to the fealures in anather laper.

| want to:

Ese]ect features from E]
the following laper(s):

{1 alojami =
¥ yaci =
ig vias de comunicacion

™ Drlly show selectable layers in this fist
that:

{are within a distance of :J

the features in this layer:
Iﬂuta del Suroeste :_J

SECRT (0 features selected)
™ Apply a buffer to the features in Ruta del Suoeste

<7

of: {2000 [ Meters ~l
... HWEEW’ e e e = a8 6 et = & e e e 2 2 i A A M
The red features represent the features in Rula del Suiceste.
The highlighted cyan featuies are selected because they
are within a distance of the red features.

Poaints Lines Polygons

Aoy | Close. |

Crea una nueva capa shape que contenga los elementos seleccionados.=Clic con el botén derecho del
ratén en la capa sobre la que has realizado la seleccidn, en este caso la capa yacishp > Data > Export
Data. Denomina a la nueva capa yaci 2Km

Limpia la seleccidn de la capa yacishp = Clic con el botén derecho del ratén sobre la capa yaci.shp >
selection = clear selection.

Cambia la simbologia de la nueva capa creada (yaci 2Km.shp). Para ello haz un doble clic sobre el
simbolo que representa los elementos de yacizkm

En el Selector de Simbolos

A Color: Amarillo (solar yelow)

Triangle 1

Size:10

A continuacion, en los pasos que siguen afiadiremos elementos de mapa para hacerlo mas til. Los elementos
de mapa incluyen una leyenda, una flecha de direccion norte, un titulo al mapa, una barra de escala, gréaficos,
tablas, informacion textual...

Paso 2. Configuracién de la pagina

Haz Clic en el mend View > Layout View para acceder a la vista de composicién de mapa
En el menu File, haz Clic en Page and Print Setup.

En las caracteristicas de la pagina, indica que la forma de la hoja es horizontal (Landscape) y como
tamafio de hoja estandar (Standars Sizes) el A4.

Adapta el marco del mapa de forma que quede como se ve a continuacion.
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Paso 3. Anadir una leyenda

La leyenda es la clave de un mapa. Con ArcMap podemos crear facilmente una leyenda y mejorar su
apariencia. Sin embargo, antes de mostrar la leyenda, cambiaremos algunos textos del indice de la tabla de
contenidos, ya que lo que aparezca en el indice es lo que se mostrara en la leyenda.

e Cambia los nombres de las capas yaci, yaci_ruta y alojami por Yacimientos arqueolégicos,
Yacimientos arqueolégicos a menos de 2km y Alojamientos respectivamente. Para ello, haz Clic con
el botdn derecho del ratén en cada una de las capas a las que vas a cambiar el nombre > Propierties >
General

= L T
l £ Edja l o i

= &) i L

- % coor | L ® Vil ‘f

25 i avgflame ¥ Vishle H

= alojar X Remave

i ! ior :

= B yael =] Oper Attribute Table { Desivon - i

° Joins and Relates 3! !

= vias ¢ T T —ir ] 1

r <& Zoom ToLayer ! o i |

=1 Visible Scale Range » AN

o g B Pl You can specily the 1ange of scales at which this layer vill be shown: t

== =

5 H R 1y & Show layer al 2l scajes

e e e 7 Dontt show layer when zoomed:
= F e !
Label Features

s

Out bayond 1: {0
= M munlc i scdd)

Inbegend 1: {0
[masimum scals]

Aceptar 1 Eam:ela‘i

Ahora, afiadiremos la leyenda.

Fle Edt View Insert Selection Tools | e  Haz Clic en el ment general insert > Legend.
D B‘E’ ] & £F DataFrame !

Editor =

|
|
|
15
|
o o e E

i = Yacin
1

Aparecera el asistente de leyendas.

e Elige las capas que quieres que aparezcan en la leyenda; en nuestro caso: Yacimientos arqueolégicos,
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Yacimientos arqueolégicos a menos de 2km y Alojamientos, Ruta del Suroeste y Vias de comunicacion.
En el nimero de columnas de la leyenda deja el que aparece por defecto. Haz Clic en Siguiente.

— Choose which layers you wark to include in your legend ——— -

Alajamenlos .._:m

YYacimientos i .
vias de comunicacion _..>.3.J vi:imeconmmicacién _|i_i En este Cuadro dEben
Futa del Suroeste \

Rula del Surcesle
mcen ecija \

J de estar los elementos
T ~ 3
muricl s Tk M que qu[eres que

! ]

Set the number of columns in your M =] Numero de

coliimnas aie

= 1
Preview |
et

| Siguene> | Cancels ;

En el titulo de la leyenda escribe Ruta Suroeste.

* Aceptatodos los valores predeterminados y haz Clic en Sigujente hasta que finalice el asistente.

De forma predeterminada todos los nuevos elementos se afiaden en el centro del mapa.

» Haz Clic sobre el marco de la leyenda y arrastrala hacia la esquina superior derecha del marco del data
frame de Ecija. Ajusta su tamafio como sea necesario.

Ahora cambiaremos las propiedades de la leyenda para mejorar su aspecto y funcionalidad.
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» Haz Clic con el botén derecho del ratén sobre la leyenda > Properties.

» Enlapestafia Frame, indica que el marco de la leyenda (border) tendréa un grosor de 1,5 pty que el fondo
sera de color gris. Haz Clic en Aplicar.

Si tienes tiempo, examina las opciones de mejora de la leyenda en las diversas pestafias del menut. Sobre
todo, observa las tres casillas de verificacién de Conexiones del mapay el botén Style de la pestafia ftems.

Estos son los elementos que requiere cualquier cartégrafo. Para este ejercicio, lo que hemos hecho en la
leyenda es suficiente.

¢ HazClic en Aceptar.

Paso 4. Afiadir la barra de escala y la flecha de direccién norte file Edt View |Insert Selection Tools

Es importante tener barras de escala en aquellos mapas que se utiizan para [ & B € £F DataFrame
medir distancias. Otros, sin embargo, pueden no necesitarlas (por ejemploun —_

mapa de densidad de poblacién). A continuacion , afiadiremos la barra de
escala a nuestro mapa.

;. bz Iitle

g Neatlne...

» Haz Clic en el menu Insert > Scale Bar. ;
3 Legend...

* En el Selector de barras de escalas, haz Clic en Scale Line 1. Haz Clic North Arrow. ..

en Aceptar para utilizar los valores predeterminados, ya que necesitaras m
verlos antes de decidir los cambios que haras en las propiedades. R M

De forma predeterminada, la escala aparece en el centro del mapa.
e« Haz Clic sobre la escala y arrastrala a la esquina inferior derecha del marco del data frame.

Normalmente, la longitud de la barra de escala no debe exceder de un tercio del ancho del mapa. Ademas
puedes afiadir mas intervalos a la barra de escala o aumentar el tamafio del intervalo.

s« Haz Clic con el boton derecho del ratén sobre la escala > Propetrties.

& at Chrked
B copy Ctr+C
. X Delete  TECLA DECIMAL

T, Conyert To Graphics

Graghic Operations. »
Qrder

Nudge
Align
- Distribute
z Rotate or Flip

-

NI W

o Enlaventana Propiedades, haz Clic en la pestafia Scale and Units.

e En el cuadro Units, indica metros como unidades de division.
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e Enelcuadro Scale,

o Enlalista desplegable When resizing (modificar tamafio), selecciona Adjust Width (ajustar
alancho). Observa que la casilla Divisién value se activa. Dale el valor 8000.

o Confirma o escribe 3 para el nimero de divisiones, escribe 1 para el nimero de
subdivisiones.

El cuadro de la ventana de propiedades debe de quedar ast;

Scale and Units § Numbers and Marks | Fomat | Frame | Size and Fosition |
- Scale T P S O S LU
- Division value: | T

Number of divisiors: | 3=

Number of subdivisions: | 1 __1753

W before zeio
en resizing... )

\

Division Ungs:

’Meiels ;’_J |
Labe! Pesition:
- [ alterlabels =l
| Labet |metros Symbul,,.i;

Gap: 3pt-s

= Haz Clic en Aplicar.

cocns |

e En la pestafia Numbers and Marks, en el menl desplegable
Frecuency (frecuencia de los nimeros), haz Clic en divisions.

= Haz Clic en Aplicar > Aceptar para ver como ha quedado la barra de escala (haz un Zoom con la barra de
herramientas Layout para poder ver la barra de escala).

EVE“H@ @ EE EJ “”u V“j‘§8)1z .v @ @

o Cierra el menu de propiedades de la linea de escala cuando hayas terminado.

La barra de escala, para ser correcta, deberia ser parecida a la que se muestra aqui.

1] g.000 16.000 24 000 metros
| | | |

A continuacién, afiadiremos la flecha de direccion Norte. Esta proporciona al usuario informacién sobre la
orientacién del mapa.

e Haz Clic en el ment /nsert = North Arrow. Aparece el selector de Nortes.
e« Selecciona la opcion Esri North Arrow 6 y haz Clic en Aceptar.

e Mueve laflecha justo encima de la barra de escala y ajusta su tamafio consideres oportuno.

Paso 5. Ahadir titulo y otra informacién textual.

e Enelmenu /nser, haz Clic en Titlte.
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Observa que de forma predeterminada aparece como titulo el nombre del mapa. Para cambiar las
propiedades del titulo utiizaremos la barra de herramientas de Dibujo situada en la parte inferios de la
interfaz de ArcMap.

S B s ulA- B g s

¢ Seleccionando la herramienta de texto A puedes modificar el texto. Escribe como titulo del mapa lo
siguiente:

RUTAS ARQUEOLOGICAS: SEVILLA
SUROESTE DE ECIJA

(arial , 28, negrita)

s Seleccionando la herramienta para seleccionar elementos k puedes mover el cuadro de texto. Sitla el
titulo en la parte superior del mapa.

Debe quedar algo parecido a esto

RUTAS ARQUEOLOGICAS DE SEVILLA
SUROESTE DE ECIJA

De forma muy parecida, simplemente seleccionando la herramienta texto A puedes afiadir cualquier otro tipo
de informacion textual como el nombre del autor, fecha, informacién sobre la proyeccion y datos espaciales...

Paso 6. Ahadir un contorno y un fondo al mapa
A continuacién, afiadiremos un contorno al mapa. Este nos ayudara a mejorar el balance visual.
e Haz Clic en las propiedades del data frame > pestafia Frame (marco).

« Haz Clic en el menu desplegable Border para seleccionar un estilo. Elige Double line y haz Clic en
Aplicar.
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Ahora, afiadiremos un fondo al mapa.
e Enelmend desplegable Background, selecciona Linear gradient.

» Haz Clic en Aplicary luego en Aceptar.

e = |
= @ T addoaa... 3
W New Group Layer Generel | Data Frame | Coordinate Systemy’] | MapCache | |
R e Annotation Gioups | Extent Redtangled Jae wdPosion | ||
B3 copy
- i Boidar - - i -
=M . U
. P oo
=M - — TR
G %[ 0= pe ] 0= ps Roundeg: | 0z
i e
- ==
"B s e S
2 A=
E Collapse All Layers
Reference Scale >

Advanced Drawing Cplions,
1™ Draft mode - just show name

= . :
B CwekEeae B oehc

Activate

Acaptar Cancelar |

Paso 7. Insertar otros documentos en nuestro documento mapa

Ademas de la informacién cartogréfica, queremos afiadir a nuestro documento mapa los siguientes elementos:
- Perfil de la ruta (imagen de tipo TIF denominada perfil.tif).
- Logotipo del Instituto Andaluz de Patrimonio histérico (imagen iaph.tif)

- Tabla de alojamientos cf/lla/c&?a'rca\ (alojamientos.dbf; es el resultado de exportar la tabla de
atributos del archivo shape alojamientos shp)—____ /

A continuacion, insertaremos las imégenes.

e Haz Clic en el menl Insert > Picture. Navega por el cuadro de didlogo hasta encontrar la imagen iaph.tif.
(C:\ PRATIA 86).Selecciénala y haz Clic en Abrir.

s  Ajusta su tamafio y muévela hasta la esquina superior derecha del mapa.

e Inserta de la misma forma la imagen perfil,tif. Ajustala de la misma forma para poder colocarla en el
espacio libra a la derecha del mapa.

FIN DEL EJERCICIO



EJERCICIO SIG

El objetivo del presente ejercicio es encontrar un drea en la provincia de Sevilla para
ubicar un centro de turismo rural. Esta drea debe cumplir las siguientes condiciones:

¢ Debe encontrarse dentro de Parque Natural de la Sierra Norte de Sevilla.

* Se localizara en una zona cuyo uso del suelo actual es de Matorral disperso con
pastizal.

e Debe tener un embalse a menos de 2000 metros.

® Decbe estar situado a menos de 1000 metros de la red eléctrica.

El resultado debera quedar representado en una salida cartografica (vista layout del
documento*.mxd) a escala 1:90.000 aproximadamente, y debe contener los siguientes
elementos:

o Zona/ zonas adecuadas para la situacion del centro de turismo rural.

o Etiquetas (labels) que muestren el area de las zonas adecuadas de ubicacion
(para lo cual. habra que calcular el area de dichas zonas)

Zonas de matorral disperso con pastizal

Embalses de la Sierra Norte de Sevilla

Red eléctrica

Titulo del mapa

Autor

[.eyenda (aparecera la informacion referente a embalses, red eléctrica. zonas
de matorral disperso y zonas de ubicacién dptima).

o Demas elementos cartograficos necesarios

@)

O 0 0 0

@]

La informacion necesaria para la realizacion del ejercicio se encuentra en la carpeta
ejercicio.



EJERCICIO. DESARROLLO

1. Establecer las unidades del mapa y el sistema de coordinas en el que estaran
proyectados los datos.

Las unidades del mapa >propiedades del Data Frame / pestaiia General

El sistema de coordenadas>En propiedades del Data Frame / pestafia coordinate system
/I En el cuadro Select coordinate system, haz Clic en Predefined =Projected Coordinate
System > UTM > Others GCS >Europeam datum 1950 UTM Zone 30N/

2. Cargar las capas enp .shp y seleccionar por atributos el Parque Natural de la
Sierra Norte de Sevilla. Crear una nueva capa con los elementos seleccionados
a la que llamaremos SIERRA NORTE.shp

® (menu general Selection / Select b Vv attributes)

* Lainformacion referente al nombre de los espacios naturales se encuentra en
el campo NOMBRE de la capa enp.shp

* Para crear una capa a partir de los elementos seleccionados (Data / Export
Data).

3. Cargamos la capa usos sierra.shp y seleccionamos por atributos los poligonos
cuyos usos sean “matorral disperso con pastizal”. Crear una nueva capa con los
elementos seleccionados a Ia que llamaremos MATORRAL.shp

® (mend general Selection / Select by aitributes)

* La informacion referente al nombre de los de los usos se encuentra en el
campo DESCRIPCIO de la capa usos_sierra.shp

» Para crear una capa a partir de los elementos seleccionados (Data / Export
Data).

4. Cargamos la capa embalse sierra.shp y seleccionamos por localizacion aquellas
zonas de pastizal que se encuentren a menos de 2000 metros de un embalse.

Crear una nueva capa con los elementos seleccionados a la que llamaremos
MATORRAIL_EMB.shp

* (mena general Selection / Select by location)
Select from:MATORRAL
ARE WHITHING A DISTANCE FROM
Layer: embalse sierra
Of: 2000 metros
® Crear una capa a partir de los elementos seleccionados (Data / Export
Data).

5. Cargamos la capa red electrica.shp seleccionamos por localizacion aquellos
poligonos de MATORRAL EMB.shp que queden a menos 1000 metros de la
red eléctrica. Crear una nueva capa con los elementos seleccionados a la que
llamaremos ZONA FINAL

® (menu general Selection / Select by location)
Select from :MATORRAL _ EMB .shp



ARE WHITHING A DISTANCE FROM
Layer: red eléctrica
Of 1000 metros
® (Data/ FExport Data).
6. Calculamos el drea de las zonas éptimas Jpara la ubicacion.
e Clic en ArcToolBox L I Spatial A"ralxéll‘yg;fh‘tools > Utilities> Calculate area.
El resultado serd una capa nueva a la que llamaras AREA ZONAFINAL. Si observas la

tabla de atributos de esta nueva capa podras ver que tiene un campo llamado area que
contiene esta informacidn.

7. Poner etiquetas (labels) que muestren el area de las zonas de ubicacion optima.

8. Establecer los elementos del mapa
En la vista layout (Menu View > Layout View)

o Titulo del mapa

o Autor

o Leyenda (aparecerd la informacioén referente a embalses. red elécetrica. zonas
de matorral disperso y zonas de ubicacion Optima),

o Demas elementos cartograficos necesarios

Exportar vuestro mapa a formato ipeg.

Una vez terminado el mapa sera necesario que lo presentes en un formato que pueda
visualizar cualquier persona sin necesidad de que €sta tenga instalado el programa
ArcGis o los datos que has utilizado para elaborarlo.

® Haz Clic en el menti general Field > Expot Map
e EnNombre indica Solucion NombreAlumno

e Tipo: JPEG
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